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1 - Getting Started

Welcome to VERIS™ Science 5.1, the latest enhanced version of
an electrophysiological instrument based on new concepts of
systems analysis developed at the Smith-Kettlewell Eye Research
Institute in San Francisco, California.

VERIS™ programs are in use by research and clinical facilities
throughout the world. In addition to the present functionality of the
VERIS™ system, a wide range of new methods for data processing
and presentation in special clinical and scientific applications are
currently being explored and will be incorporated in future releases.

Using This Guide
Please become familiar with your VERIS™ system and this
Reference Guide before recording subjects.

This guide has been written to help you become productive with
VERIS™ and serve as a first guide to the underlying technology.

Each chapter contains fundamental information about VERIS™,
including tutorials on how to use the menus and windows. In depth
discussions have been inserted, where appropriate, to provide a
more detailed understanding of the recording procedures and
analysis options.

First become familiar with the fundamentals. Then return to the In
Depth sections to become more familiar with the underlying
technology and program functions.

Chapter 1, "Getting Started" provides an overview of the
program, and gives a "Quick Start" introduction to the simplicity of
using VERIS™.

Chapter 2, "Setting up a Recording" explains the setup recording
view, how to select the appropriate settings, and how to create
Recording Settings protocols.

Chapter 3, "Recording a Subject" explains the recording process
and use of the Recording Window controls. Detailed information is
also given for getting good recording results.

Chapter 4, "Looking at the Data" discusses each of the analysis
views available and explains how to modify settings to improve
response signal and data presentation.
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Chapter 5, “Working with the Data” details advanced
techniques for making your analysis of data more meaningful.

Chapter 6, "Ganzfeld Recordings" provides instructions for using
the VERIS™ Ganzfeld software in recording and analyzing
conventional standard Ganzfeld tests.

Chapter 7, “Menu Reference” explains each menu item.

Chapter 8, "Advanced Topics" covers features available in the
VERIS™ Pro version of this software.

Appendix A, "Hardware" includes instructions for luminance
calibration of each stimulator-monitor combination and guides to
setting up the Eye Monitoring camera and calibrating the Stimulus
Grid in the Fundus Camera.

Appendix B, " Software" includes a copy of the Software License
Agreement and Limited Warranty, a guide for installing VERIS™
software and updates, and a brief description of the supplementary
files provided with the System.

Special items of interest are designated by icons and set off from
the balance of text with vertical lines.

Important Notice

Useful Information

In More Detail

NOTE: This guide assumes that you have a basic knowledge of
your computer and know how to use the mouse, select menu
items, open files, click on buttons, scroll, re-size and close
windows, etc.

For more information about your computer, please refer to your
computer manual and the on-screen Mac Help available from the
Help pull-down menu.
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An Overview of VERIS™ Science 5.1
VERIS™ Science is organized by the program's three functions,
which are usually done in sequential order.

1.  Setting up a recording.
2.  Recording a Subject.
3.  Analyzing the recorded data.

All VERIS™ systems include pre-programmed automated
Recording and Analysis protocols. With VERIS™ Science you can
design your own protocols for recording, analysis, and data
presentation.

Setting Up a Recording - The Setup view

When VERIS™ first starts, an "untitled" setup recording window
appears. All information about an experiment is entered through
this setup view.

This setup view can be saved as a Recording Settings protocol and
used to create new setup views without having to re-enter much of
the same information.

Recording a Subject - The Subject view

During a recording the Subject views an array of elements, which
are stimulated as defined in the setup view.

Electrodes attached to the Subject carry the responses generated
back to the computer where they can be monitored in real time and
recorded.

Once the recording is completed a Data file is created. The setup
view is replaced with a tabbed Subject view in that Data file's
window. (One file is created for each channel recorded.)

Looking at the results - The Analysis views

Using pre-defined Analysis protocols, VERIS™ provides graphical
analysis tools to work with the recorded data and to visualize the
results.

Through a series of tabbed Analysis views in the Data file window,
you can look at and compare different responses, observing the
individual response traces, group trace averages, two and three
dimensional response density plots.

Analysis views also display comparison of the Data file to other
Data files and to normative reference (Normals) files.
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Quick Start
As a quick introduction this short tutorial shows the simple steps
needed for recording and analysis with VERIS™. We will do a mock
recording using the Auto-calibrator's photodiode as an input to
provide a response.

   

    

1 Double-click on the VERIS™ 5 icon to start the program.

This icon should be found in the VERIS™ Application folder.
An "alias" icon may also be found on the desktop.

The program displays a Splash Screen showing the specific
version of VERIS™ you are using.

In most cases, each time you start VERIS™ the program
opens a window containing a new setup view using the
Default Recording Settings on the "desktop" and gives it the
temporary title "untitled."

If no setup view appears you can manually select the
recording settings to be used with steps 2 and 3.

2 From the Select menu, choose Recording Settings.

3 From the Select Recording Setting File dialog box, choose
Default Recording Settings and click OK.
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4 In the setup window that has been opened click on the
Record dialog button found at the top of the Setup view.

VERIS™ will prompt you to give this test data file a name
and a folder to store it. By default, from the Setup view, the
program uses the last name, first initial, exam date and eye
tested as the file name and stores it in the Veris Data folder
located with the other User Documents folders.

5 Modify the file name as you like and click the Save button to
bring up the Recording window.

6 Place the luminance calibrator shell over the stimulator
refractor lens and, using the left / right arrow keys, switch
the input mode from amplifier to Signal from Calibrator.
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In the top right rectangle of the recording window you would
normally see the image of the eye camera or the fundus
camera. If you have the eye camera connected you should
now see an image of the sensor of the calibrator.

On the left side of the screen you should see the signal trace
from the calibrator. Below it you will see the real-time
computed response from one of the stimulated patches
displayed during recording

If you have a fundus or eye camera connected and the camera
image does not show in the top right rectangle, consult “Setting Up
the Eye Monitoring Camera” in Appendix A.  

7 Click on the “Record Next Segment” button. A "Segment
Progress" bar below the buttons shows the progress in the
recording of the segment.

If the oscilloscope trace shows that the signal is
unacceptable, you can interrupt the process at any time by
pressing any key on the keyboard. Please try it. You then
restart the segment.

When a segment has been recorded, the corresponding icon
changes its color from green to red. A red line in the
oscilloscope window at the bottom allows you to evaluate the
contamination of the record by blink and eye movement
artifacts.

8 Repeat step # 6 until all segments have been recorded. The
Record Next Segment button now becomes Accept
Recording. Accept the recording.

In most cases an Analysis protocol will be associated with the
Recording protocol and the screen will now show a tabbed Analysis
window. Select the different Analysis view tabs to display the data.

If the Analysis window doesn't appear you can manually apply
Analysis settings as we selected Recording Settings earlier.
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1 From the Select menu, choose Analysis Settings.

2 From the Select Analysis Setting File dialog box, choose
Default Analysis Settings from the mfERG folder. (Our
default recording is an mfERG.)and click OK.

3 Click OK and select the different Analysis view tabs to
display the data.

The Desktop
Each time you start VERIS™ a window containing a new setup
view appears on the "desktop" with the temporary title "untitled."

Multiple VERIS™ program files can be open on the desktop at the
same time, each in its own window. To make a window active
simply select it.

Similarly, multiple different programs can be open on the desktop
at the same time. You can switch between open programs by
simply clicking on the window of an inactive program to activate it.



1 - 8 Chapter 1   Getting Started

VERIS™ Science 5.1 Reference Guide

You can always switch to the Finder (the Mac "home base") by
clicking anywhere on the desktop outside a window.

Whenever VERIS™ is the "active" program, its menu bar will be
displayed next to the Apple menu on top of the desktop.

VERIS™ Menu Bar

Dimmed menus or menu items indicate operations which
are either not available at a particular stage of the
program or are only active in other VERIS™ software
packages.

When contacting EDI with a technical question, it is very
important that you tell us which version of VERIS™ and which
version of the Operating System you are using.

1 With Veris™ Science as the active program, pull down the
Veris menu, found at the left end of the menu bar.

Select "About VERIS™ Science..." to display the VERIS™
Splash Screen and version number.

2 At any time you can pull down the Apple menu.

Select "About This Mac" to display the Operating System
version number, the computer's total memory and its
processor(s). Select "More Info..." to gain further information
about your computer.

The Mac Help guide is a great resource of information when you
need assistance with your computer.

To access this guide, switch to the Finder and from the Help pull-
down menu select the Mac Help command. Type a few words or
a phrase in the text box then press return to see a list of relevant
topics. Double-click on a topic to open it.
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2 - Setting Up a Recording

The Setup View
During installation, a set of Recording protocols was
placed in the Recording Settings folder on your computer.
A description of the supplied Recording protocols can be
found in Appendix B.

With VERIS™ Science you can modify existing Recording protocols
or create your own. These protocols determine all stimulation
parameters.

1 Start the VERIS™ Science program by double-clicking on
the program icon. An untitled Setup view, containing the
Recording protocol of the "Default Recording Settings" is
displayed.

2 You can either modify this protocol or use the Select menu
to choose an alternate protocol from those stored in the
Recording Settings folder.

For this tutorial we'll use the mfERG to discuss the Setup
View. Later sections of the Reference Guide will address
the mfVEP.
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The Setup view is divided into a series of parameter sections.  You
enter parameters using a series of dialog boxes that correspond to
each of these sections.

You can click on one of the dialog buttons along the top of the
setup document to open the dialog box for that section or simply
double-click on that section of the setup window.

Subject Parameters
In the first section you enter personal data about the subject.

The default layout of the Subject titles may not meet your needs.
You can easily make changes to these fields as shown in the
following section, "Changing Subject Titles."

3 Click on the Subject dialog button (or double-click in the
area of the Subject parameters) to open the Subject
parameters dialog box.

Each field has an associated data format, either characters,
numbers, or date. A characters field can have any
combination of text and numbers. A numbers field will not
allow text.

A date field accepts only certain formats and converts them
to a day, date, month, and year format. To change the Date
format use the "Date & Time" System Preferences... from
the Apple pull-down menu.

4 Click on some of the parameter fields and make entries into
them.

5 Use the tab key and shift-tab key combination to move
forward or back between fields.
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6 From the Eye Tested menu select from the choices, Left
Eye, Right Eye, Binocular VEP, Binocular ERG, or
Dichoptic mfVEP. The appropriate fields will be activated to
add refraction, pupil size and visual acuity.

Dichoptic stimulation duplicates the stimulus display. The stimulus
will consist of two arrays side by side. (In analysis views you can
look at the responses for the left and right eyes separately or
together for comparison.)

It is very important to correctly select the eye tested. This
information is used in analyzing the data. It is also used as
part of the default name of the newly recorded data file.

7 Click OK when you've finished entering Subject Parameters.

The program checks each entry for the proper format. If an
entry does not contain a valid number or date, you must
correct that field before the dialog box will close.

Editing Data Entries

All editing is done within the dialog boxes. Click and drag the
mouse to highlight the text to be edited. Use the delete key to
erase the text or just enter new text. Tabbing between fields
highlights them automatically.

The Edit menu commands - Cut, Copy, Paste and Clear work
with individual field entries only.

Selecting a dialog box’s Cancel button removes all changes made
since you opened the dialog box.

Changing Subject Titles

Future versions of VERIS™ will include database functions for
finding and sorting files by Subject fields such as Last Name,
Visual Acuity, Date, etc.

If you change Subject titles we strongly encourage consistency,
so that in the future your efforts to search, sort, and display your
many files and those of your colleagues will be successful.

Also note when making changes that, by default, the program
creates a title for each recorded data file using the entire first field
(Last Name) and the first letter of the second field (First Name).

Pop-up menus for each field contain titles and an associated data
type for each major category of information. For special categories
there is a "Custom Title" option at the bottom of each menu.

1 From the Parameters menu, select the "Change Subject
Titles" command. You will receive a warning about changing
subject titles.
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2 Click Proceed to open the dialog box containing 16 pull-down
menus, most showing their current titles.

Titles for fields containing data cannot be changed. If you have
entered data into Subject fields the pull-down menus for these
fields will not be accessible until you remove the data.

3 Pull down the title options menu for Title 15 or 16 that
currently has "No Title".

A black dot designates "No Title" as the current choice. You
can either choose from the title options shown (which have
pre-defined data formats) or create your own "custom" title.

4 Choose the "Custom Title" option to open the Custom Title
Settings dialog box.

5 Enter a name for your custom title and select a data type to
be associated with it.
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6 Click OK to close the Settings window.

Your custom title should now be visible as Title 15 or 16 in
the Change Subject Titles window.

7 Click OK to close the Change Subject Titles dialog.

The size of the Subject Parameters section is dynamic. It
adjusts to accommodate all titled fields and it has just added
a new line to incorporate your custom title.

You can easily change ALL of your Recording Settings files to
match your new Subject titles in one step!

Use the "Other" button on the bottom of the Change Subject
Titles dialog box to highlight your entire Recordings Settings folder
(or individual files) and select "Choose."

Comments
Use this section to enter subject or experiment comments. The size
of the Comment section is also dynamic and adjusts to the length of
the text.

1 Click on the Comments dialog button to open the Subject
Comments dialog box.

The Comments section is only visible if comments
have been added.

2 With the Comment window open, type in some text.

If your comments reach the bottom of the text area, the
vertical scroll bar activates, allowing you access to the
balance of the text screen.

Your choices in the next four Setup sections, Geometry, Colors,
Temporal and Acquisition will determine the success of your
recording. In each section we explain how to enter and change
parameters choices. "In Depth" sections explore the selection
process in greater detail.
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Geometry Settings

In this section you select the stimulus picture and a fixation
target for your recording. You also enter physical details about
the size of the stimulus image on the screen and the subject's
distance from it.

VERIS offers a variety of pictures with different types of scaling
depending on what you are recording. The size of the stimulus
matrix is usually determined by the signal to noise ratio. Ideally you
want a similar ratio at each location.

For photopic recording you get large responses at the center
so the stimulus patches can be small there. Signal density drops off
fairly rapidly with eccentricity. Therefore you need to make
patches larger in the periphery to get the same signal to
noise ratio. Retinal mechanisms not having this emphasis on the
center will require different scaling.

With very small signals, like pattern ERG’s, you may have to
make stimulus patches larger in order to get a good signal to noise
ratio from each element in a “reasonable amount of time”. (For
clinical applications this would be 8 - 16 minutes.)

The scaling of these patches will, in turn, limit the total number of
patches (spatial resolution) you can stimulate within the
achievable field size and will also depend on the stimulus monitor
display size and the technology.

1 Click on the Geometry dialog button to open the Geometry
Settings dialog box.
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2 Pull down the Stimulus Picture options menu to reveal a
list of choices and change the picture from Hexagon 103 to
Hexagon 241.

The new picture appears, scaled to fit in the small preview
window. In this default view, the size of the fixation target is
scaled relative to the picture preview and takes into account
the subject's distance from the monitor screen and the
screen height and width.

                            

To select a pattern or custom picture, including pictures created
in other drawing programs, choose "Import Custom" from the
Stimulus Picture options menu or use the File menu's "Import
Stimulus" command.

Pattern stimulation pictures will be discussed in depth in the next
section, "Color Settings".

3 Check the "Show Actual Size" box to show the fixation
target actual size.
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In Actual Size view the fixation target is shown the same
size as it will appear to your subject on the stimulus monitor.

The fixation target size, and its location relative to the center of
the stimulus, are specified in visual angles.

4 Under Screen parameters, double the Subject distance (the
distance from the subject's eye to the monitor display) to 80
cm by highlighting the box and typing in the new value.

The fixation target size grows as you move further away,
relative to picture size. You have increased the subject's
distance but kept the target's visual angle value unchanged.

5 Double Screen height & width to 58 cm x 76 cm. (These
values are for the active scanned area - not the total
glass area on the monitor.)

Although the target size does not appear to have changed, its
actual size relative to the enlarged stimulus image is smaller.

It is important that the values for Subject Distance and Screen
size are correct. They are used in the density plots (2D) to draw
eccentricity rings in 5 degree intervals.

6 Now return the Subject Distance and Screen size to
their original values.
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What is the subject's visual acuity?

To ensure that the intended retinal area is stimulated, each
stimulus picture is provided with a fixation target for fixating on a
center point.

The appropriate fixation target type, size, and location relative to
the center of the stimulus picture can all be selected using the
Geometry Settings dialog box. Fixation Target color will be
discussed in the next section, Color Settings.

7 Experiment with the Fixation Type pull down menu
choices. (The Cross 2 option can be helpful for subjects with
little central retinal function. The Circle is useful for VEP
recordings using checkerboard pictures.).

Observe how changing the Fixation parameters, Diameter,
Pen size, and Fixation x and y values affect the fixation
target in the preview window.

The center of the stimulus picture is the x and y coordinates
origin for the fixation target. Positive values move the
target up and to the right. Negative values move it
down, to the left.

8 Select the Cross 2 Fixation type.  For subjects with
maculopathies you will want to use a very large target.  Use
a Diameter value of 50 degrees & reduce the pen size
to 5.

Some of these subjects have a preferred retinal locus so they
can see this intersection eccentrically with a preferred retinal
locus. However, if you remove that center all together and
ask them to fixate on the center of the spikes they may do
better.

9 Use the Free central zone in deg control to remove the
center of the Cross 2 fixation target. Use a value of 7
degrees. (This control only works with the Cross 2.)
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Selecting the Fixation Blinking Task  checkbox creates a
sporadic blink during the recording process. You can ask the
subject to count the number of blinks in a segment and compare
that to the number generated. The number of blinks
generated appears in the recording window.

The Hexagons stretch factor controls the scaling (change
of hexagon size with eccentricity) of stimulation pictures. The
hexagons are scaled in order to get approximately uniform
responses across the field.

Pictures first appear with the default stretch factor which
are fine for most purposes. They were chosen by trial and
error so that the scaling would be almost the same for all
pictures.

Use a stretch factor of 0 for no scaling. When testing
rod function you don’t want any scaling. With an
unscaled picture, stray light will be similar from every single
element. The diffuse light bouncing around in the eye from
reflections will be the same.

It is difficult to compare arrays recorded with stimuli of
different “stretching” factors.

10 Slowly increase the stretch factor from 0. Note that as
the number gets larger, the outer hexagons become bigger
relative to the center.

The Hexagons zoom factor is useful for looking at details of
the hexagons when you are in the Show Actual Size mode -
for instance, when you want to renumber the stimulus
elements.

Renumbering the Stimulus Elements

By default each cell is assigned a unique number row by row, from
left to right, consecutively. Each stimulus cell flickers individually.

There are three reasons why you may want to re-organize the order
or renumber the stimulus elements.

First, you can now import a custom stimulus picture created
in any drawing program. When you import such a picture (using
either the "Import Custom" option from the Stimulus Picture pull-
down menu or the File: Import Stimulus command) it is just a
collection of shapes which VERIS converts to a multifocal stimulus
array and assigns cell numbers based on the layer in which it was
created in the drawing program. You can change the numbering
within VERIS and the new order will be saved as part of the
Recording Settings.
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The second reason is to re-organize the order so that you
change the numbers of neighboring cells. You may be
interested in mutual kernels and the interaction between neighbors.
Or, with a small array you may want to have the center hexagon
flicker and then each of the surrounding ones flicker consecutively,
instead of row by row.

The third reason is to enable you to have certain hexagons
flicker together by assigning different hexagons the same
number.

1 Select the Hexagon 103 Stimulus Picture and check the
“Show Numbers” box below the preview window.

When you select the Show Numbers checkbox it activates
the  Renumber checkbox and shows the cell numbers and
how they are stimulated. The preview window currently
shows the default numbering system.

2 Check the Renumber checkbox and experiment with the
two options - "sequentially from" and "to same number."

The “sequentially from” option starts with the number you
assign in the box to its right. Click on a cell and it gets the
new number. Click on additional cells and they get reassigned
the next consecutive numbers.

The “to same number” option assigns the number in the
box to each cell on which you click. The "compact" option
corrects for any gaps in the numbering sequence.
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Using the “reset“ option puts the numbers back to the order
in which they were last saved as part of the Recording
Settings.

The “Show Centers” checkbox shows you the locations of
the centers of the traces - where each trace in the Trace
Array plot is to appear. This is a particularly useful
adjustment in stimulus pictures such as dartboards where
the central traces might otherwise overlap.

With every custom picture file there will be a centers file
for locating the trace positions in the Trace Arrays and the
positions of numbers in the numeric 3D mode.

The “See Through Fixation” checkbox makes the target
transparent so you can read numbers through it.

Recommendations for Raster Scan Stimulation Devices
VERIS currently uses CRT based display technology for stimulation in
some of its devices. These and other displays such as scanning laser
ophthalmoscopes (SLO), and liquid crystal displays (LCD) use a raster scan
that stimulates different areas of the visual field sequentially, usually from
top to bottom. While this is not noticeable perceptually, raster scan
causes relative delays of the signal from different retinal areas.

VERIS automatically compensates for the delays between stimulus patches
at different areas of the screen in all its plots. Note, however that such
corrections are not possible within each patch. When an individual patch
becomes very large, the corresponding response is generated by local
stimuli at slightly different times. Thus the fine, high frequency structure of
the ERG response will become washed out.

We therefore do not recommend ERG recording using stimulus
patches covering the entire screen or a large portion of the screen.
The problem is somewhat less serious for VEP recording, as the cortical
response is poor in fast, high frequency components.

The relative delays between different screen areas are larger and the
problem becomes more serious the lower the scan rate. We therefore do
not recommend the use of slow scanning displays for multifocal
recording.

Under certain stimulus conditions the local responses are strongly affected
by interactions between the stimulus patches. In these cases the sequencing
of the stimulation - the direction of the scan across the retina - will affect the
local responses. The response waveforms may change when the display is
turned upside down. Using fast scanning displays minimizes such effects.

Color Settings
In order to generate retinal responses, the subject views an array of
patches (stimulus picture) on a monitor. This array has a specific
pattern and color (or luminance) scheme.

Each element in the array is stimulated sequentially in a specific
order, according to a series of (+1)'s and (-1)'s, called an m -
sequence. These individual +1's and -1's, which make up the m-
sequence, are m-sequence steps.
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In Color Settings you choose the number of frames (the number of
times the screen is re-drawn) in each m-sequence step.

You also select the dynamic color (luminance) scheme and pattern
for the stimulus patches and the static colors (luminance) for the
fixation target and background. In conjunction with the Geometry
dialog  box you can choose a subset of the hexagons to modulate in a
different way from the rest.

1 Double-click in the Colors area of the Setup Document to
open the Color Settings dialog box.

This dialog box graphically shows one m-sequence step. The
current choice is 1 frame per m-step. The icon for that frame
is shown in the preview window, subdivided into its two
possible states.

In a typical multifocal flicker stimulation, as shown below,
the (+) color by default is white and the (-) color is black.
Each patch will be modulated between white and black,
depending on the m-sequence step.

Each frame represents one scanned video frame. A video
board with a 75 Hz frame rate, refreshes 75 times per
second, or approximately 13 msec. per frame.

If you want to slow down the stimulation sequence you
can increase the number of frames in each m-
sequence step. By adding one frame to each m-sequence
step you would slow down the change to the next step by 13
msec.

2 Increase the number of frames per m-step from 1 to 6
by typing the new value or clicking the arrow key.
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The preview window now shows icons for the six frames.
Each frame may have its own colors for setting up
transient or sustained stimulations.

For a sustained stimulation you would follow the initial m-
sequence modulated pulse with additional identically
colored frames (as shown below).

To set up a transient stimulation, you would follow the
initial m-sequence modulated pulse (frame 1) with dark
frames - inserting frames whose colors are all black.

Selecting the Color (Luminance) Scheme

1 Double-click on either half of an icon to open the Choose
Color dialog box and enter color or gray values depending on
your monitor type.

If you have properly calibrated the luminance of your
stimulus monitor these controls will accurately set the
luminance values in cd/m2.

2 Select a new color and click on the OK button to transfer
your color choice to the icon square.

You change the Fixation and Background colors in the same
way, by double clicking on their icons.

3 Drag the center of your color-changed square to the center of
another square to duplicate the color.
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4 Drag between the (+) and (-) squares to copy both colors to
another frame.

5 Click on the Info button in the Color Settings window to
access these instructions at any time.

Note: Color (luminance) selections for the Microdisplay
stimulator are made in the Color Settings window itself. More
information on the Microdisplay can be found in Appendix A.

Modulate (or mask) subsets of stimulus patches

You can choose a subset of the hexagons and modulate them
in a different way from the rest.

1 Re-open the Geometry Settings dialog box and make sure the
Show Actual Size box is not checked.

2 Click and drag the cursor over some of the hexagons in the
picture to select them.
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3 Return to the Color Settings dialog box.

Note that a new option appears when you select a subset
of hexagons in the Geometry Settings dialog box, "Show
Colors of Masked Polygons".

Check the "Show Colors of Masked Polygons" to view and
change the colors for the masked selected hexagons.  They
will be modulated according to these colors.

The unmasked patches will be modulated according to the
colors shown when the "Show Colors of Masked Polygons"
box is unchecked.

We can also use this feature to do masking.

4 Set both colors to the same value as the background color.

The selected hexagons will be the same shade regardless of
whether the m-sequence is a (+) or a (-). So they will be
effectively masked when the stimulus runs.

Custom Stimulus Pictures
Most current stimulus pictures use hexagons, which can be packed together
efficiently and which can be scaled without significant distortion. VERIS
includes a folder of additional pictures titled “Custom Stimulus Pictures”.
Use the “Import Custom” selection in the pull-down menu to load these
additional pictures.

The custom pictures are divided by stimulus mode, “No Patterns” and
“With Patterns”. The “No Patterns” pictures are “Flicker” stimuli similar
to the basic set of pictures in the pull-down menu. During the binary m-
sequence stimulation, each frame is assigned one color for (+) and one for (-).
The “With Patterns” pictures are “Pattern” stimuli. Pattern pictures are
chosen in the same way as flicker pictures. Each frame, however, can be
assigned two colors for (+) and (-).

The custom pictures include Dart Boards. The Dart Board pictures are
scaled for cortical responses to be used with VEP recordings.

You can also create your own custom stimulus pictures in a graphics
program, such as Adobe Illustrator, and use the same “Import Custom”
command to load your picture. Refer to the previous section, "Renumbering
the Stimulus Elements" for more details.
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Importing a Pattern Picture will automatically change the Color
Settings display for each frame from one to two columns.

Pattern Stimulation:

1 Using the Import Custom command in the Geometry dialog,
select a pattern stimulus picture.

The pattern stimulus consists of two sets of patches - like a
checkerboard with interleaved black and white checks. You
have two sets of checks that can be modulated independently
between the two states.

2 Select the colors in the Color Settings dialog box.

When a pattern picture is selected each symbolic frame has
two vertical columns. Each column symbolizes the colors in
one of the two sets of subpatterns that we have in the
pattern stimulus.
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The default setting shown produces pattern reversal.
The first part of the subpattern (first column) is modulated
between white and black. When the m-sequence is a (+) it is
white, when it is a (-) it is black. The other part of the
subpattern is counter-modulated compared to the first set.
When the m-sequence is a (+) it is dark, when it has a (-) it is
white.

For Pattern Appearance, in order for the pattern to
appear when the m-sequence is (+) and disappear into the
background when the m-sequence is (-), assign two colors,
(black and white) to the (+) and assign the background color,
gray, to the (-).

Static Colors
Neither the Fixation target or Background color is modulated
according to the m-sequence.
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Create a "Time Slice" Recording

NOTE: This is an advanced technique. If you are just beginning
to learn VERIS you may wish to skip this section for now and
return when you have mastered the basic techniques.

You can now select and look at different “time slices” in a “multi-
frame” m-sequence stimulation.

1 Open the Color Settings dialog and increase the number of
frames per m-step to 4 frames.

This means that for these frames the same value of the m-
sequence will be used to determine the state of each hexagon.
In the first example, for four frames each hexagon will
remain either bright or dark.

We have another option. We can select the Use Time Slices
box. Now we can place arrows at each frame. At every point
where there is an arrow, the following frame(s) will update to
the next step in the m-sequence.

If we only had an arrow before the very first frame, this
would be the same stimulus as the previous example without
time slices.
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2 Check the Use Time Slices box. Click on the arrow after the
second frame to activate another arrow.

By putting another arrow after the second frame, the m-
sequence will update (advance to the next step) after every
second frame.

The stimulus would look identical to one with only two frames
per m-step but it will be stored in a special way that allows
separate processing of the first frame pair and the second
pair.

You can use time slices to study many interesting responses.
For example, we could examine the effect of a flash on
consecutive responses.

We could set up a stimulation and make the first frame a full
field flash followed by three m-sequence frames. We can now
separately process the response to the first frame after the
flash, to the second frame after the flash and to the third
frame after the flash.

Once the responses have been recorded using time slices, you
will be able to selectively choose the particular slice you wish
to view.



Chapter 2   Setting Up a Recording          2 - 21

VERIS™ Science 5.1 Reference Guide

Temporal Settings
In this section you define the balance of the stimulation sequence
parameters for your recording.

Based on your selection of stimulus picture (number of stimulus
patches), frame rate, the m-sequence exponent, the duration of
each m-sequence step and the biological system parameters,
VERIS™ automatically selects the "best" binary m-sequence.

In selecting a stimulus picture, keep in mind that increasing the
number of stimulus patches to improve resolution also requires
increasing recording time to avoid response overlap.

The Temporal Settings dialog box instantly calculates the effects of
changes made to these inter-related values.

1 Click on the Temporal dialog button to open the Temporal
Settings dialog box.

We first address the standard multi-focal m-sequence stimulation
method provided with VERIS - Video M-Seq. The Ganzfeld
stimulations are reviewed in Chapter 6, "Ganzfeld Recordings."

Additional choices are provided under the Stimulation Type pull-
down menu. We will address them briefly at the conclusion of this
section.

Total recording time is determined by the Frame Rate (screen
re-draw rate), Frames per m-step (number of re-draws in each
m-sequence step) and the M-sequence exponent (the number
of "steps" in the series).

The Frame Rate is the number of times the video card re-
draws the screen. This value should be left at the default
setting of 75 Hz (75 times per second or approximately 13.33
ms per frame) unless your monitor has different
requirements.
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The Frames per m-step setting controls the number of
screen re-draws in each m-sequence step. (This control is
also accessible in the Color Settings dialog box.)

The M-sequence exponent setting determines the number
of "steps"(m-sequence steps) in the series.

The total net recording time is calculated according to the
following formula, where N is the m-sequence exponent.

T =
2N −1[ ] × Frames / M − Step[ ]

Frame Rate

For an M-sequence of 15, with 1 frame/m-step and a frame
rate of 75, as you can observe in the Temporal Settings
Summary, the total recording time is 7 minutes 17 seconds.

2 Change the M-sequence exponent value and look at the
range of recording times possible.

3 Increase the Frames per m-step to see how total
recording time is increased. Selecting 1 Frame per m-step
runs the stimulation at "full speed."

Adding additional frames “slows down” the stimulation
increasing the amount of time necessary to complete the m-
sequence.

Choosing the total recording time

Recording times of 30 minutes are impractical both from the
standpoint of patient endurance and the size of the data generated.
Recording times below 7 minutes create lower signal to noise ratios.
Each time you double the recording length you double the amount of
repetitions, and improve the signal to noise ratio by 40%!  

Also, recording times below 7 minutes create a higher chance for
overlap.  With longer m-sequence length, you reduce the possibility
of overlap between higher order terms.  However, with longer
recording times the response degrades due to fatigue.  There are
trade-offs.

The most practical range seems to be between 8 and 16
minutes. 8 minutes is bearable.  The last 4 minutes of a 16 minute
run can be torturous.  Keep in mind that even if the total recording
time is broken into segments of 30 second or less, with more
segments you increase the total time of the experiment.
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Biological system parameters

These parameters must be based on what you know and expect
will be the visual system responses.

Biological system memory is defined as the preceding time
interval within which visual stimulation can affect the response
amplitude at the current time.

The Maximum kernel order is the largest number of preceding
stimuli (or flashes) whose interaction contributes significantly to
the current response.

The kernel spread for a given kernel order is the largest time
measured in units of m-sequence steps between the first and the
last of the interacting events. The Maximum kernel spread is the
largest spread up to the maximum kernel order selected.

The “best” m-sequence for a specific experiment is the one that
resolves all kernel slices up to the max. kernel order and up to the
max. kernel spread while also accommodating the largest possible
system memory and avoiding kernel overlap.

Kernel overlap occurs when the response of different kernel slices
begin to overlap within the system memory such that you can’t
separate them out numerically. In sequence they are happening too
close to one another - before one kernel ends, another one begins.

As noted earlier, VERIS™ selects the "best" m-sequence
automatically based on the number of stimulus elements, net
recording time, and biological system parameters.

Based on these values, VERIS™ also calculates and exhibits in the
Temporal Settings dialog box the maximum biological system
memory allowable in order to avoid kernel overlap.

Selecting The Right Biological System Parameters

Without being careless or overly conservative there is actually a
very safe procedure you could follow to quickly approximate
Biological System parameters.

Do a one input experiment - just one field. Use the Hexagon 37
picture (better signal to noise with a larger field) and mask all but
the center element. Then look at all the kernels. You can really
see where they disappear in the noise and you can estimate the
highest kernel order that is significant and the maximum kernel
spread. You can insert these parameters.
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Using a large field the recording time need not be very long. (If you
put that element in the center, you may get more kernels out of the
noise than if you put it in the periphery.)

You must either have an estimate of the system properties from
previous experiments, or you have to do an experiment that
allows you to estimate them accurately.

That would be a single input experiment, as just explained. In a
single input experiment, you can easily choose parameters that
guarantee no overlap.  The overlap problem only becomes severe
when you have multiple inputs.

The number of patches (inputs) in the stimulus picture affect the
maximum allowed biological memory.

4 Select the Info button to see how stimulus pictures with
greater or fewer patches than the currently selected choice
would affect the system memory length.

Number of segments

The number of segments determines how long each segment is. How
long can your subject look at the screen without blinking? The
length of each segment is calculated and shown in the Temporal
Settings Summary field.

5 In the Summary field, note the current length of each
segment.

Assuming our settings are 75 Hz, M-seq. = 15, and Frames
=1, each of 8 segments in a 7 min., 17 sec. recording length
would be 54.61 seconds.

If the subject can comfortably fixate for 30 seconds at a
time, increase the number of segments until the length in
each segment approximately matches that value.

6 Pull down the Number of segments menu and select 16
segments.

The length of each recording segment is now a more
manageable 27.31 seconds.
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The segments are recorded slightly overlapping and are spliced in a
way that forces a smooth transition. A linear splice is done in the
region of overlap beginning with 100% of the old segment, 0% of the
new and increasing the percentage of the new until there is 100% of
the new and 0% of the old. (If you have a low frequency noise, this
technique avoids generating a step when you splice.)

Samples per frame

Samples per frame sets the discrete number of samples of the
voltage taken per sweep of the screen. Due to the way signals from
the eye are digitized, there are only a discrete number of samples of
the voltage taken per sweep of the screen. In between those times
the voltage isn’t constant, but the data acquisition card doesn’t
know that. Aliasing is when there are a lot more frequencies in the
signal than you are sampling and you see frequencies and voltage
fluctuations which don’t really exist.  

To avoid aliasing you match your sampling rate (samples per
frame) to the signal frequencies by making sure the sampling rate
is slower than the highest frequency you have.

For example, to really see oscillatory potentials, where high
frequency rates are around 100 Hz, and see differences in
components 2-5 ms in time, you want to open up the amplifiers
from 10 Hz to 300 Hz. To resolve those differences turn up the
sampling rate from 8 to 16 samples per frame - doubling waveform
resolution.

NOTE:  Doubling the number of samples per frame also doubles the
amount of data collected and the file size.

7 Change the number of Samples per Frame to see the time
between samples calculated.

Pre-exposure

Pre-exposure determines the lag between the onset of stimulation
and when the collection of data begins. When the stimulation is
switched on there is often an onset transient you want to avoid. So,
when a segment is started, the stimulation is begun shortly before
starting the actual recording.

It also takes a certain amount of time for the signal from the eye to
generate retinal signals (or to travel up to the cortex if recording
from the brain). Usually pre-exposure is set at 1 second (1000
ms).

8 Change the Pre-exposure value and see the change
reflected in the Summary.



2 - 26          Chapter 2   Setting Up a Recording

VERIS™ Science 5.1 Reference Guide

Additional Stimulation Methods

The standard stimulation method provided with the VERIS
system has been the Video M-Sequence Stimulus. With the
current release VERIS now provides additional choices under the
Stimulation Type pull-down menu.

Video & Triggered M-Sequence
Video & Triggered Periodic

These options generate a pulse through the A to D connection
coinciding with the first element on the screen. When the first
element is flashed then you also get a pulse through the A to D.

One use for these modes is in auditory experiments. If you need to
generate beeps they can be triggered with a pulse through the
digital IO.

The M-sequence option provides pulsed or sustained pulses,
generating a pulse when the m-sequence has a 1. The Periodic
stimulus is simply pulsed on and off.

The timing for these options rely on the vertical blanking
pulses from the video board. In these modes the stimulus
can only be incremented in steps of 1 frame period (13 msec
at 75 Hz).

1 Select either of these video board triggered options.

A new Trigger Parameters box appears at the bottom of the
window.

The length of the pulse is determined by the Duty Cycle
which is a percentage of the frame period. (If you have a 13
msec frame rate, a 10% Duty Cycle will yield a 1.3 msec
pulse.)
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With the Positive Trigger box checked this will be a “pulse
high” as shown in the graphic. An unchecked box will yield a
“pulse low” and the graphic representation is reversed.

As with all Stimulation modes, the effects of any changes
are reflected in the Summary section.

Timer Triggered M-Sequence
Timer Triggered Periodic

These two options use timers so that the timing is
independent of any vertical blanking that the video board
may generate.

2 Select either of these timer triggered options.

Note that in these modes the Frame Rate in Hz changes to
Flash Interval in ms.

 
When the m-sequence has a 1 in the pulsed mode it will generate a
brief pulse in that base period. In the sustained mode, it will stay on
until the next m-step occurs and then go down or stay up depending
on the m-step value. Pulse length is determined by the Flash
Interval. (If you have a Flash Interval of 10 ms and you have a
Duty Cycle of 10% the it will on for 1 ms and off for 9.)

With Periodic Stimulus you set the Flashes per segment and
recording length independent of the m-sequence.

Binaural & Triggered M-Sequence
Binaural & Triggered Periodic

These are similar stimulations that do auditory stimulation with
stereo earphones. You can test the response to one ear stimulus,
the other ear, or the interaction of the two. These tests have proven
useful in auditory electrophysiology.
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Acquisition
In this section you enter data acquisition and amplifier settings and
activate the optional Eye Camera/Refractor.

Most new installations of VERIS™ include a Grass amplifier
controlled through the computer's serial port using the amplifier
settings in this section.

The program checks for this connection upon startup. If it doesn't
find one, a notification appears informing you that you will need to
set your amplifier manually.

1 Open the Acquisition Settings Dialog Box.

The Acquisition Board Type is usually detected and set
automatically.

2 If you are using an external board or the board type is
wrong, use the pull-down menu to manually switch to the
correct type.

If you are using an external board, you will be prompted for
its location (IP Address and Port #).

VERIS™ currently supports one sampling board with 8 analog
channels. With an external card you may record up to 256
channels.
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3 From the Analog Channels pull-down menu, select the
number of channels you will be recording.

4 From the Acquisition board gain pull-down menu, select
the gain factor you will be using.

The "board gain" should be set at "1" for the PCI board
supplied with VERIS™.  

5 In a similar way, select your External Amplifier Gain
setting as well as the Low and High Cutoff, and Notch
Filter settings with the appropriate pull-down menus.

For mfERG we recommend - Gain: 50 K,
Low Cutoff: 10 Hz and High Cutoff: 300 Hz.

For mfVEP we recommend - Gain: 100 K,
Low Cutoff: 3 Hz and High Cutoff: 100 Hz.

We recommend that the "notch filter" on the amplifier
be turned off as it distorts the waveform. (We can
remove powerline interference with digital filtering which is
discussed in Chapter 4.)

The Gain Setting on the amplifier must match the setting
for External Amplifier Gain in the software. This setting is
used to construct the amplitude scales and convert to
amplitude densities. If they don't match, you'll get
abnormally small or large amplitudes.

If the amplifier filter settings are not the same as what we
recommend it will affect the waveform and latencies, making
comparisons with our normal data invalid.

If you are manually controlling the amplifier, the Low and High
Cutoff and Notch filter settings do not affect the processing of data
but are stored with the file for informational purposes.

Recommendations Concerning Gain Settings

The 12 bit range analog-to-digital converter (ADC) is set to correspond to an
input voltage range of -5 to +5 Volts.  This setting works well with a signal
amplification of 50,000 or 100,000.

If higher gain settings are used, artifacts from micro saccades and blinks
tend to drive the ADC into saturation. During saturation all the signal is
lost. This is not desirable.

To permit precise isolation of the local responses, the record should be as
complete as possible. VERIS contains a sophisticated artifact elimination
scheme that finds and subtracts artifacts due to blinks and eye movements
rather than cutting the contaminated segment from the record. Thus the
signal superimposed on the artifact is preserved. However, this is only
possible as long as artifacts don’t exceed the range of the amplifier and
analog-to-digital converter, that is, as long as they do not exceed the rails
shown in the recording window.
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Recommendations Concerning Filtering

Low Cutoff - (High Pass Filter Setting) - Blinks and eye movements cause
relatively slow excursions, contaminating the signal with predominantly low
frequencies. Unless one has a very good subject, or if low frequency response
components are important, (recording of rod mediated responses) it is
advisable to set the low frequency cut-off at around 5-10 Hz.  This
high setting also greatly reduces the need to run Artifact Removal.

High Cutoff - Low Pass Filter Setting is very closely related to the
sampling rate by the Nyquist sampling criteria.  Setting the filter too high
results in aliasing or frequency folding. In the context of the m-sequence
time-domain analysis such aliasing will exhibit itself by a poor signal-to-
noise ratio in the kernel estimates. To avoid aliasing problems, the
sampling rate should be at least twice the high frequency cut-off of
the low-pass filter. Oversampling, on the other hand, is not recommended
either. It does not improve the kernel estimates and is wasteful in usage of
computer memory and disk space.

Activating the VERIS™ Eye Camera

The VERIS™ Eye Camera comes in several configurations,
including the VERIS™ Fundus camera. This camera allows you to
monitor eye movement within the Recording Window while
recording a patient.

We will examine the Recording Window in the next chapter,
however you must first activate the camera in the Acquisition
Settings dialog box.

1 With the camera attached, select the Eye Camera option
from the pull-down menu, located below Acquisition note. If
you have a Fundus Camera, select that option instead.

If you are not using any camera, it is very important that
"no camera" be selected.

The camera optically rotates the image of the stimulus array by
180 degrees and these options tell the software whether or not to
rotate the response array by 180 degrees so that the processed
data set is correctly oriented.

Real Time Processing

1 Choose the RT Process button, adjacent to the Acquisition
button, at the top of the Setup window.

The Recording Window allows you to monitor the incoming
raw signal and displays in real time the selected kernel slice
of a specific stimulus patch.

Note: Real Time Processing is not available on multi-
channel recordings.
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2 In the dialog box that opens, click on the stimulus patch you
want to observe in "real time" and make sure that the Real
Time Process box is checked

Select a hexagon that you expect will generate a large
response. Choose the central hexagon in normals and
patients with problems in the periphery. Select a peripheral
hexagon for patients with macular problems.

3 You can also choose the kernel slice whose processed signal
you want to be displayed, by clicking on the appropriate
mark on the time scale graphic.

Select the first order kernel for the real time processing
window (tick mark on zero - default) because that signal is
the largest.

A discussion of kernel slices, and the use of the time scale graphic
for choosing a kernel slice, will be found in Chapter 4, "Looking at
the Data."

Digital Filtering
VERIS™ provides a set of digital filters that are intended to
improve signal to noise while avoiding amplifier notch filters,
which can distort data.

To select a digital filter you use the Edit: Edit Filters...
command from the Edit pull-down menu. All parameters changed
using the top pull-down menus are global, modifying all views of
the document.

In the Edit Filters dialog each of these filters is activated by
clicking the checkbox associated with it and then adjusting the
values.

The Power Line Filter is useful for removing interference (50 or
60 Hz.) where poor electrical wiring makes elimination of the
noise difficult.
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The High Pass and Low Pass filters do a non-causal filtering. They
each do a Fourier transform and take all the frequencies above or
below a certain limit and cut them out. They use a sharp cut-off,
leaving a box without doing any fancy cut-off transitions or
“windowing”.

Any signal beyond the selected limits is assumed to be so small and
in the noise that you don’t want to see it. You’d rather have the
noise removed than look for a signal when you can hardly see it.

These filters are very narrow band and will not show much change if
data is not noisy. You can monitor the effectiveness by looking at
the top single trace in the Averages plot window.

Blinks and eye movements cause relatively slow excursions,
contaminating the signal with predominantly low frequencies. It is
advisable to set the High Pass Filter (low frequency cut-off) at
around 5-10 Hz., unless you have a very good subject, or if low
frequency response components are important, (recording of rod
mediated responses, etc.)

Setting the Low Pass Filter (high frequency cut-off) too high
results in aliasing or frequency folding. To avoid aliasing problems,
the sampling rate should be at least twice the high frequency cut-off
of the low pass filter. However, over sampling is not recommended,
as it doesn’t improve the kernel estimates and wastes computer
memory and disc space.

In the VEP, using a Low Pass Filter setting of 35 - 40 Hz can
significantly improve the appearance of the data.
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The Bandpass Filter is used in VEP recordings to control the
alpha frequency. When you close your eyes you generate an alpha
frequency, which is around 10 Hz. Some people generate them even
with open eyes. It really destroys VEP recordings. You don’t find
them in the ERG’s. It is a cortical concern.

In VEP analysis, if you want to use Alpha filtering, you have to use
your judgment because the alpha frequency varies from person to
person. It is usually in the 8 – 12 Hz. range.  This is also where the
response is, so it is bound to distort the wave forms.

Filter by segment - We filter the whole data set as one big array
which allows us to get very very narrow band filtering with, for
instance, powerline filtering.  The problem is that you may have
one or two contaminated segments, correct the problem, and then
all further segments are uncontaminated. Then the powerline
filter doesn’t work.

We recommend selecting the Filter by segment checkbox
on the bottom of the Edit Filters dialog when in doubt. In this
mode the data set is cut back into its original segments and each
segment is filtered separately.

Under certain testing conditions the data might require additional
processing to isolate the response information after recording.

In Chapter 4 we will discuss the two methods of improving the
signal, Spatial Averaging and Artifact Removal, which
VERIS™ uses to improve the signal by replacing noisy individual
responses with the substitution of reliable alternative data.

Saving the Setup document
After entering parameters into the Setup view you can
either begin recording or save the settings. Using the File:
Save As command you have two options.

"Save Subject Setup As..." saves all of the subject's
information as well as all recording settings for use in future
recording sessions for this subject.

"Save Recording Settings As..." creates a new recording
protocol without any subject information. This template is
saved in the Recording Settings folder and can be used for
recording multiple subjects.

If you have not yet saved the document and try to close the
setup view or quit the program you will be prompted to save
the file.
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1 Choose one of the two options to open the Save dialog box.

2 "Save Recording Settings As..." automatically selects the
Recording Settings folder in which to save this Setup file.

In order to select Recording Settings from the Select pull-
down menu, Recording Settings files must be saved inside
the "Recording Settings" folder. This folder is located with
the other program files.

Two other ways to create a Setup using existing files will be
demonstrated in Chapter 3, “Recording a Patient.”

Printing the Setup View
You can print a copy of all your Setup view information as it
appears in the window.

1 With the Setup view "active", select the Print command
from the File menu.

The Print dialog box will appear, from which you can select
your choice of printer, the number of copies and other
options. We will explore the Print and Page Setup dialog
boxes in later chapters.

2 For now, just click the Print button to get a copy of your
Setup information.
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3 - Recording a Subject

Starting the Recording Process

Using Open File

Selecting the Open command from the File menu provides access
to all possible files that can be used to create a new recording
setup. These files can be filtered using the buttons below the file
names to find a specific choice for new setup.

Any data file can be used to create a new setup. Select "Show
only Data Files" and the "for Recording" checkbox to create a new
setup duplicating all subject and recording parameters.

In the last chapter you may have saved your Setup view using
the "Save Subject Setup As..." command. Choose the "Show only
Subject Setup files" button to filter out files that are not Subject
Setup files.

Finally, you can access any Recording Settings files using the
"Show only Recording Settings" filter. Unlike the Select Recording
Settings command, these files do not have to be in a specific
folder in order to be selected for a new setup.

Always observe the following when recording:

1. Never start printing before recording. Print operations
during recording can lead to loss of data.

2. Turn off file sharing before recording.
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Using Select Recording Settings

You will begin most recordings using one of the protocols
contained within the Recording Settings folder. The simplest way
to access these protocols is with the Recording Settings option
from the Select pull-down menu.

The Recording Settings folder has subfolders containing protocols
for the various stimulus and monitor options. Conventional and
Multifocal protocols are provided for  CRT and
Microdisplay.systems. The Conventional and Multifocal protocols
are documented in Appendix B. The Ganzfeld Protocols are
documented in Appendix C.

The primary focus of this Reference Guide is on Multfocal
recording and analysis. We will first look at the multifocal ERG
(mfERG) found in the Multifocal Protocols folder.

                 
Two versions of this protocol are provided. The mfERG B-A has
settings for contact lens electrodes (recording segments of 30
second duration). The mfERG  DTL  has settings for fiber
electrodes, where blinking needs to be suppressed (recording
segments of 15 second duration).

1 From the Select Recording Settings dialog box, double-
click on the appropriate Multifocal Protocols folder depending
on whether your display is a Color or Monochrome CRT
Monitor or a Microdisplay,

2 In the same way continue selecting the mfERG B-A group,
color or monochrome monitor, the dilated pupil subgroup,
and the 103 patch, 7-minute option. (File name: 103,
7min,B-A, 200cd)

A new "untitled" Setup window opens with the parameters
from this recording protocol.
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3 Note the relevant settings found in the Temporal
parameters section of this new window.

The total actual recording time is 7 minutes, 17 seconds split
into 16 segments of 27.31 seconds.

4 Click on the Record dialog button found at the top of the
Setup document.

5 If you have not yet saved your “untitled” document
VERIS™ will open the Save Data File dialog box. You must
save the setup view before doing a recording.

The program will give the file a name by default,
consisting of Subject's last name, first initial, the
current date, and eye examined.

6 If you have not yet calibrated your system, you may receive
additional warnings.

Instructions for System Calibration are given in Appendix A.
For now, click Continue Uncalibrated to proceed.

The picture included with the selected recording protocol, as
shown in the Stimulus preview section of the new Setup
window, will be drawn on your  Stimulus Monitor.

Initial
stimulus
 display
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The Recording Window
When the stimulus picture is displayed on the Stimulus monitor,
the Recording window will appear on your Control monitor. The left
side of the window shows both the raw signal from each electrode
and the processed signal from a specific stimulus patch. The right
side of the window contains recording controls, and aids for
monitoring segment progress.

Monitoring Eye Movement & Position

If the VERIS™ Eye or Fundus Camera is attached and has been
selected in the Acquisition Settings dialog box, a rectangular area on
the top right side will show the video image from the camera. You
can monitor eye movement by the superimposed ring (Eye camera)
or the superimposed stimulus pattern overlay (Fundus camera).

If there is no video image coming from the Eye camera or if the
stimulus pattern overlay in the Fundus camera does not appear
scaled correctly, please refer to the Appendix A sections: “Setting
Up the Eye Monitoring Camera” and “Calibrating the Fundus
Camera’s Stimulus Grid.”

The subject's iris/pupil border will be in focus in the eye camera
when the distance between the subject's eye and the camera is
correct.

The pupil should be centered in the video image. This can be
accomplished by shifting either the stimulator or the subject's head
in the appropriate direction (up, down, left, right).
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If a contact lens type of electrode is used, the pupil should be
approximately centered with respect to the contact lens. If is not,
then the angle of the stimulator (or the angle of the subject's head)
needs to be adjusted. For example, if the pupil is too high with
respect to the contact lens, have the subject look down, either by
leaning the subject's head backwards or by tilting the stimulator
upwards.

Adjusting Fixation
Following proper positioning, ask the subject to adjust the focus
with the refractor while you maintain the stimulator in the proper
position with respect to the subject's head.

To ensure that the intended retinal area is stimulated, each
stimulus picture is provided with a fixation target for fixating on a
center point.

1 Ask the subject if they can see the fixation target.

2 Ask the subject to look at the center of the cross while you
use the eye camera / fundus camera to observe the eye in the
Recording Window for fixation stability.

Is the subject moving their eye around? If so you may need to
adjust the fixation target.

3 Select the Edit Fixation button in the Recording Window to
bring up the controls for the fixation target.

You can make all necessary adjustments to the target while
the subject is viewing the stimulus on the screen without
having to leave the recording procedure.

If the subject is having problems fixating, try making the
fixation cross larger and/or thicker until their fixation
stabilizes. However, do not allow the fixation cross to cover
more than 20% of the area of a hexagon.
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4 Use the Diameter and Pen Size controls to increase the
size and thickness of the stimulation target.

Is the subject's stable fixation at the correct location? If not,
experiment with moving the fixation target in the x and y
directions until their stable fixation is in the correct location.

(If in conjunction with the fundus camera you are using the
optic disc to determine the fixation point, note that there is
considerable variation in the location of the optic disc in
normals.)

5 Use the Fixation x and y controls to move the target.

The center of the stimulus picture is the origin for the x and y
coordinates for the fixation target. Positive values move the
target up and to the right. Negative values move it down, to
the left.

6 Select Cross 2 from the Fixation Type pull-down menu.  

The Cross 2 option, where pen size decreases from the
periphery to center, can be helpful for subjects with little
central retinal function.

For subjects with maculopathies you will want to use a very
large target.

7 Enter a Diameter value of 50 degrees.

Some of these subjects have a preferred retinal locus so they
can see this intersection eccentrically with a preferred retinal
locus. However, if you remove that center all together and
ask them to fixate on the center of the spikes they may do
better.

8 Use a value of 7 degrees in the Free central zone in deg
control to remove the center of the Cross 2 target. (This
control only works with the Cross 2 Fixation type.)
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Fixation Blinking Task
It is often helpful to improve subject fixation by giving them a task
to perform while fixating on the stimulus.

Selecting the Fixation Blinking Task  checkbox creates a
sporadic blink during the recording process. You can ask the
subject to count the number of blinks in a segment and compare
that to the number generated. The number of blinks
generated appears in the recording window.

Monitoring the Raw Signal Quality

The raw signal for each channel will appear as a white trace in its
own box on the right side of the window. (If amplifier and electrode(s)
are not connected, the trace will appear as a flat line across the
bottom of the box.)

The relatively flat line trace that appears below shows how a good
quiet signal should look.

Good Signal

     
The raw signal can be monitored before, during and between the
recording segments. You want to always see a relatively flat trace.
Jumps in the trace indicate that the subject may have blinked or
that there has been eye movement.

Jumps and other noise can also be caused by muscle artifacts
(attempted blinks and other facial muscles), a defective electrode,
or an electrode that is not properly positioned, or perhaps a poor
ground connection.

Large Blink

Small Blink
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Moderate Eye
Movement

Large Eye
Movement

     

     

Since all these artifacts will contaminate the signal, it is important
to recognize them as separate from the ERG. If a segment contains
significant artifacts, you will probably need to re-record that
segment.

You can abort the recording of a segment at any time by
pressing on any keyboard key.

Examining Initial Results for Problems

What constitutes a "good" response signal? Look at the raw signal
on the recording window screen. The signal should initially be a
relatively flat line similar to that generated when the electrode was
in the water. This indicates a good connection on the subject's eye.
If the trace jumps around, that indicates blinks. Little “blips”
indicate smaller eye movements.

Knowing the shape of the quiet signal is important since the ERG
will be superimposed on top of it. During the recording, the little
wiggles on the trace are the ERG that is being recorded. When the
stimulus pattern stops, the trace should return to a flat line.

Monitoring the Processed Signal Quality
The processed signal for the stimulus patch and kernel slice you
selected previously will appear as a white trace in its own box on
the bottom left side of the window. As the length of time you record
increases, the processed signal should improve in shape with fewer
artifacts.

Processed Signal
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Recording Controls

The Record window contains control buttons with which you start
recording individual segments, and stop or complete the experiment.

Record Next Segment:  Select this button to start the first
recording segment and then start each of the other segments in
numerical order.

Accept Recording: The "Record Next Segment" button
changes to "Accept Recording" when the last segment has been
run. Select this button to complete recording of the experiment and
save the data.

Record Current Segment:  Select this button to re-record a
segment that has already been recorded, or to record a selected
segment out of order.

Stop Recording: Selecting this button will stop the recording
process without saving the data.

1 Click the Record Next Segment button to simulate the
recording of the first segment.

The stimulus picture elements are stimulated sequentially
for the duration of the segment.

Segment Progress
Two graphic aids located next to the control buttons help you
monitor your progress in recording segments.

A thermometer-like Segment Progress bar fills as the segment is
run, allowing you to approximate the time remaining in that
segment.

Each segment in the recording cycle is represented by a button
icon. The icon of the currently selected segment is shaded (or
"pushed" in). When that segment has been run, its icon switches
from green to red. (In the illustration below, 6 of 8 segments have
been recorded and the 7th is being recorded.)

     

2 Click the Record Next Segment button to continue
recording the remaining segments.
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Segment Information

After each segment is recorded a red curve appears, representing
the received signal for that segment and showing the distribution of
sampling values for that entire segment, ordered by height and
sorted negative to positive.

The more noise in the signal, the greater the deviation from mid-line.
If the red line flattens out at the top or bottom you have
clipping, since the height of the view reflects the maximum
capabilities of the sampling board.

Extremely Noisy
Segment

     

During a recording session, you may need to re-record a segment
containing poor signals due to noise, or subject eye movement.

In the last example the noise is so bad that re-recording a segment
isn't going to help. This amount of noise is caused by either an
electrode problem or subject discomfort.

In the example below the red line briefly flattens at top and bottom
indicating some clipping. Also, the red line climbs vertically away
from the sides indicating noise in the signal.

Noisy
Segment

     

This segment should be re-recorded since our Artifact
Removal algorithm does not work when the signal clips.

3 Click the Record Current Segment button to re-record the
just recorded segment,.

To record a different segment, click on that segment's icon
button to select it and then click the Record Current
Segment button.

If that segment has already been recorded, you will re-record
it.  If it has not yet been recorded, the segment will be
recorded for the first time.
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To see if re-recording a segment has improved the signal, select
Undo Segment Recording (from the Edit menu) immediately
after re-recording. The results of the previous recorded version will
be shown.  

Select Redo Segment Recording to switch back to the later
version.  Switch back and forth to compare and select the best one
before proceeding.

Occasionally you may find it impossible to get good results
with the current subject or circumstances. In such cases you
can stop the recording.

4 Select the Stop Recording button.

You’ll have the option to Save your incomplete recording or
lose the data. The data will not be a complete set but may be
all you can get under the circumstances.

5 Choose "Abort Segment" to return to the Recording Window
with all data intact.

In the following example the red line is primarily horizontal or
hugs the vertical side walls indicating little noise. There is
little if any clipping indicated.

"Good
Recording"

After all segments have been recorded, the first control
button becomes "Accept Recording." If your data has been
relatively noise free you are done.

6 Click Accept Recording to complete recording.
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Grab Frame

The Grab Frame button captures the video image appearing in the
Recording Window. This can useful as a part of your record for this
subject. You will be prompted with a Save dialog to name the image
and where you’d like it saved.

Minimizing Rod Stimulation during Recording

When recording from a dark adapted subject you can set the
console monitor to a red screen in order to minimize rod
stimulation. This red screen feature can be switched on and off at
any time by clicking on the check box located on the top right
corner of the document window.

Processing of Incomplete Multifocal Records

With the pseudorandom stimulation used for mfERG and mfVEP
recording it is important to always record an entire stimulation
cycle. Incomplete data sets result in imperfect separation of the
focal responses. However, when only a small percentage (10% to
20%) of the data are missing, the data are still usable.

In VERIS™ 5.1 it is now possible to evaluate incomplete mfERG
and mfVEP recordings. If the patient is unable to continue, the
operator can now terminate the recording before all the segments
are collected. The data are processed accordingly and scaled
correctly.
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Saving the Recording as a Data Document
After you "Accept Recording," a dialog box gives you the
option of returning to the recording.

7 Click the OK button to finalize the recording.

The setup document is converted to a data document and
saved with the same name. (As noted earlier, the program by
default gives the file a name consisting of the Subject's last
name, first initial, the current date, and eye examined.)

For multiple channels, a data document is created for each
channel, and the set is saved in a folder with the same name.
Finally, the data document(s) automatically open for
analysis.

Reusing Recording Settings for New Recordings
This new feature is a tremendous time saver. It permits you
to re-use the current settings for new recordings. For multiple
recordings with the same subject this method re-uses all subject
information for the new recording record.

Suppose you have recorded one eye and now want to record the
other. Simply choose  “Reuse Recording Settings” from the
Select menu. A new “untitled” document opens. You only need to
change the Eye tested information and select the Record button.

Or, suppose you are familiarizing yourself with a subject’s data
from a previous recording, If you select “Reuse Recording
Settings”, you can immediately begin a new recording using all
the same parameters and information.

As we have shown, there are three methods for creating new
recording setup documents using existing parameters. First, any
data document (created in Version 3.0 or later) can be opened for
recording. Second, a document can be saved as either a Subject
Setup file or as a Recording Settings protocol. Finally, you can use
the settings of the current file by selecting the “Reuse Recording
Settings” command.
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The Keys to Getting Good Recordings
Considerations while setting up

Electrical Noise

Electrical noise can seriously contaminate recorded data, which to
the untrained eye could be misinterpreted. Noise can occur as
persistent periodic background noise caused by external sources
(Electromagnetic Interference). Occasional noise can also be
generated by poor subject connections.

How to Avoid Electromagnetic Interference (EMI)

In order to minimize interference, the connection from the
electrodes to the amplifiers should be as short as possible. Excess
cable length should be rolled up into a loop rather than spread out.
The input cable should be kept well separated from power cords or
other radiating system components such as the CPU, monitors,
etc. If using a shielding unit on the stimulus monitor, make sure it is
grounded to the grounding screw on the stimulus monitor by means
of the green/yellow wire.

After proper hardware installation the system should be tested for
EMI as follows: Place a bipolar electrode together with a grounding
wire in a small paper or plastic cup with tap water. Connect the
grounding wire to the ISOGROUND jack and the electrode leads to
two selected differential amplifier inputs on the connector box. Place
the container in front of the stimulus monitor at the approximate
viewing distance. Start the program and select “Record”. Observe
the signal in the recording window. It should look like random noise
(a relatively flat line) without any visible signs of periodicity
(cycling).

   
Clean signal     Contaminated signal

Record a standard size data set using this arrangement and display
the trace array. The individual traces should look like random noise
with no signs of periodicity. A spike at the beginning of the traces
indicates interference from the stimulus monitor. Check for proper
grounding.

In the presence of power line interference 60 or 50 Hz periodicities
are clearly visible. Check the layout of the amplifier input cable. In
buildings with poor electrical wiring it may be difficult to eliminate
power line interference completely.
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In extreme cases the equipment may have to be moved to a
different room.

In general it is not advisable to use the notch filter on the amplifiers
to eliminate 60 Hz (or 50 Hz) power line interference as the filter
causes distortions of the response waveforms. However, it can be
used in emergency situations.

Ambient Lighting Conditions

Normal room lighting with indirect fluorescent lights is best. Do not
dark-adapt the subject. Incandescent bulbs and daylight both give
off infrared, which can be a problem if you are using the fundus
camera.

Choosing the ERG Recording Electrode

We recommend bipolar contact lens electrodes (Burian-Allen,
etc.) that consistently provide better signal-to-noise than
monopolar electrodes (such as DTL, gold foil, and loop).

Monopolar electrodes are often preferred because they are
considered somewhat less invasive and can be used without local
anesthetics. Many VERIS™ users have recorded good results with
them. Advantages and disadvantages of the two types of electrodes
are listed below.

Bipolar contact lens electrode    Monopolar lid electrodes

Advantages   Advantages   

Better signal-to noise - achieves higher
spatial resolution in the same recording time.

Less invasive, smaller risk of corneal
abrasion.

Contact lens automatically corrects for most
astigmatism. Only spherical corrections are
necessary for subject refraction.

Subject's spectacle prescription can be used
for refraction.

Contact lens keeps cornea moist and
eliminates the need to blink. Speculum of
electrode prevents blinking.

Binocular recording possible.

Disadvantages   Disadvantages   

Approximate alignment of contact lens and
pupil is necessary, especially when recording
through dilated pupils.

Lower signal-to-noise ratio. Longer recording
times required to achieve the same spatial
resolution.

Binocular recording is not recommended, as
eccentrically placed lenses can introduce
prism diopters causing misconvergence of
the eyes.

Subject is required to suppress blinking for
the duration of a record segment.
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Subject Preparation and Comfort

To achieve high quality low noise records, subject comfort is
extremely important. The subject should be at ease and in a
comfortable position that can be easily maintained for the duration
of the recording.

Subject comfort is increased by the use of adjustable seating, a
comfortable viewing angle, and brief (~30 sec) recording segments.
It is also helpful to get periodic subject feedback and to tell the
subject how many segments remain to be recorded.

Many potential sources for subject "noise" can generate artifacts
into the recorded data. These include muscle tension in the eyes and
lids, eye or body movements, and blinks (which can be reduced by
artifact rejection).

Subject Positioning

The most difficult part of making a successful recording is proper
positioning of the subject and maintaining that position.

There must be method of stabilizing the subject's head with respect
to the stimulator. Their head should be in a fairly fixed and
comfortable position with their eyes looking down at a 10-15 degree
angle toward the screen. We recommend a chair (tilted back by 10-
20 degrees) with a headrest, although some clinicians and scientists
prefer a chin rest.

The subject's feet should be well supported on the floor, their elbows
well supported on armrests. The subject should be able to sit still,
be comfortable and maintain fixation.

Recording Duration

Do not record for too long a period. It is better to record shorter
amounts over several days. You’ll get better data. Even with good
subjects fixation starts going if you record for 15 minutes. You can
see the noise levels building up as time goes on. Two 8-minute
recordings are a lot. It is also better to take the lens out during
breaks in recording. Don't leave the lens on.

If recording with Burian-Allen electrodes, you shouldn't have them
in much more than 15 or 20 minutes. Longer periods may cause
corneal hypoxia, staining, or irritation and can cause corneal
abrasions.

Unless you have an application where the fixation isn't as critical
(i.e. you're not using scaled hexagons) subjects get tired of sitting
still and fixating.
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Ground Electrode Connection

A grounding electrode should first be applied to a convenient
location on the subject's head. The location is not critical, however,
to minimize common mode noise, a site near the eye such as the
forehead or temple is preferable. Ear lobe electrode clips also work
well.

The Grass double-gold cup electrode in an ear clip makes a good
connection, particularly if both cups are filled with an electrode gel
compatible with biological tissue.

Use alcohol pads with pumice (proper electrode pads) to get off all
the natural skin oils, grease, dead skin, mascara, etc. It is
important to get the lowest impedance, resistance between
electrode and skin. If you are using self-adhesive electrode pads, like
pediatric electrodes, you have to dry the alcohol off before you put
them on - alcohol stops them from sticking.

Connect the other end of the electrode to the ISO ground jack of the
amplifier’s input cable. Be sure to tape the wire to the subject’s
shirt to ensure that if the subject suddenly jumps up they won’t rip
out the cable. Taping the ground wire also prevents movement on
the cable lowering noise.

Electrode Application

Apply 2-3 drops of a topical anesthetic like AK-T-CAINE .5% (or
tetracaine, proparacaine) and allow the anesthetic to take effect.

It is a good idea to keep the eyelid of the non-tested eye closed so
that the cornea doesn't dry out. Otherwise, the subject will blink
causing blink artifacts. You can use easily removable surgical
tape to tape the non-tested eyelid, or an eye patch with some
gauze or tissue paper under it that lightly pushes against the lid.
Or, the subject can lightly press against the lid with his finger.

Prior to inserting the contact lens electrode into the subject’s eye,
apply a small amount of artificial tear solution containing methyl
cellulose to those areas of the electrode that will touch the subject’s
eye as additional protection for the cornea and to establish good wet
contact with the cornea. We recommend a sterile solution from little
ampules such as Celuvisc™ or equivalent, since bottled solutions
contain preservatives that can cause eye irritation. Thicker
products do not help stabilize the electrode and often contain
preservatives that irritate the eye. They also seem to delay good
eye contact with the electrode causing poor signal-to-noise in the
early stages of recording.
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Apply one drop to the inner surface of the contact lens taking care
that the outer surface remains dry. Instruct the subject to look
downward. Pull the upper eyelid upward with one hand while gently
sliding the top edge of the speculum underneath with the other.
Avoid touching the cornea with the edge of the speculum.

Now instruct the subject to look slightly upward while lowering the
electrode into the cornea. Pull down the lower lid with the other hand
and slide the lower edge of the electrode under the lower eyelid.

When you put the contact lens on - make sure you don't get any air
bubbles trapped under it. Air bubbles will destroy the image of what
the subject sees. You will then have to take it out, clean off excess
gel and re-insert.

Use a small amount of surgical tape to hold the contact lens
electrode wire to the cheek. This keeps the subject from
inadvertently pulling on the wire and pulling the electrode out. A
good bio-compatible tape to use is TRANSPORE tape. Connect the
red and green electrode leads to the positive and negative jacks of
the amplifier’s input cable.

Corneal electrodes for data acquisition are not provided
with the VERIS™ system. We recommend the use of
electrodes manufactured by Hansen or Doran. Follow the
instructions accompanying these electrodes carefully.

Subject Refraction

If a contact lens electrode is used, the subject must be refracted to
the viewing distance after electrode insertion. When recording with
HK-loop, DTL, or gold foil electrodes, the subject can use their own
reading glasses.

If refractive lenses are used, the subject is best refracted by means
of a small eye chart and the set of refractive lenses provided with
the instrument.

If the subject is viewing the stimulus through the VERIS™
Refractor/Camera, they are instructed to focus the refractor for
best vision of the fixation cross. If the subject has poor central
vision it may be necessary to adjust the fixation cross to make it
clearly visible. (See the following section, "Adjusting Fixation.")

If the VERIS™ Fundus Camera/Stimulator is used, the operator
can focus the refractor for best focus of the fundus image on the
console monitor after the subject has been properly positioned. (See
the final section of this chapter, "Fundus Monitoring.").
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The contact lens electrodes correct for most astigmatism while
other electrode techniques such as DTL do not. The spherical
correction provided with the VERIS Refractor/Camera is quite
adequate for any ERG recording with a contact lens electrode.

Proper refraction is particularly important when
recording PERGs and mfPERGs.

PVEP recordings from astigmatic eyes require cylindrical
correction and are best done with the subject's own
corrective lenses. Do not, however, use bifocals or
progressive lenses!

Electrode Care

To clean the contact lens electrode: Don't let tears dry on the
electrode. Dried tears are very hard to remove after they are dry.
Rinse well to get rid of mascara, mucus, etc. You may need to use a
hard contact lens cleaner, like a Boston (surfactant) cleaner, to rub
the surfaces in order to get the proteins off. Then rinse again.

Clean with a 50/50 mixture of liquid TIDE (or any mild detergent)
and distilled water. Do not soak electrodes in acidic (hard) water. It
will cause electrolysis between the solder (tin/zinc) turning the silver
on the electrode black. If left over a weekend, the solder joints will
fall apart and the electrode will have to be reconditioned. You may
RINSE the ERG electrode with tap water. Soaking in water doesn't
cause electrolysis unless the water is HARD tap water.

To disinfect the electrode: After cleaning, We recommend
using a high level disinfectant such as Cidex OPA (ortho
Phthalaldehyde) See the product directions for proper usage.

We do not recommend using bleach however many labs do. You
can disinfect after cleaning by soaking in a 1:10 dilution of sodium
hypochlorite (Clorox) for no longer than 5 minutes! Longer exposure
causes the silver to turn brown. Then use the same soapy water
mixture and a toothbrush to lightly scrub the silver (only the silver).
Be careful not to scrub the wire spring. Then rinse. With bleach,
some deterioration will occur over time even when mixed properly.

Note that the distilled bleach must be mixed properly - the
concentration of bleach is 0.05% (NOT 5.0%). (Straight CLOROX is
5.25%)

You can only do this for electrodes that will stand it such as the
Burian- Allen. You can't put gold electrodes in bleach. Note that
when using bleach, the concentration is 5,000 ppm.
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We do not recommend hydrogen peroxide or alcohol, which
can both damage the electrode.

For the ground electrode: It is very important to rinse off all the
electrolyte, which is highly corrosive. If you get the electrode paste
underneath the shrink tubing where the wires are soldered onto the
connectors you will eventually corrode those connections. You won't
know it until you start getting noise. A toothbrush is useful with lots
of running water to try to dislodge as much as you can

Additional Electrode Care

The electrode has been tested for electrical leakage at the factory.
However, for safety it should be tested weekly or whenever it has
suffered abuse of any kind. For instance, when it has been
accidentally left in a sterilizing solution for extended periods of time.

If the leakage currents measured as shown in the simple steps
below exceeds 10 µA, the electrode must be returned to the
manufacturer for refurbishing.

Measurement of Leakage Currents

1 Submerse contact lens electrode in a beaker of tap water together
with a grounding electrode. Make sure that the ground electrode
does not directly touch the contact lens electrode.

2 Connect lead wires for IR emitting diodes to battery box.

3 Measure current between all possible pairs of the three electrode
wires using the multimeter provided.

Special Concerns with mfVEP Recordings

Patient Preparation & Comfort

It is more difficult to get good data with the multifocal VEP than
with multifocal ERG. The subject must be relaxed, especially in the
neck muscles and the upper shoulders. To avoid muscle artifacts
you don't want muscle tension. As with the mfERG, the chair is
very important.

A slightly reclined head position is recommended using a good,
comfortable head support. We also recommend a travel type pillow
that fits around the neck and supports the neck muscles.

EMG noise contamination should be minimized through careful
positioning of the patient. When entering the record mode, try to get
the oscilloscope display to get as flat a trace as you can. Invest
some time adjusting the subject's position, chair, pillow, etc. Your
investment will be rewarded with much better data.
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Electrode Placement

Consult the current ISCEV recommendations for electrode
placement.

Good results have also been reported using 2 channels with the
main channel's electrode placement 2 cm below the inion and 4 cm
above midline with a reference on the forehead to keep noise down.

The second channel is lateral - 4 cm left of midline, 4 cm to the right
of midline, and about 1 cm above the inion, between the two
hemispheres.

Fixation & Refraction

MfVEP records are much more sensitively affected by fixation
inaccuracy, fixation instability, poor refraction and opacity of the
optical media of the eye, particularly in the central field.

The tiny checkerboard stimulus patterns have only a few pixels per
check. Any kind of refractive error will blur out the checker board
and you will get little if any response. The subjects should be
provided with spherical as well as cylindrical correction usually by
means of the subjects' eye glasses (no bifocal or progressive lenses).

Even minor eye movement, because response waveforms are very
different nearby, can wipe out the response since you are basically
averaging response waveforms that are opposites.

Fixation Cross targets get buried in the mfVEP stimulus pictures.
We recommend a circle with 100% pen size that will fill it in.

Stimulation Pictures

Two recording protocols are provided for the mfVEP. The standard
is the "1m" which uses a single frame per m-step. The "2m" slows
the stimulus down to two frames per m-step.

If you have a VERIS™ dichoptic stimulator you can record
mfVEP's for both eyes at the same time. A set of "dichoptic"
protocols are included in the Recording Settings folder.

Fundus Monitoring (with the optional FMS II Unit)

Optimizing the Video Display for Maximum Contrast
Since the infrared fundus image is of relatively low contrast, it is
important that the control monitor and the video controls for the
camera image are adjusted to maximum brightness.

1  On the Control monitor, adjust the contrast and
luminance controls to achieve maximum contrast.

2 In VERIS™, click on the Acquisition button and select
Fundus Camera in the Acquisition Settings dialog.
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3 Use the Up/Down arrow keys to switch from Fundus to Eye
Camera in order to obtain proper pupil positioning.

4 Now click on the Record button.

5 In the Recording Window, double-click on the video image
or select the Calibrate Camera button.

6 Select the Levels tab in the Calibrate Camera controls.

7 Adjust the Brightness and Contrast settings as necessary
to achieve a good image of the subject's eye.

When switching between eye camera and fundus camera the
brightness level may need to be adjusted.

The Contrast and Brightness controls on the Stimulus
Controller Box have been adjusted prior to shipment and
should not need to be adjusted.

Positioning of the Stimulator/Camera

1 Position the subject’s pupil in the approximate center of the
circle in the video image.

2 Ask the subject to focus on the fixation target and make sure
that they can see it clearly. (This is very important,
particularly with mfVEP recordings.)

The correct distance of the eye from the camera lens is
achieved when the pupil is in sharp focus.

3 Change the switch in the camera control box to Fundus.

Positioning the Fundus Illuminating Infrared Source
There are currently 2 methods of providing fundus illumination.
With the COBRA™, infrared illumination of the fundus is done
through the sclera. A special Burian Allen electrode available from
EDI provides an alternative method. Two tiny infrared emitting
diodes are built into the speculum.
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COBRA™

The COBRA™ is a self-contained, battery-operated unit, which
provides trans-scleral infrared illumination. It should be attached as
shown in the photograph. (Alternatively it can be mounted below
the eye, if it interferes with the ERG electrode.)

  
You should see a fundus image with a clearly visible spot indicating
the location on the disc. If you don't see the image:

1 If the subject has good visual acuity, have them turn the
focusing knob on the stimulator/camera until a sharp image
is achieved.

Otherwise, you will need to try to achieve the best focus.

2 Optimize the image quality using the brightness control in
the camera image control panel.

The illumination control knob on the COBRA™ power supply
can also be adjusted to equalize differences in the brightness
settings of the eye and fundus camera.

 3 Adjust the COBRA™ placement.

Small changes in position can make a big difference, from no
image to a good image. The COBRA™ can be bent slightly to
better direct illumination backward into the eye and away
from the stimulator lens.

Things to try for a better image: While holding the COBRA™
by hand, a) try moving it closer or farther from the eye. b)
bend the illuminator more or less to change the angle at
which the IR goes into the eye, and c) move it to slightly
different positions around the eye.

IR EMITTING BURIAN-ALLEN ELECTRODES

1 To use the electrode follow the instructions for insertions and
sterilization provided with the standard Burian-Allen
electrode.
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2 After electrode insertion connect the battery leads (coaxial
connector) to the battery unit provided. After proper
positioning of the stimulator/fundus camera and following the
instructions for its use, you should obtain a fundus image
with an overlaid grid of the stimulus.

Fundus Illumination with Anesthetized Subjects

When used for stimulus positioning with anesthetized subjects,
alternative methods of fundus illumination are available. An
infrared emitter can be placed in close proximity to the sclera for
fundus illumination. Make sure that the eye lens of the
stimulator/camera is shielded from any direct light emitted by the
diode, as this will severely degrade the image.

Getting a Good Fundus Image
The position of the pupil is the most important factor in
getting a good fundus image.

The pupil needs to be centered with respect to the fundus camera
(which is generally, but not necessarily, exactly in alignment with
the eye camera).

In other words, optimal pupil position could be slightly off-center
when viewed by the eye camera. The absolute center of the screen
may not be the best position. It takes some experimentation to find
the optimal parameters for the best fundus image.

All new model fundus cameras have an aperture adjustment
lever that has a big effect on the quality of the fundus image.

This lever can be found on the back of the black shell that houses
the fundus camera lens. (You may need to move the fundus camera
all the way back with the refractor knobs in order to see it.)
Generally, the lever should be located near the middle of the range
defined by the open slot that limits how far it can be moved.

Moving the lever in one direction increases the aperture setting,
allowing more light in. The other direction will reduce the aperture.
Making small adjustments to the aperture setting can improve the
fundus image. If the aperture setting is open all the way or closed all
the way, it may not be possible to see any fundus image.

It is much easier to get a good image with a dilated pupil.
Although it is possible to get an image with a natural pupil, there
is little room for error.
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4 - Looking at Your Data

Opening a Data Document
If VERIS™ is currently running, select the Open command from
the File menu. Using the "filters" in the Open dialog box to show
only data files, you can select and open the document you want to
analyze.

     

In the Finder you can also double-click on a document's name or it's
icon to open it, whether VERIS™ is running or not.

Additionally, when you finish recording a subject, the newly created
data document is automatically opened for analysis.

In each case, the document will open in its own window.

1 Select the Open command from the File menu and make
sure that the "Show only Data files" option is selected

2 From the Open dialog box that appears, select the Sample
Data Files folder.

The Sample Data Files were placed inside the VERIS™
folder during installation.

4 In turn, select the Normals subfolder, and the "103 areas 8
min" folder to reveal the contents.
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5 Double-click on "B49-CJ" to select and open it.

The Data document window opens in Subject view with multiple
tabbed analysis views. Many data files can be open at the same
time. Each file will open in its own window with its own analysis
settings.

The number and type of tabbed views, and the parameter
settings for each view are determined by a n  Analysis
Settings protocol.

Initially a specific protocol or a Default Analysis protocol will be
associated with a newly opened file. Its title will appear below the
File window’s title.

6 For now, make sure "Default Analysis Settings" is the
selected protocol. If not, use the Select menu to select it from
the Analysis Settings .
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VERIS™ includes an Analysis Settings folder which contains
protocols for the each type of recording. A description of the
supplied Analysis protocols can be found in Appendix B.

Using the Integrated File Navigator

The File Navigator appears on the right side of every document
window and permits quick access to data files. At the top of the
Navigator are two buttons.

The “Home” folder contains the file used to open the window. (If you
started VERIS™ by double-clicking the program icon, the Home
folder will be the folder that contains the VERIS™ program.) Click
the Home button to show its contents.

The second button activates a pull-down menu “tree” of folders,
from the current folder on top, down to the desktop. Use this menu
to navigate to the desired folder and document file.

Double-clicking on a data file in the Navigator will open the
document in the currently active window. The new file opens in the
left side of the window, replacing the file currently displayed, with
the same tabbed view and using the old file’s Analysis
Settings.

Alternatively, holding down the Option key while double-clicking a
data file loads it as a reference file. It doesn't replace the currently
displayed file. Depending on the parameter settings both files can be
displayed for comparison, as detailed in a later section, "Using
Reference Data."

You can also use the File Navigator to drag and drop multiple files,
and folders containing data files, into a Combination Window. (We
cover the Combination window, used to combine files and create
reference files in Chapter 5.)

Once a data file is opened, the File Navigator will filter its
selection so that only compatible files will be accessible. All other
files will appear dimmed.

To quickly find a specific file, type the first letters to jump to the
first file in the Navigator starting with that character.
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The Analysis Plot Types

The Analysis plots are graphical tools contained within the
document window for working with your data. Each plot type and
its parameter settings are determined by the Analysis
protocol being used.

Each tabbed view may contain a single analysis plot, as
illustrated below, or several different plots. The layout of each
view is determined by the Analysis protocol.

You can create your own analysis environment with
customized tabbed views. The Default Analysis Settings
provides a set of “canned” views which are explained below. In
Chapter 5 we will show how to create and edit your own views.

1 Select the Traces tab to open a view of the Trace array.

Each tabbed analysis view is divided into four areas. Across
the top are control buttons for changing an analysis plot's
Spatial Averaging, viewing its parameters, and displaying
normal reference data.

Displayed on the left side are the parameters which control
how the plotted data is presented. (You may need to select
the Show Info control button to see this area.)

The largest area displays the analysis plot(s) for this tabbed
view. A horizontal band at the bottom can be used for your
own comments specific to this window.
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You can resize the document window in several ways. Drag the
box in the lower-right corner vertically, horizontally or diagonally
to enlarge or reduce the entire window.

Placing the cursor between the Navigator window and the plot
view changes it to a vertical bar, allowing you to shrink or expand
the Navigator window.

Using the buttons on the top left corner, you can switch between
full screen and a smaller size by clicking on the green button. Hide
the window in the "dock" by clicking on the yellow button. The red
button closes the document.

     

Traces Plot Tab (Default Analysis Settings)

The Traces plot displays an array of response traces plotted with
the same spatial relationship as the corresponding stimulus
elements. Initially, the response traces are plotted unscaled in order
to avoid crowding toward the center. They do not reflect the
eccentricity scaling of the stimulus array.

(Depending on the Analysis protocol, a set of Normal reference
traces may be superimposed over the traces of the data set.)

2 If the parameters are visible, click on the Hide Info button
to better show the trace array.

3 Double-click on one of the traces to get a separate zoomable
window to examine that trace in more detail (or compare it to
a reference trace by opening a second window when only
Normal traces are displayed).

You can change the scale factor of this window by using the small
plus and minus buttons on the top left corner.

We will return to the Traces view, but first we'll open a view for
each of the other analysis plot types.

Custom Averages Plot Tab (Default Analysis Settings)

Often the individual traces shown in the trace array are too noisy to
reveal details of interest. However, it is possible to average together
traces from areas where the response characteristics are known to
be similar.
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These group averages represent accurate waveform estimates for
different retinal areas. They can also be used as templates to
estimate local response amplitudes discussed in the next view type,
"3D Plot (Density)."

4 Select the Averages tab to open the Averages plot.

If necessary, use the scroll bars on the bottom and right side
to see the entire view

Depending on the Analysis protocol, this window displays one of four
types of group averages.

Response Density Scaled amplitudes (shown), in which each
trace is scaled to compensate for stimulus size, gives an accurate
view of actual response amplitudes.

Normalized is used to compare waveform shapes, with the
amplitude in each trace having approximately the same size
vertical excursion.

Normalized to Feature Epoch is similar to Normalized. Instead
of the entire response, you can normalize to a specific portion of the
response, selecting the epoch that contains the feature you want.

Sum of Groups amplitudes, in which the traces for each grouping
are added together, provide a cumulative response and are useful in
comparing the entire retinal response of one subject to the total
response of another.
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A graphic showing how the traces were grouped to calculate
the averages can be found to the right of the traces, and also
with the other settings in the parameters area. (The default
shown is ring averages.)

You can combine responses in any configuration using the
Edit Groups button. This option for grouping, and all the
other analysis parameters are explored in the following
section, "Changing Analysis Parameters."

3D (Density) Plot Tab (Default Analysis Settings)

In the 3D Plot, a single value is derived for each stimulus picture
element. Depending on the Analysis protocol used, there are several
methods for calculating the response density (Scalar Product and
RMS) or latency (peak, small feature and slope) for the signals
derived.

5 Select the 3D Plot tab to open the Density Plot view.

The Density Plot assigns a color to each value derived for the
stimulus picture elements and graphically displays the range of
responses superimposed on the elements.

When viewing the plot in 3D, each element is assigned a height as
well as color for the values derived. This third dimension is useful for
visualizing response characteristics.

Density
Plot

The Scalar Product method (shown) takes into account both
amplitude and wave shape differences and provides an enhanced
topography when traces vary little across the visual field.
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The RMS  method does not use group average templates. It
calculates the root mean square of the trace values. This method is
useful when individual traces have much local variability.

The Analysis protocol determines the methods for
calculating response density and latency.

The Traces, Averages, and 3D Plot are the “building blocks” for
visualizing your data. The Multi-Plot and protocol-defined
custom tabs are assemblies of these three building blocks.

MultiPlot Tab (Default Analysis Settings)

The MultiPlot tabbed view is a set of three 3D Plots, assembled to
compare the current file to a second file or to a reference set of
normals.

6 Select the MultiPlot tab to open the MultiPlot view.

7 If no “Difference” or “Reference” plot is drawn you first must
select a Normals file.

Use the Select pull-down menu, Reference: Normals... to
open the Select Normal Reference Files dialog. Then select
the"ref 103" file.

In tabbed views with multiple plots, you must first click on one of
the plots in order to view its parameter settings and activate the
buttons for that plot.
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Changing Analysis Parameters
A powerful feature of VERIS™ is your ability to work with multiple
open data document windows. Parameter settings determine how
the data is viewed in each window. It is therefore important to
understand how changing these parameter settings can affect the
various tabbed views.

When you open a file, you open a document window that contains
multiple tabbed views of the data. An associated Analysis Settings
file determines what information is presented and includes
parameter settings for each plot.

Analysis Parameters can be changed in two ways.

1.  Individual settings can be changed for each tabbed view by
editing any of the parameters found in that view. Editing
parameters in one view does not affect parameters in any of the
other views.

2.  All document settings can be changed globally, including
choice of tabbed views, by applying a new protocol. This can be
from another Analysis Settings file or another open data document
window.

Once you alter any parameter, the name of the Analysis Settings
file being used turns red, indicating that a change has been made.

Trace Array Parameters

During a recording, VERIS™ measures the electrical response of
many regions of the retina to light stimuli and analyzes the results
using correlation coefficients. A correlation coefficient is calculated
between the stimulus at one time and the response at a later time
to see if there is a relationship.

The derived response is plotted as a trace plot. The time window of
the response trace that you are looking at is called the epoch and is
specified by a start and end time.

1 Select the Traces tab to open the Trace array plot.

2 If the Traces parameter settings are not visible, click the
Show Info button.

The settings for parameters which affect the display of
individual traces, Kernel Slice, Epoch, Spatial Averaging
and (Trace Array) Scaling are shown in the left column.
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3 Click the Edit Parameters button.

The Traces Parameters dialog box appears.

Along with the subject data, both a second data file and a
normal reference file can be selected and displayed in the
same tabbed view for comparison.

In the Display section on the top left you select which two
files are displayed in the tabbed view. The pull-down menus
and Display 2 Offset values control the appearance of the
files. Displaying reference data is covered in a later
section.

4 For now we will examine the data file alone. Check to make
sure that neither a Normals File nor Reference file name
appears below the File window's title.

If necessary, use the Select pull-down menu to Remove
Normal Reference or File Reference files.

Kernel Slice Selection

VERIS™ can calculate not only the correlation coefficient between
a response and a single stimulus, but between a response and a
pattern of stimuli over time. If you look at two flashes, is there a
correlation between these two that is not explainable as the sum of
the response to the first plus the response to the second? The
higher order kernels are such a measure.

The response to a particular stimulus pattern is called a
kernel slice and is symbolized with tick marks on a time scale.
The tick at time 0 represents the last stimuli of the pattern. The
difference in time between the stimuli and the response is measured
from this last stimulus.
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Kernel Slice selection is made on the time scale graphic. Think of
this graphic as a waveform starting at zero on the right, and the
tick marks as the preceding stimuli that generate that waveform.
Each numbered tick on the time scale represents one m-sequence
step in the stimulation series. In this example the tick marks are
13.3 msec apart.

One mark indicates the first order kernel, or response to a single
stimulus. The graphic currently shows a single mark on the “0” tick
mark, designating that the traces begin when the focal stimulus is
displayed. If it is put on “1” then the traces begin one frame after
the focal stimulus occurred. (In other words, the numbers below the
line indicate display frames.)

When first looking at a Trace array, you usually will select the first
order kernel which is the mean response to a flash. From the
appearance of the traces in this initial array you can decide what
additional kernel slices to look at. In the kernel domain there are
lots of kernels.

To get the second order kernel, two tick marks are necessary. If
the marks are placed at “0” and “1” then you will display the first
slice of the second order kernel (i.e., interactions between two
stimuli in two successive m-sequence steps - often successive
flashes).

5 In the Kernel Slice and Epoch section of the Traces
Parameters, click above the "1" to select the interaction
response generated by two stimuli 1 m-step apart (tick
marks at "0" and "1"), the first slice of the second order
kernel.  (To remove a mark, click on it again.)

If the marks are at “0” and “2” then you will display the second
slice of the second order kernel (i.e., interactions between two
stimuli, two frames apart).
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Two consecutive frames will sufficiently interact with each other to
generate the second order kernel - you can think of this as
adaptation. If you had a flash immediately before, then the
response to the second flash would be smaller. That will generate
the first slice of the second order kernel.

6 Now click on OK to look at the first slice of the second order
kernel. Notice that the traces in this plot are smaller than
the first order kernel.

Why Look At Higher Order Kernels?

Higher order kernels are very important, particularly in things
affecting the output end of the retina. The retina has all kinds of
adaptive mechanisms. It starts in the receptors and then you have
more adaptation coming into play, also contrast adaptation. These
mechanisms are the ones that generate higher order kernels. They
are non-linearities.

If you are interested in glaucoma - for instance, optic atrophy -
then you want to isolate components that are predominantly from
the inner layers of the retina. By going to second order kernels you
get that. Those are enriched in those components from the inner
retina because that’s where the signals are more non-linear than in
the outer retina at the input end.
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Epoch

The epoch parameters control the length of the response at which
you are looking. How much of a response do you want to plot?
Changing the epoch start is useful in filtering out quick initial
artifacts when the real visual response happens 5-10 mSec later.

Selecting the epoch end will depend on how long the response lasts.
The Averages tabbed view can give a good estimate of this time
frame.

You can either enter values or click on the up or down arrows to
increment the value, one msec at a time.

Scaling (Traces)

(Traces) Horizontal - The Horizontal Scaling controls how the
traces are drawn horizontally by assigning the ratio of screen pixels
to the number of samples (data points).

The options on the pull-down menu span from one pixel per 8
samples (1:8) to eight pixels per sample (8:1). Whenever the
number of samples is greater than one, VERIS™ skips samples
to plot the trace.

(Traces) Vertical - The Vertical Scaling controls how the traces
are drawn vertically by assigning the number of pixels to the
measure of amplitude.

The scaling legend in the lower left corner of the Traces view will
also be updated.

7 To see how much noisier are the second order responses,
increase the Vertical Scale to 300.
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Improving Signal to Noise

Depending on the testing environment, the parameters used, and
the patient’s ability to fixate properly for the time required, the data
set may require some additional processing to isolate the response
information. VERIS™ uses several methods for improving the
signal, replacing noisy individual responses with the substitution of
reliable alternative data. The two methods covered here are Spatial
Averaging and Artifact Removal.

Spatial Averaging

Spatial averaging replaces each value associated with a stimulus
element with the average of this value and each of the values for
the element's adjacent neighbors.

Spatial Averaging

Spatial Averaging works by applying for each point i in the response trace
p the following formula where:

X( ) is the response function.
N is the total number of neighbor traces (maximum of 6)
% is the Percent selected
q is the designation for neighboring traces

  
X(pi) =

X(pi ) + (%)X(qi
1) + (%)X(qi

2 ) +K + (%)X(qi
n)
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With the hexagonal stimulus picture, each element has a maximum
of 6 neighboring elements. (VERIS™ detects those on the
periphery that don't have 6 neighbors and averages only with the
existent neighbors.)
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Spatial averaging is repeated up to 3 times as specified in the
Iterations control. This is an absolute control. (The number of
iterations shown in the window is always the total number of
iterations that the program performs.)

With 2 iterations, Spatial Averaging takes the first result and
then does averaging on top of that. So each neighbor is already a
part of its neighbors from the first round.

You assign the weight each neighbor will get with the Percent
setting. To average with 1/6th of each neighbor use 17%. The
smaller the value, the less each neighbor is averaged in, and the
more each value retains of its own identity.

8 Click the Edit Parameters button and select 2 single
iteration of Spatial Averaging at 17% and click OK.

Spatial Averaging is only available if no Normal reference file has
been selected. If necessary, remove the Normal file using the
Select: Reference: Remove Normal Reference command.
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NOTE: One possible disadvantage of this method is the averaging
of low responses with good ones, thus blurring out the border. If the
responses are really localized, they will disappear. If widespread,
instead of a steep abrupt change you get just a graded one. With a
noisy signal however, Spatial Averaging provides a good
compromise.

9 Select the Undo Parameter Editing (Traces) command
from the Edit menu to see the "before" view and to remove,
for now, Spatial Averaging.

This ability to switch back and forth when making changes can
be very helpful. The Undo/Redo feature only applies to the last
set of changes made in a dialog box by clicking the OK button (not
Cancel).

Artifact Removal (Global Parameter)

Artifact Removal, although included in our discussion of
Individual Parameter Settings, is a global parameter affecting all
views of the document. All parameters changed using
VERIS's menu bar are global.

The objective of running the Artifact Removal is to remove
artifacts caused by blinks and small eye movements. The algorithm
used detects these artifacts and replaces the traces at the location
of the artifacts by the best prediction based on the entire record.

The method is related to the well-known technique of replacing
outliers in a distribution by the mean. It is only effective when
there are true outliers, i.e., when we are not dealing with a normal
distribution. In the absence of artifacts, no improvement will
be observed. Blink and movement artifacts are excellent
examples of such outliers. They are detected by their large
deviation from the signal predicted by the extracted kernels.

1 From the Edit pull-down menu, select Edit Filters…”

2 In the Data Filters dialog click on the “Use Artifact
Removal” checkbox to select the appropriate parameters.

Select the Significant Kernel Slices by looking at the
kernels of each of the slices and making a judgment based on
their size, or use what others have recommended.
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Select the Epoch parameters by looking at the signal and
selecting that portion which represents real signal. Maybe 0
to 80 isn't correct - maybe 0 - 75 is more like it. You don’t
want noise at the end as part of the signal.

3 Select 2 Iterations for Artifact Removal.

4 Select the first order and first and second slices of the
second order kernels - all with 0 – 75 Epoch.

You do this by selecting each kernel slice and its epoch
separately. (The default condition is the first order kernel
with 0-80 epoch.)

When you modify the highlighted Epoch the "Delete" button
becomes a "Modify" button.

When you add a mark to the Kernel Slices graphic, the
“Include” button is activated. Make sure the Epoch length for
each slice is what you want and then use the Include button
to add that slice for processing.

NOTE: With heavily contaminated data, you get a better estimate
of the signal by using Spatial Averaging. Therefore, the Artifact
Removal algorithm, in the first iteration, first performs a
Spatial Averaging (17% of each) before subtracting the kernels
from the original data set.
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We recommend that you always perform 2 iterations of
Artifact Removal before analyzing your data, unless it is
extremely noise-free.

The following illustration shows our Trace array with the two
iterations of Artifact Elimination applied.

Artifact Removal

The artifact elimination algorithm does up to 3 iterations on a basic artifact
elimination algorithm. The algorithm creates an estimate of the processed
signal by locating the kernel slices that you've indicated over the epoch
you've indicated. You may wish to point it to find just one kernel slice over a
particular epoch or you may wish it to find a couple. Why not choose all
significant kernel slices?

Choosing all, especially with a 241 element picture and an 8 minute
recording, may take up 60% or more of the entire cross-correlation cycle.
Whatever you subtract (you now subtract these kernels) you also subtract a
large percentage of the noise. You no longer get a good estimate of the noise.
Only select the very strong kernel slices which are important in predicting
the response.

With the ERG for instance, the kernel series converges very fast. Even the
first slice of 2nd order kernel may be down by a factor of 5. So the first
kernel in itself is already a very good prediction of the signal. You're better
off only selecting the first order kernel in many instances.

With a Pattern ERG, the first order kernel is not there. Instead you pick the
first slice of the 2nd order, which is the largest response. That's the best
prediction of the signal. With the VEP the other kernels are just as large as
the first order. There you may do different things.
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So this basic artifact removal algorithm starts with your best estimate of
the signal (which could be an enhanced processed signal). It then subtracts
your best estimate of the signal from a newly processed cross correlation
leaving the best estimate so far of the processed noise.

The algorithm then does a back transform to get the best estimate of the
unprocessed noise. It then finds the standard deviation and looks for
portions that stick 2 Standard Deviations or more above the average. Such
points probably identify an artifact such as a blink.

You identify the whole artifact by moving back and forth in time to where it
crosses zero. There you're picking up parts of signal which fall below 2 SD
but are associated to that peak (foothills).

Any data beyond the threshold of 2 SD are considered to be contaminated.
The procedure affects not only the signal beyond the threshold [a1b1 &
a2b2], but the entire segment to the nearest zero crossing [a,b]. The signal
from [a,b] is replaced by the best estimate based on the entire data set.

The algorithm takes that (best estimate of noise) and subtracts it from newly
unprocessed read-in data to get the best estimate of noise free raw data. It
processes that to derive a new estimate of a processed data set.

Use Imported Trace Array

All plots are derived from the trace array. You can export a
trace array using the File/ Export Processed Data command, do
some filtering in another program such as Microsoft's Excel, and
then import it back in.

An exported trace array file does not contain all the information of a
data file, such as picture type, etc. (You can only import it back into
the same data set from which it was exported or one whose data
characteristics and analysis protocol match up with those of the
trace array.)

Check the Use imported Trace Array box in the Parameters
window to import such a file. A dialog box will open from which
you can select the appropriate trace array file.
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Misc - Exact Positioning

This option puts each trace at the center of its stimulus element,
reflecting the eccentricity scaling of the stimulus array. It is helpful
when superimposing a fundus image. (Overlaying images and plots
will be discussed in Chapter 5.)

Misc - Use Baseline

If you include in the epoch of your traces all of the response, the
very beginning and very end should be near the 0 “baseline.” If you
have low frequency contamination the whole trace may be on a
slope so that one end is lower than the other. It will look better and
more interpretable by putting it on a straight line. This checkbox
straightens out the baseline on which it sits.

It takes the average of the first 3 points of the data set and the last
3 points and puts a straight line through these two averages points.
It then  subtracts this straight line from the trace. Now the
beginning and end are at equal height and the whole trace has been
straightened out. (For this technique to work you must plot the
complete response, from the beginning to the end, when the
response dies down to the zero line).

NOTE: The remaining settings will be discussed in later
sections of this guide.

View (Field/Retinal)  (Global Parameter)

VERIS™ presents all plotted data in either the Field or Retinal
view. Use the Parameters pull-down menu to select which view
you prefer. The field view is as if your eye were projecting onto
the screen. It is the same view as a perimetry field. The retinal
view is as if you were standing looking through the subject’s pupil
at the retinal surface.

All tabbed views in the active window are changed when you
choose this global command. Each view will display "Field View" or
"Retinal View" to designate the type of orientation selected.

We opened this document using the Default Analysis Settings
file. Since we've changed some parameters the Analysis Settings
name now appears in red in the document window. VERIS™ no
longer prompts you to save your changes.

If you want to keep the parameter changes you’ve made, you must
save the new settings. Otherwise, they will revert to the unaltered
Settings file last used. We will discuss saving settings files at the
end of this chapter.
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Averages Parameters
1 Select the Averages tab to open the Averages view.

2 If the Averages parameter settings are not visible, click on
the Show Info button. If several plots are in the Averages
view, click on one of the traces to reveal the parameters for
them.

3 Double-click anywhere in the Parameters display column,
but above the Groups picture.

This shortcut to the Edit Parameters button opens the
Averages Parameters dialog box. (Double-clicking in the
Groups picture would open the Edit Groups dialog box.)

The Averages view shares some of the same parameter
types as the other views. The two boxes on the right, Scaling
and Misc., contain some settings unique to the Averages
view.

Scaling (Averages Parameters)

Horizontal Scaling - Similar to that of the Trace Array,
Horizontal Scaling controls how the traces are drawn horizontally
by assigning the ratio of screen pixels to the number of samples.

However, the Averages view provides more "real-estate" than the
Trace Array for looking at the trace epoch. So unless the epoch you
are studying is quite long, each recorded data point or sample can
be displayed.

3 Increase the Averages Horizontal Scaling to 4 pixels for
each sample (4:1).
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Vertical Scaling - The Averages view displays different types of
group averages. Depending on Type selected, VERIS™ interprets
the same ratio number in different ways.

Normalized: # pixels / RMS

Normalized to Feature Epoch: # pixels / Retinal Signal

Response Density Scaled: # pixels / 10 nV/deg2

Sum of Groups: # pixels / µV

4 Decrease the Vertical Scaling to 10.

Amplitude Type

The Averages Plot type is four analysis views in one.

Normalized: The response amplitudes for each stimulus element
in a group are added and the result is divided by the root mean
square of the trace values. Each group average trace will have the
same standard deviation and approximately the same size vertical
excursion.

This makes it easier to compare waveform shape and is useful for
analyzing how the latency of responses change as you compare
each group trace.

Normalized to Feature Epoch: If you want to normalize to a
specific portion of the response you can do that with this feature.
This view is useful with the Optic Nerve Head Component protocol
we discuss in Chapter 5.

Response Density Scaled: The response amplitudes for each
stimulus element in a group are added and the result is divided by
the total solid angle of all elements in the group. Each group
average trace is therefore scaled to compensate for stimulus size,
providing an accurate view of the relative response amplitude for
each group.
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If the amplitude option "Response Density Scaled" is used, all measured
values are given in "nV/deg^2". This value represents the unit area of a
stimulus in square degrees.

In other words, it is the solid visual angle subtended by a stimulus element
(or group of elements). Therefore, a quantity such as "5nV/deg^2" means "5
nV per square degree", a metric that we refer to as Response Density.
Response Density factors in the area of each stimulus element or group.

Sum of Groups: The response amplitudes for each stimulus
element in a group are added together, providing a cumulative
response for that group. This is useful in comparing equal areas or
comparing the entire retinal response of one subject to the total
response of another.

5 Select Response Density Scaled from the Amplitude Pull-
down menu.

Spacing

Spacing controls the number of pixels vertically between the
horizontal axis (y=0) of each group trace. (If this value is set to 0,
the traces are superimposed on top of each other.)

When the spacing is relatively large, each trace's axis runs through
the number representing it on the plot.

6 Reduce the Spacing to 20 pixels.

Bottom Margin

Bottom Margin controls the position of the axis below the traces
containing the epoch length legend. Use a positive or negative value
to position this axis where you want it.

Show Marks

The Show Marks check box turns on and off the display of marks
and their associated latencies and amplitudes.

When this box is not checked, the "Clear All Marks" and "Mark
Extrema" buttons in the Averages view are inactive.
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7 Click on the Show Marks checkbox to display the marks,
latencies and amplitudes.)

Color Traces

When checked, the average traces each appear in the same color
used to indicate their group in the groups picture. This is useful for
identifying individual traces when superimposing them on top of
each other.

When the Color Traces box is not checked, all traces will be shown
in black. (Using black can sometimes make the traces more legible
on the screen and when printed.)

8 Click on the Color Traces checkbox to turn on the coloring
function.

9 Select the OK button to change the parameter settings for
this view and close the dialog box.

10 Having chosen Show Marks in the Parameters dialog, the
"Clear All Marks" and "Mark Extrema" buttons are now
active. Select "Mark Extrema".

The Group Averages using Response Density are now
displayed in the Averages view, However, the window is too
small to display the latency and amplitude values associated
with the marks.
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11 Move the cursor arrow between the window and File
Navigator. It changes into a vertical bar with arrows. Click
and drag to expand the window.

You can also click on the Hide Info button and drag on the
size box or horizontal scroll bar to increase the viewable area.

The Latency and Amplitude values represented by the
marks in each trace are shown in rows to the right of the
traces. The first row shows the three extrema marked for
group #1.

The horizontal and vertical axis in the Averages window are
shown below the group traces to keep the graph uncluttered. In
reality, each trace's horizontal axis runs through the number
representing it on the plot as illustrated below.

You can add a point to select a local feature by clicking on a
trace. Edit a point by dragging it along the trace. To remove a
point drag it away from the trace.

12 Experiment with clicking and dragging to add and remove
points. Use the buttons on top of the Averages view to “Clear
All Marks” and “Mark Extrema” (the three original marks).
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Edit Groups

Groups is just another sophisticated parameter. The Averages
views use Groups to represent accurate waveform estimates for
different retinal areas. The Density Plots (discussed in the next
section) use Groups as templates to estimate local response
amplitudes, unless a reference file has been selected.

Each analysis view that depends on groups has its own Edit Groups
dialog and opens with the grouping as defined in the data document’s
analysis settings file.

1 Click on the Groups picture in the Parameters display to
open the Groups Dialog.

The Groups dialog works like a paint program and permits you to
assemble groups of traces. Each group is numbered and color-coded.

Since the similarity of traces is one common criteria for grouping
elements together, showing the traces is useful. Sometimes looking
at each element’s group number is helpful in assembling them.

2 Select the Show Numbers radio button to switch the
display from traces to numbers.

3 Click on the Clear All Groups button.

4 Now select the New Group button. A new icon appears in
the Select Group palette with a group number and color.

5 Clicking on an element puts that element into the
current grouping. Paint some of the elements with the new
group number/color.

If the element is already in the current group, clicking on it
de-selects it. Clicking on it again re-groups it.
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Clicking and dragging (holding the mouse button down while
moving it) over elements quickly puts them into the selected
group.

6 Use the Clear Group button to de-select all elements in the
currently selected Group

7 Select the Add Rest button to add any unselected elements
into the currently selected Group.

8 Use the Make Rings button to automatically group and
number all elements in rings, starting with the center trace
and moving concentrically outward.

If after selecting a grouping or New Group you hold the option key
down and click on a hexagon, it will select the entire ring to which
this hexagon belongs.

1 To look at the total response, select the Clear All Groups
button to remove the existing grouping.

Select the New Group button, and then the Add Rest
button and click OK.

2 To look at the individual nasal and temporal quadrant
responses, again use the Clear All Groups button,

Select the New Group button, and paint the first quadrant.

3 For each of the other three quadrants first select the New
Group button and proceed to paint one of the remaining
quadrants.

4 Click OK to accept the new grouping for this window.
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If you like a particular grouping, in order to avoid unnecessary
work you can save it as part of an Analysis Settings file. Then, by
applying that Settings file, you can change groupings quickly.

We discuss saving Analysis files later in this chapter.

Grouping Traces
The individual traces of the array are often too noisy to reveal details of
interest. However, it is possible to average together traces from areas
where the response characteristics are known to be similar. Such group
averages represent accurate waveform estimates for different retinal areas
and can be used as templates for the estimation of local response
amplitudes.

Which traces to group is determined by inspection of the trace array, prior
knowledge concerning local variability of the traces, and also by the
intended use of the group averages.

Group together wave forms that are alike in terms of latency, not
amplitude. It is only latency that matters. Each group serves as a template
- a model for what the waveforms in the group should look like. For each
group you get a mean value which, when multiplied by each of the local
responses, gives the scalar product amplitude.

Before doing the grouping you should check whether the wave forms are
actually identical. If the individual waveforms are too noisy to see the
changes, you could do some Spatial Averaging. The signal to noise ratio
increases and you can then look at single waveforms.

The responses of some (but not all) ERG components vary mainly
with eccentricity. In such cases it is sensible to form groups of concentric
rings around the central element.

NOTE: Since the peripheral templates are derived from a large number of
traces, they are generally more accurate than those used at the center. The
central element should only be grouped by itself when the record is
of very high quality. If you have noisy data, don’t choose the center by
itself. This will add too much positive amplitude, leading to an
overestimation of the central response. It is better in such circumstances
to group the central seven traces.

Determining what is waveform and what is noise.
If you can make the assumption that over certain areas the wave form is
constant - it doesn’t change - you can use the group averaging technique to
get a very good estimate of that response wave form. You can then look at
the local deviations from that wave form which is basically your
estimated noise. If you want to simply isolate the noise in your record, you
can choose a higher ordered kernel that has no response. Then you basically
have noisy straight lines.

Other ERG recording methods, which generate a single signal, make it very
difficult to know whether you have signal or noise. With VERIS™ we can
create “groups” of single elements, plotting them under each other and
examining how they co-vary. While small variations in each trace could be
noise, when they happen in all the traces you have certain confidence that
you are dealing with signal.
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1 In order to look at what is wave form and what is noise,
return to the Groups dialog and select Clear All Groups
option.

2 Now create a series of New Groups consisting of individual
traces in a ring around the central element similar to that
shown in the next figure.

3 Select OK and look at the individual traces.

4 Select the Edit Parameters button and switch to
Normalized amplitude..

5 Choose 1 iteration of 17% Spatial Averaging.

6 Change the Spacing between traces to 0 pixels so the traces
will overlap and a Bottom margin of 60 pixels to keep the
legend axis below the trace.

7 Finally, change the Horizontal scaling  to 4:1
pixels:samples, and Vertical Scaling to 30 pixels/RMS.

8 Turn off the Show Marks and click OK.

Your plot should be similar to that below.



4 - 30 Chapter 4   Looking at Your Data

VERIS™ Science 5.1 Reference Guide

Another check for noise is to measure the response amplitude using
the group template and the (Density) Plot view. If you only have noise,
in the Density plot the amount of area that would be black (zero or below)
and the amount of area that would be shaded (above noise) would be equal -
because you have a 50-50 chance of falling on either side. Even with very
noisy kernels, usually the area that is black is very small. So you know your
amplitudes are actually real.

Using Averages to Analyze Kernel Slices

One way to look at the relative strength of the local response amplitudes for
different kernel slices is by generating an average for each slice. This is
done by grouping a large number of traces into a template and then plotting
the average for each kernel slice.

We will now do a quick comparison of averages for three kernel slices.

1 Return to the Groups dialog box and Clear All Groups. To quickly
select all traces without picking them one by one, select the "New
Group" and then the “Add Rest” grouping button.

2 The First Order Kernel trace is viewable in the Averages View.

3 Select the Edit Parameters button and, in the Kernel Slice time
scale graphic place an additional mark on the "1" to select the first
slice of the second order kernel.

4 Now remove the tick mark from the "1" by clicking it again. Place
the additional mark on the "2" for the second slice of the second
order kernel.

NOTE: The remaining Averages Parameter settings will be
discussed in later sections of this Guide.
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The 3D (Density) Plot Parameters

1 Select the 3D Plot tab to open the Density Plot view.

2 If the parameter settings are not visible click on the Show
Info Button.

3 Click on the Edit Parameters button.

The Spatial and Color parameters contain settings unique
to the Density Plot.

Spatial
Resolution

Original resolution - the Density plot is based on the original
stimulus picture with a response density value directly mapped to
each stimulus element.

Refined resolution - (Default) Through interpolation, the refined
method provides twice the resolution of the original. The derived
picture is obtained using half-size hexagons.

The small hexagons (A) centered on a stimulus element (shown
gray) get the same amplitude density as the original element. The
hexagons straddling a border (B) between two stimulus elements
get the average of the amplitudes of the two original elements.
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4 Make sure Refined has been selected, for the more accurate
graphic resolution.

V Scale / H Scale

This parameter controls the vertical scale when viewing 3-D
density plots (plots > 0 degrees).

The vertical scale (measured in µV / deg^2) is specified as a ratio to
the horizontal scale (measured in pixels / deg.) In this way, as a 3D
plot is re-sized, it is uniformly scaled to best preserve the apparent
shape.

The Overall Scaling is set as "Fit All", creating a plot centered and
scaled to all fit into its allocated space. The total vertical height will
be plotted within the allocated space. Increasing the V Scale/ H
Scale ratio decreases the horizontal dimension to maintain the
correct proportion.

Although both the horizontal and vertical scales (the number of
pixels per underlying unit) are changed, their ratio is unchanged.

5 Change the V Scale / H Scale ratio to 300.

Color

Plot Value

Density plots deal with a single derived value for each stimulus
picture element. The Plot Value parameter gives choices for how
that value is calculated.

The Scalar Product method (Default) takes into account both
amplitude and wave shape differences and provides an enhanced
topography when traces vary little across the visual field. It first
averages the traces over each group and creates templates using
the group averages. For each stimulus element it then calculates
the average of the product between each value of the element's
trace and that group's template.

A large amplitude waveform with the same wave shape as the
template will produce a large positive number. If either the
amplitude is smaller or the wave shape is different from the
template, then the result is a smaller number.
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The RMS method does not use group average templates. It
calculates the root mean square of the trace values.

The RMS measure generally leads to an overestimation of the
signal amplitude since it can’t distinguish between signal and
noise. Unless there is much local variability in traces, Scalar
Product provides a more enhanced topography.

(An in-depth discussion, "Selecting the appropriate amplitude
estimation," follows this section.)

6 Select the Scalar Product amplitude.

(Scalar Product Fitted, Peak Latency, and Small Feature
Latency will be discussed in Chapter 5.)

Color Space

Density plots use colors to indicate different amplitudes. There are
three color scales from which to choose and White, which ignores
color.

7 Select the Red Green Blue color space.

White For:

Each color scales uses white to represent the highest values. This
parameter specifies the amplitude beyond which all amplitudes will
be represented by white. If looking for the widest color range,
selecting this value will usually involve trying out a series of
numbers until white is visible in only a small portion of the plot.

8 Change the White For value to 30.
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Scaled for Response Density

Normally we scale to response density so this box is checked. The
vertical extent of the traces in the trace array plot really has no
physical meaning unless you know the area of each stimulus
element. We scale the elements so the traces are of similar height
that have a similar signal to noise ratio.

In the 3D Plot we divide by area to calculate something physical,
namely response per unit area. But in the 3D Plot this results in a
sharp peak in the center that can obscure some smaller
topographic features.

So by unchecking this box you can simply plot the responses and
their amplitudes without dividing by area. They don’t have a
physical meaning any more in the strict sense - they are just
responses plotted.

9 Click OK to accept the Parameter setting changes.

10 From the Edit menu, select the Undo Parameter Editing
(3D Plot)) command to switch between the two sets of
parameter options.

You can quickly switch between two parameter sets by using the
keyboard shortcut Command - Z (⌘ - Z) for Undo/Redo.
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Viewing Orientation

In the Density Plot view you may switch orientation, (N) Nasal to
(T) Temporal, and (S) Superior to (I) Inferior clicking on the
appropriate letter on the NSTI control button.

Both the (Density) Plot and MultiPlot views can be rotated in 15
degree increments using the up and down arrow keys. They can also
be rotated using the pull down menu on the view.

Numeric View:

In the numeric view (Amplitude Array), you can look at the actual
values derived for each stimulus element. This view can be useful in
explaining unusual data, such as negatively plotted areas in the
Density Plot.

1 Again click on the Edit Parameters button in the Density
View.

2 Check the Numeric View box and then OK to leave the
Parameters dialog box.
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3 Change the Amplitude Parameter from Scalar Product to
RMS and click OK to make the change.

4 Use the Undo command to see how the values change for
each amplitude measure.

NOTE: The remaining 3D Plot Parameter settings will be
discussed in later sections of this guide.

Using Groups as Templates

The Density Plots use Groups as templates to estimate local
response amplitudes, unless a Normals Reference file has been
selected.

If no normal references are used, then the response amplitudes
are estimated as the scalar product of each subject trace with a
normalized template derived from the group of traces to which the
trace belongs.

If reference data are used, the response amplitudes are
estimated using the scalar product of each subject trace with the
corresponding normalized trace derived from a population of normal
subjects. In such cases the Edit Groups button and diagram
are removed from the window.

Using the data file itself to create Group templates for
response density calculations can amplify defects.

It can also obscure them.

Suppose amplitudes are normal but there is a latency shift
compared to normals. If the data file itself is used for the
template, the scalar product will look normal if every element in
the group has the latency shift.

However, if a normal reference file is used then the scalar product
will be greatly reduced because of the latency shift compared to
normals.

For more detailed information, refer to the In Depth sections
"Scalar product measure" and "Obtaining Accurate Templates that
follow.
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Density Plots

Selecting the appropriate amplitude estimation
The Density Plot (and MultiPlot) provide topographic representations of the
amplitude densities derived for each stimulus picture element and how
these amplitudes are distributed. Density is defined as amplitude divided by
area, for example nV/deg2.

In order to plot ERG amplitude densities, VERIS computes an amplitude
estimate for each trace and divides it by the solid angle subtended by the
corresponding stimulus element. (Note: Amplitude densities are not
synonymous with "response densities".) There are various ways to estimate
the amplitude of the local waveforms:

a)  Peak-to-trough amplitudes of response features
b)  RMS (root mean square) measure
c)  Adjusted RMS measure
d)  Scalar product measure

Peak-to-Trough latency measure

The peak-to-trough measure makes use of only two data points and is very
sensitive to noise. It is, therefore, not very useful for the evaluation of
multifocal data if one is attempting to measure the responses evoked by
small retinal patches and the noise level is relatively high.

RMS (root mean square) measure

The RMS amplitude measure takes into account the entire response
waveform and is, therefore, less sensitive to high frequency noise. For each
trace it is computed as:
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Where the interval i, f (first sample) to l(last sample), contains all the
significant signal, N is the number of data points in the interval (N = l – f +
1) and si is the voltage of each sample point. For brevity we will use the
vector notation:
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Note: VERIS automatically subtracts the mean voltage of the epoch (the
D.C. component) from each sample si.

While the RMS measure is less sensitive to noise than the peak-to-trough
measure, it has the disadvantage that additive noise always generates a
positive contribution and thus leads to overestimation of the amplitude
density. This is not so serious when the noise in all traces is approximately
equal, which is usually the case.

The RMS measure is always positive because it is derived from a sum of
squares. It is insensitive to waveform and does not distinguish between
signal and noise. In the absence of a signal, all traces have approximately
the same RMS noise.
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When response densities are computed for the 3D pseudo-color plot, noise
becomes scaled up toward the center of a scaled stimulus array, where the
solid angle of the stimulus patches is small. The resulting central peak can
be easily misinterpreted as a response. The RMS measure should, therefore,
be used with caution and only after inspection of the waveforms in the trace
array.

Adjusted RMS measure

Separating the signal s into response r and noise n and writing the
expression for RMS in expanded form:
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we see that the noise does not simply contribute an inaccuracy to the
amplitude estimate but tends to increase its value. While the term r • n is
equally likely positive or negative and thus contributes noise to the estimate,
the term n • n always makes a positive contribution. However, the value of
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Scalar product measure

When the response waveform is known a more accurate estimation of the
response amplitude is possible. In the extraction of the signal from the noisy
traces, the known response waveform can be used as a template. It is
inserted in place of one of the factors in the numerator as well as under the
square root sign in the RMS term of the denominator. The resulting
expression is that of a scalar product between the vectors s  and the
normalized template vector t.

Accurate template waveforms for each stimulus patch can be derived by
averaging multiple data sets derived from normal subjects. When normal
references are used in the data analysis, the amplitudes are automatically
estimated in this way.
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It is important to note that the scalar product does not only reflect the
amplitude of the patient’s response. Any mismatch between the waveform of
the patient and the template which may result, for instance from latency
differences, will cause a reduction in the scalar product. This can be an
advantage if the aim is to derive a single number that reflects “abnormality”
of the response.

When no reference data are available, template waveforms can be
derived as averages of groups of traces that contain the same
response waveform.  In general, waveforms change with retinal
eccentricity. It is, therefore, reasonable to form templates from group
averages. The grouping selected in the PLOT view is used for this purpose.

Mike Fendick, O.D., Ph.D.
Highlight
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Every trace in a group is measured with the normalized average waveform
derived from the group to which it belongs. To achieve a good match
between each template and corresponding traces, only traces with similar
waveforms should be placed in the same group.

If there are traces that do not belong to any group, they are measured
with the template from the last group selected - the group with the
highest group number.

When ring averages are used as templates, the trace at the center is its own
template. In this case the scalar product becomes the RMS measure; this
usually leads to an overestimation of the amplitude. To a lesser degree this
also applies to the first ring around the center where the template
represents the average of only six traces and tends to be noisier than
templates derived from more peripheral rings. For all groups consisting only
of a single element, the adjusted RMS measure is used.

If reference data are used, the response amplitudes are estimated using
the scalar product of each patient trace with the corresponding normalized
trace derived from a population of normal subjects.

If no normal references are used, then the response amplitudes are
estimated as the scalar product of each patient trace with a normalized
template derived from the group of traces to which the trace belongs.

Dramatic differences are possible when a patient's own
response template is used to calculate density.

Without Reference
Data

Patient appears to
have positive

response at center

With Reference
Data

Patient actually
has a severe
 drop off in

response at center

Mike Fendick, O.D., Ph.D.
Highlight



4 - 40 Chapter 4   Looking at Your Data

VERIS™ Science 5.1 Reference Guide

Obtaining Accurate Templates

As briefly discussed in "Grouping Traces", over large areas of the visual
field the wave forms do not change significantly for some ERG components.
The only significant changes are observed with eccentricity and only in the
macular region. (Exceptions are the local PERG and the second order flicker
ERG). It is thus possible to obtain accurate templates by summing and
normalizing traces within areas where no significant changes in wave form
are expected. Often templates can be derived from a few concentric rings.
Each template is then used only within the area from which it was derived.

There is an important caveat to using ring averages as templates.
Since the peripheral templates are derived from a large number of traces,
they are generally more accurate than those used at the center. Particularly
if the central element is used as its own template, its amplitude is effectively
estimated with the RMS measure. This leads to an overestimation of the
central responses, which is more serious when dealing with a contaminated
record. The central element should only be grouped by itself when
the record is of very high quality.

Ideally templates might be derived for each location by averaging
recordings obtained under identical conditions from a group of age-matched
normal subjects. In scientific studies a sufficient number of identical records
is often not available. However, when studying retinal dysfunction, such a
normative data set is generally required. It provides not only the local
templates, but also the variances in the local amplitudes of the normal
population. These variances can be used as a measure for the estimation of
local dysfunction.

The scalar product measure provides an additional advantage in the study
of patients. Pathological changes in response latency and wave form will
lead to a reduced amplitude estimate and show up as a depression in the
response density topography.

When to use RMS instead of Scalar Product

You could use RMS to see how the response changes as a function of
horizontal position only. You would not group elements, but would use
each signal as its own template - which is RMS, more or less. It allows you
to look at individual rings without imposing templates. You can then look at
the traces and see that latencies are changing, the peak may be coming a
little later with each one.

You may not be sure how to form groups if there is a big nasal/temporal
asymmetry as in pattern responses, or if you have big asymmetry due to
averaging records together. If you take each response as its own template -
RMS - then you are not imposing anything on the data. RMS. is a good way
of getting around biasing. Every local response is its own template and is
normalized to the same height across the retina first and then multiplied by
the absolute height.

RMS is also a common method for amplitude measurement when working
with visual evoked potentials.

It is important that any data analyzed using RMS be “clean” since this
method of amplitude measurement is very sensitive to noise. For
example, in examining a response wave form, the noise level out beyond the
visual signal should be low, compared to the signal.

Mike Fendick, O.D., Ph.D.
Highlight
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The “MultiPlot” Parameters
The MultiPlot is an example of the custom tabbed views that you
can build with VERIS™ Science. We will show you how in Chapter
5, "Creating Your Own Tabbed Views."

Using three 3D plots we can view the subject's response
amplitudes, and compare them with a second data set such as right
eye vs. left, two recordings from different dates, etc. Or we can
compare them to a Normals reference file. We can use a third plot
to show the difference between the two.

VERIS™ includes in the Sample Data files a set of normal subjects
and Normals reference files based on these subjects.

This normative data is limited and for illustrative purposes only.
You should generate your own Reference Files as we will illustrate
in Chapter 5.

In order for VERIS to display reference data these files must be
inside the Normal Files folder located with the other program files.

1 From the Select menu, choose Reference: Normals... to
open the Select Normal Reference dialog. Select "ref 103
(n=48)" to apply it to the current file.

(To open a second data set for comparison you can use the
Select: Reference: Choose data file command as we
illustrate in the next section.)

2 Select the MultiPlot tab to open the MultiPlot view.

“Multi Plot”

(assembled from
three

 3D Plots)
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The Multi Plot consists of three separate 3D Plots with their own
parameters. The default setting for the top plot shows the
difference from the normal population, measured in standard
deviations, between the subject data (the bottom left plot) and
the reference data (the bottom right plot.)

4 Select the Show Info button and click on each of the three
plots to view the parameters for that 3D Plot.

The Display sources area changes to reflect that the top plot
is “Patient Data - Normal Reference”, and the lower plots are
“Patient Data” and Normal Reference”.

In the next section, "Displaying Reference Data," we show in
more detail how Normals and data reference files can be selected
and displayed in the Traces, Averages and 3D Plot views for
comparison to the subject data.

5 Use the Edit Parameters button to open the dialog box.

The 3D Plot Parameters dialog opens for the plot you have
selected.

To see the absolute numeric difference between the two files
instead of in standard deviations you can select the "Use
Absolute Difference" check box.

You can also view each plot’s numeric values by selecting the
"Numeric View" check box for each of the three plots.

   
Whenever you use Normals reference data your choice of
kernel slice selection is limited in the parameters menu to a
pull-down selection of those kernel slices included when the
reference data was first created.

Applying Changes to all Plots in Tab

Whenever you have multiple plots in a tabbed view, a shortcut
allows you to make changes to all plots without having to select and
modify the parameters of each one.

Simply check the "Apply changes to all Plots in Tab" box (found
next to the OK and Cancel buttons) in any parameter dialog and the
parameter changes will be made to each plot.
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Displaying Reference Data

In prior versions of VERIS™ you could compare the current data
file with either a reference Normals file or a second data file. In
VERIS™ Science 5.1 you can do both.

A second reference data file can be selected and displayed in the
same window as your current file for comparison. Both of the data
files are processed using the same filtering and can be processed
with a Normals reference data file (e.g. each showing its standard
deviation from the normal mean.)

This second file can contain identical data from the fellow eye or
data recorded from the same eye at another time or under different
conditions. Protocols for test-retest and interocular comparison are
included in the Analysis Settings folder.

For our next example we will look at and compare the eyes of a
patient with Central Retinal Vein Occlusion (CRVO). File
comparison is accomplished in the following easy steps:

1 Use the File: Open command to load the "jeo.01.13.01..." file
from the Sample Data Files/ Sample Patients/ CRVO
subfolder.

You should be looking at the Subject view for this data file.
The protocol "Two Eye Comparison w.Lat" should also
appear as the Analysis Settings for this file.

If not, use the Select: Analysis Settings command to
select the protocol from the MfERG/ 103 areas folder.

This protocol was designed to compare two eyes and applies
the Normals file: "ref 103 (n=48)."

2 Click the Traces tab.  There is not yet a trace array for Eye
2. The second reference data file needs to be added.

3 The reference data file must be loaded in one of two
ways.

A. While holding down the option key, double click on
the file name "jeo.02.13.01..." in the File Navigator on the
right side of the window.  Or,

B . Load the second data file, "jeo.02.13.01..." using the
Select: Reference: Choose data file command.
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After you load the second reference data file, its name
appears above the tabs as the "Reference File." A new
"Reference" tab is added, similar to the Subject tab for the
current file whose name appears on top of the window.

4 Select the Show Info button in this Traces "multiplot"
window and click on each of the three plots to view the
parameters for that Traces plot.

5 Now select the Eye 1 plot and click on the Edit Parameters
button.

Each plot can have two Overlays. On the top left side of
each Parameters window is a Display control used to select
the data displayed in Overlay 1 and Overlay 2. In this
example, the choices are: Patient Data, Normal Reference or
File Reference. (The default for Overlay 1 is Patient Data.)

If displaying both Overlays, you can specify a horizontal (x)
and / or vertical (y) offset using the Display 2 Offset.
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In our example the Normal reference file was chosen as part of the
Analysis protocol. You can also use the Select: Reference
command to remove or change the Normal Reference.

With the Normal Reference chosen both selected data files will be
processed to match the Normal File reference (same spatial
filtering).

When Normal reference data are used, several of the parameter
choices become restricted.

The Epoch is automatically chosen to be the same as the one
used for processing of the normal files. The only Kernel Slices
selectable are those used for creating the Normal file and for
which statistical analysis is available.

6 Click OK to return to the Analysis window.

For each plot, a button controls the visibility of the two Overlays. In
the Eye 1 Plot, the Patient Data is currently visible as Overlay 1,
and the Normal Reference (not visible) is in Overlay 2.

7 To show Overlay 2, select the second button, "Show Normal
Reference."

8 Re-select Edit Parameters, change Overlay 2  to File
Reference and click OK.

Now the File Reference, the patient's right eye (reflected left),
has replaced the Normal Reference and is superimposed on
the patient's left eye. The second visibility button now
controls the File Reference.

To hide the File Reference plot, simply click on the same
button. (If you Hide Patient Data instead, the right eye
reflected left will be shown.)

You can choose from a wide palette of colors to distinguish the
reference data from your current subject data. Select “Change
Subject Color...,” "Change Normals Color…," or  "Change File
Reference Color...," from the Parameters pull-down menu.

Select from the various Colors Wheels, Sliders, or Palettes to create
the colors of your choice.
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1 Now click on the Eye 1 - Eye 2  Plot to see how the two
Overlays can be combined and displayed as one plot.

2 Select Edit Parameters and look at Display controls.

In this plot Overlay 2 (File Reference - right eye) is
subtracted from Overlay 1 (Patient Data - left eye). Both
Overlays must be visible to see the difference plot.

Reflecting the Reference Eye

Orientation is important when comparing subject responses to a
second data set with both displayed in the same window.

With an mfERG recording, in order to compare left and right eyes,
you want to compare the two eyes reflected in the same nasal
temporal direction. With a Normals reference file you would also
want to match the nasal temporal orientation of your patient file.

By selecting the "Reflect Eye as Needed" option in the
Parameters menu, the data chosen as Overlay 2 are always
oriented to match the data in Overlay 1. (If the two eyes are to
be displayed next to each other in their original orientation, the user
can position two identical plots side by side and the select one eye
as Overlay 1 in one plot and the fellow eye as Overlay 1 in the other
plot.)

For the mfVEP, you want to compare them unreflected. The only
reasonable reference is the fellow eye of the same person and non-
reflected. That is why we don’t use Normal references with the
mfVEP at this time.)

In a following section, "Looking at mfVEP Data" we will
examine the Analysis plots and parameters unique to the
multifocal VEP.
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Changing a Document's Settings
We began our discussion of analysis parameters by describing the
two ways they could be changed.

1. Changing the individual settings of an analysis view using
that view’s Edit Parameters and Edit Groups buttons affect that
view only.

2. Changing the parameter settings of a document modifies all
views in a document window by applying new Analysis Settings
from another Settings file or another open document window. (In
addition, parameters changed using the VERIS™ pull-down menus
affect all views.)

You can script an analysis protocol and apply it to open data
documents. Or, you can apply the parameter settings of one open
document window to others.

We will now look briefly at how, by scripting an analysis protocol
and applying the settings to another document, you can improve
your efficiency and help make analysis more intuitive.

Creating an Analysis protocol

1 From the Sample Data Files folder, open the “CSR.norm”
data document.

This recording was done on a subject with normal vision,
under the same conditions as a Central Serous Retinopathy
subject whose file we will examine shortly.

2 From the Select: Analysis Settings menu, choose the
"*Default Analysis Settings" file from the mfERG
subfolder.

Look at the tabbed views and note that the scaling could use
improvement. Some of these default settings will need to be
changed, creating a new protocol .

3 In the two Traces view, change the following parameters:
Spatial Averaging to 1 Iteration at 17%, Scaling
Horizontal to 1:4, and Vertical to 60.

4 In Averages view, change the following parameters: Spatial
Averaging to 1 Iteration at 17%, Scaling Horizontal value
to 4:1, and Vertical to 15, Type to Normalized and Spacing
to 20.

5 In 3D Plot and Multiplot views, change the following
parameters: Spatial Averaging to 1 Iteration at 17%,
Spatial V Scale/ H Scale value to 100, and the White for
value to 90.
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Your Traces, Averages, and Density Plot views should look similar
to those below:

TRACES

for

CSR.norm

AVERAGES

for

CSR.norm

 3D PLOT
(DENSITY)

for

CSR.norm

5 Use the File menu's Open command to open the “CSR”
data file in a separate window. Look at the different tabbed
views.

Having revised parameter settings for a normal eye
(CSR.norm) recorded under the same conditions as our CSR
subject’s recording, we can now apply that new protocol to
this file.
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Applying One File’s Protocol to Another

If you have several data windows open, the Analysis protocol from
any one of them can be applied to any other.

1 With the “CSR” data document window active, use the File
menu to select the Apply: Apply Analysis Settings from
Window command.

Since the CSR.norm document window is open, it appears as
a choice in the submenu.

2 Use the comand to apply the “CSR.norm” settings.

3 Use the Select menu to load in the Reference file, "ref 241
(n+13)" and look at the Multiplot.

The top difference plot needs the scaling reduced.

4 Click on this plot and use the Edit Parameters button to
reduce the V Scale/ H Scale to 100.

Now tab through the “CSR” analysis views. The analysis
settings from “CSR.norm” have been used to modify the
Default Analysis Settings and applied to each view in the
“CSR” data document.

3D PLOT
(DENSITY)

for
CSR subject

using settings
from

CSR.norm

The Analysis protocol of the currently active data window can also
be applied to any other unopened file.

1 Close the CSR.norm window.

If your version of VERIS™ presents you with the option of
saving the settings, select Don't Save.
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2 With the “CSR” data document window active, double-click
on the "CSR norm" file name, in the File Navigator located
on the right side.

As mentioned earlier, doing so replaces the old file in the
same tabbed view, using the old file's analysis settings

Applying Protocols From an Analysis Settings File

The currently active data window can have an Analysis protocol
applied or replaced using the Select menu's Analysis Settings
command to choose one of the Analysis Settings files provided with
VERIS™.

These files reside in the Analysis Settings folder and contain
protocols tailored to each of the recording methods available. A list
of these Analysis Setting files is given in Appendix B.

Saving Analysis Settings
If you have modified any settings in any tabbed plot view, the
Analysis Settings title legend changes from black to red.

When you close the window or quit the program, if you don’t save
the settings, all changes you've made to the parameters will be lost.
The next time you open the file it will use the last Analysis file
applied with unaltered settings.
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Previous versions of VERIS™ put up a warning whenever any
changes were made to the Analysis Settings during data analysis.
This warning box appeared when the window was closed or the
data set in the window was exchanged. It asked if you wanted to
save the settings.

This warning has been eliminated, since in most cases
users didn't want to change the protocol and found the
frequency of this prompt annoying. The user can still save the
modified settings by selecting Save As from the File menu.

If you save the settings, the next time you open the file it will use
the revised analysis settings.

In our previous example we modified an existing protocol for the
"CSR.norm" data file. Since we may need it again we'll save it as a
new Analysis protocol.

1 With the “CSR.norm” data document window active, from
the File pull-down menu select the Save As: Save Analysis
Settings As... command.

2 When the Save dialog appears make sure the folder in which
the file will be saved is "Analysis Settings" or one of its
subfolders.

3 Select a new title for your Analysis Settings and SAVE.

Saving new settings to an existing Analysis Settings file
may change settings that you don't want revised. When in
doubt, always create an alternative file.

You use the Select menu's Analysis Settings command to apply a
protocol from an Analysis Settings file. In order for VERIS™ to
access them properly, these files must be saved in the Analysis
Settings folder or one of its subfolders.
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Saving a Reference File with an Analysis Setting File
Analysis Settings files may or may not have Reference files
associated with them. In our CSR example we loaded a Reference
file prior to saving the revised protocol.

Whenever you save an Analysis Setting file that includes a
reference file, each time you apply your new Analysis protocol it will
also include the associated reference file.

Saving all Protocols In a Recording Settings File
The new improved scripting in VERIS™ should be of particular
benefit to the clinician or scientist doing repetitive testing. You can
now program an entire sequence of recording and analysis protocols
and save them as a single Recording settings file.

4 With an open data file, as in the previous example use File:
Save As - but instead of saving Analysis Settings, use the
Save Recording Settings As... command.

5 When the Save dialog appears make sure the folder in which
the file will be saved is "Recording Settings" or one of its
subfolders.

6 Select a new title for your Recording Settings and SAVE.

When you select this Recording protocol, after each recording the
proper number and type of tabbed Analysis views will appear in the
data file window. Each view will be configured with the appropriate
parameters including filtering, artifact elimination, proper reference
file, display and printing options.
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Saving Your Current Document

When you finish working with a data document, if you have made no
changes to the analysis settings you do not need to Save the
document. (The Save option will not appear as an option in the File
menu.)

Simply close it, either from the File menu or by using the Close Box
in the top left corner of the document window. The next time you
open the file it will use the last Analysis Settings file that was
applied to it.

Exporting Data

Development of VERIS™ is an ongoing project. Future releases will
include additional tools for analyzing and presenting data that
enhance functionality hopefully without unduly increasing program
complexity.

Some tasks can be done easier with other software. Therefore we
have provided commands for exporting quantitative and pictorial
information in formats that can be readily imported into other
software programs.

File: Export Processed Data  and File: Export Marks
commands export quantitative data in each analysis view as tab-
delimited ASCII files. File: Export PICT and File: Export
Stimulus commands export information in graphical formats.

Chapter 6, "Menu Reference" provides a description of each of
the File: Export commands.

Printing Tabbed Analysis Views

VERIS™ 5.1 now provides automatic scaling of the tabbed view
to the printed page regardless of printer technology or brand.

The File: Print Preview command provides a window that
accurately shows how the selected view will print. From within
the window you can either select the Print command or Page
Setup.

Use Page Setup to alter paper size, and orientation. The Scale
should always be left at 100%.

When printing in portrait format, patient information is inserted
at the bottom of each page. In landscape format only the subject
name and current date are inserted.
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Looking at mfVEP Data
As noted earlier, the evaluation of mfVEP records usually requires
comparison of the records from the two eyes (in this case without
reflection).

Within the Sample Data Files folder is a folder with mfVEP data.
We will look first at some normal data.

1 Using the File: Open command, from the mfVEP
data/normal folder load the right eye "mm.vep.right" as
the subject eye.

2 In the File Navigator, option click on "mm.vep.left" to load
the left eye as the reference file.

3 From the Select menu, choose as the Analysis Settings File
"mfVEP 1."

To avoid possible confusion we recommend always loading
the right eye first and coloring its traces red with the left eye
colored blue.

4 From the Parameters menu, Change Subject Color to Red
and Change File Reference Color to Blue.

5 Select the Traces tab. In the Traces Parameters dialog
increase the End of Epoch to 250 ms, and decrease the
Vertical Scaling to 50.

The right and left eye traces are superimposed. In a normal
person you would expect the traces to be the same, even
though there is variability from place to place due to folds in
the cortex. Here we see that both eyes are similar except in a
few places, which may be significant.
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The mfVEP trace array plot is very similar to the mfERG. In
this example we have spread the traces out. Had we selected
exact positioning we wouldn't have been able to see the
central traces.

6 For increased visibility of the traces you may want to use the
Display 2 Offset control to increase the x and y values by 2
or 3 pixels.

VERIS™ 5.1 now offers a quantitative comparison between the
records and displays the results in a pseudocolor 2D representation
or in numeric form. The difference between the two eyes is
estimated using both signal RMS and goodness of fit between the
signals from the two eyes and is displayed in units of noise SD.

1 Select the 3D Plot tab and use the Show Info button.

This view is made up of two plots superimposed. Plot 1
controls the appearance of the File and Reference traces.
Plot 2 is the Noise Reference.

In the Information panel, if the Display sources are Patient
Data and File Reference you are looking at Plot 1.

2 Use the Edit: Select Plot command to select Plot 2 and the
Edit Parameters button to open 3D Plot Parameters.

The noise SD are derived by applying the same measure to a
selected kernel of high order that has been proven to contain little or
no signal. A confidence level is established by measuring the signal
RMS of the better eye with SD of the noise RMS. Each sector of the
pseudocolor plot contains a colored or white area centered on it
while the rest of it is gray.

The size of this central area represents the confidence of the level
signal measure while the difference between the two eyes is
encoded in color.

Noise Slice

What you see in the pseudocolor plot is dependent on the exact
kernel you choose as the noise slice. You want one that minimizes
the amount of gray area - gray areas are too noisy to come to any
conclusion. The plot currently shows about 7 totally gray areas,
where both eyes are in the noise level.
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3 In the Noise Reference section, move the 3rd order kernel
from tick mark 4 to tick mark 5 and click OK.

We've reduced the number of totally gray areas to 5 and
improved some checks from partial gray to white.

Remember, you can easily switch between two parameter sets by
using the keyboard shortcut Command - Z (⌘ - Z) or the Edit
Menu's Undo / Redo command.

For the noise kernel you always want to use an odd number
of tick marks, because with pattern reversal an even
number of tick marks is more likely to give you signal than
noise. An odd number will have more noise than signal.

The coloring of the areas refers to the difference between responses.
Total gray means the waveforms of both eyes are in the noise level.
We can't conclude anything about these areas.
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Areas that are partially gray indicate that they are somewhat
noisy but there is still enough signal to be useful. Areas with no gray
are very strong signals.

Total white areas means the waveforms of both eyes are strong
and equal and therefore this is a totally normal response. There is
no difference between these wave forms. Areas where the difference
is below a set threshold (in SD noise) are white.

A Red area indicates dominance of the right eye waveform. A Blue
area indicates dominance of the left eye waveform. The difference
between the eyes is encoded in the color saturation. The brighter
the color, the greater the difference. With less difference the colors
are more washed out.

You have control over the parameters that determine all
this. In addition to the kernel you choose for the noise slice,
four parameters control how this plot is going to look - the
Threshold and Maximum values for the Noise Reference
and the Interocular Difference.

Noise Reference

The noise reference determines the amount of gray level in
each sector. Everything is based on noise levels - the kernel that
was picked is noise and it measures the mean and standard
deviation of the noise. Using the values in our example, if one of the
eyes has signal which is 2  Standard Deviations above the noise
then it will not be all gray. If it is below the 2 SD threshold then
the sector will be pure gray.

If the strength of the signal in either eye reaches a maximum
greater than 6 SD above the noise level than it becomes totally
colored - either white, blue or red - but no gray whatsoever.

Those areas with some gray indicate that the signal strength is
between 2 and 6 SD above the noise. You can eliminate all the gray
areas by bringing the threshold down. If you make the threshold
high, you make more areas gray. If the maximum is made high than
many areas won't be colored.

Interocular Difference

The interocular difference determines whether the sector is
going to be white or red or blue and how saturated the color
will be.

If the difference is less than 3 SD of the noise it will show up as
white. Reducing the threshold will reduce the amount of white.



4 - 58 Chapter 4   Looking at Your Data

VERIS™ Science 5.1 Reference Guide

The maximum sets the saturation level. A value of 20 is very high.
You would have to have a big difference to saturate color. Reducing
the maximum gives you more saturated areas.

You can dramatically change the look of the pseudocolor plot
depending on the Threshold and Maximum values used for the
Noise Reference and Interocular Difference. Thresholds of 2 or 3
SD make sense statistically. The maximum values can be
whatever you want them to be in order to emphasize differences or
similarities.  

4 Use Edit Parameters to select the Numeric view.

In the numeric representation both the signal confidence and
the inter-ocular difference measure are displayed in each
sector. (Interocular Difference value over Noise Reference
value).

We will now repeat the same steps followed in this section to
look at an abnormal record.

5 Using the File: Open command, from the mfVEP data/
abnormal folder load the right eye "qm.vep.right" as the
subject eye.

6 In the File Navigator, option click on "qm.vep.left" to load
the left eye as the reference file.

7 Select the Analysis Settings File "mfVEP 1" and click on the
3D plot tab.

This plot is very different from the previous example with
improved colors and little white. In most areas the right (red)
eye is better than the left (blue) eye.
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5 - Working with the Data

Working with Multiple Documents
There are several ways to open data documents. The way they
appear on the desktop depends on how they are opened.

To open multiple documents in their own windows use the
File menu's Open command or double-click on the icon of the
document. You can open a series of documents in their own
windows. Each file opens with the parameters and views of
the saved Analysis protocol it last used.

To open multiple documents in the same window use the File
Navigator, found on the right side of the window, to select and
double-click on a file. Only one file at a time can be opened in the
window. Each file opens with the parameters and views of the
file it replaces. In this way you can quickly review multiple
documents using the same analysis protocol.

Since files opened with the File Navigator share analysis settings,
they must have certain recording settings such as stimulus
picture in common. Therefore, some files may appear gray and
unselectable in the File Manager if they don't share the requisite
settings.

Combining Data Documents

It is often useful to look at the combined results of multiple
recording sessions, either from a single subject or from a group of
subjects. Combining similar files recorded under the same
conditions can significantly improve the signal to noise ratio.

Combining the records of similar subjects can also provide
useful reference information for comparing one group of
subjects to another as we will discuss in the next section, "Creating
Normative Data".

Previously VERIS™ combined raw data files, and had required
the same m-sequence (recording) length for each file. We now
combine the processed trace arrays, point by point, avoiding the
limitations of earlier versions.

You can add or subtract 2 or more data files as long as their
retinal stimuli are compatible.



5 - 2 Chapter 5   Working with the Data

VERIS™ Science 5.1 Reference Guide

1 Select the File: New Combination command.

2 An "untitled" combination view window opens with a new
set of buttons.

To add or subtract documents in the Document list window,
we could use the Add Doc and Remove Doc buttons.
Instead, we will add an entire folder of files.

3 In the File Navigator double-click on the Sample Data
Files folder and then the Normals folder within.

4 Locate the "103 areas 8 min" folder in the File Navigator
and drag it to the left, into the Documents list. (A small
rectangle will follow the cursor until you release the mouse
button.)

Within a few seconds, all 10 files contained in that folder are
copied into the Documents list.

5 Click on a few of the files in the list to see the Subject
information for each of those files visible in the window below
the Documents list.

6 Select one specific file and click on the Show Doc button to
open that data file in its own window.

7 Return to the “untitled” Combination window and select the
Edit Weight button for that file.
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The Edit Weight button has many purposes. With a group of
files, some may have excellent data and others may be noisy. To
get the best estimate of mean response, weight the files
inversely proportional to the noise.

If combining recordings made with different stimuli
(temporal or luminance values), and you have a model that
accounts for the difference, you can use values greater or less
than 100% to account for the difference.

To subtract one eye from another you can simply load both in
and weight one a negative 100%, since the files are algebraically
combined.

The Weight value is a percentage that can be positive or negative.
Each data point is multiplied by that value when it is read in. The
default of 100% adds a copy of the current data set.

When combining files the program performs a weighted
average on the algebraic sum. In subtracting one file from
another (with each weighted 100%), the program does a point by
point subtraction and then divides by 2.

For the absolute difference between two file's waveforms
give one a weight of 200,  the other -200.

When combining a set of data files it is always a good idea to
perform Artifact Removal.

8 Click on the Data Filtering button to display a dialog box
similar to the one we discussed in the last chapter.

It is recommended that you do 2 iterations on Combination
files and select an epoch as long as the response. 80 ms. is
usually enough for a regular response without cutting any off.

9 Check Use Artifact Removal and select 2 iterations.
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10 Click on the Include button to include the first order kernel,
making sure that the epoch is 0 - 80 ms.

11 In a similar manner, include the first and second slice of the
second order kernel, and the first slice of the third order
kernel.

To avoid having to do Artifact Removal separately for each
file, a special "Apply to all documents" option is available.

12  Check the "Apply to all documents" box and click OK.

The program now performs Artifact Removal on each of the
files in the Document List.

13 Select File: Save As: Save Data As... and save our
Combination in the Normal Files folder  (not VERIS data).

You may be prompted to save the Analysis settings if they
were altered during the creation of the Combination file.

We will use this file to create a normals reference file in the next
section. It is important to save this file in the Normal Files
folder so that when it is converted to a reference file it will appear
in the Select: Reference pull-down menu.
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A Combination File is just an instructions file, which says
go, find a specific list of data document files and combine them
according to a set of parameters.

All associated data files must be available on the same
computer as the Combination File.

Selectively Choosing Eyes to Combine

While looking at the individual files we’ve just combined, you may
have noticed that half the eyes recorded were left eyes and half
were right eyes.

VERIS™ keeps track of which eye has been recorded by looking at
the Subject's "Eye tested" parameter that you entered when
setting up a recording.

When combining a "mixed" set of left and right eye recordings,
VERIS™ uses the “Combine Both Eyes as Left Eyes” option by
default. It will flip the right eyes to look like left eyes and then
combines them all.

From the list of files combined you can selectively choose which files
you want to look at.

14 Select the Default Analysis Settings and use the
Parameters pull-down menu to Combine Left Eyes only.

Now, as you look through the tabbed views, only the left eyes
are included. Similarly you can view only the right eyes using
the “Combine Right Eyes Only” command.

Use the "Combine Right Eyes Only" and "Combine Left Eyes
Only" commands only if you have files with some right or left
eyes. Otherwise your trace and averages plots will be straight
lines (indicating no responses).

The “Combine Both Eyes” command is useful for VEP recordings
where you don’t reflect. It simply combines all eyes and leaves them
oriented left or right as recorded.
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Creating Reference Data

Combining the records of similar subjects can provide useful
information for comparing one group of subjects to another.
VERIS™ creates and uses reference information to analyze how
data files compare. In an earlier section on the MultiPlot tabbed
view we used some of the reference files provided with VERIS™ to
compare data.

It is always a good idea to create your own reference files and it is
easy to do from suitable combination files. Just include enough files
so that, statistically, you can properly calculate probability of
abnormality.

The first step is to combine a set of files and do Artifact Removal on
each file. We have already performed this step in the previous
example.

1 Use the File: Open menu and "Show only Combination
Files" filter to select the Combination file you just saved. If it
is already open, you'll get an "in use" warning. Just click OK.

2 Now select the Calculate Normals button.

Selecting the Calculate Normals button if you haven't
already saved your Combination file will open the Save Data
File As dialog box. Make sure your file is saved into the
Normal Files folder.
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Currently our only Normals type option is Scalar Product
(amplitude). Future versions of VERIS™ will include the ability
to construct reference data for comparing subject latencies with
reference latencies.

In the Calculate Normals dialog box you select the desired
kernel slices and epoch for your reference file and, if
necessary, spatial averaging.

We have already done Artifact Removal on our set of files,
which, as noted earlier, also includes a spatial averaging as
part of its algorithm.

3 Make sure that the first order kernel has been selected
and click OK.

The program calculates the Normals data for the first order
kernel slice, with an epoch 0 - 80 and without additional
spatial averaging.

Each reference file can now contain multiple kernel slices,
which you create one at a time.

During analysis you will be able to switch between kernel slices in
the parameters dialog box without having to switch to a different
normal file.  

4 When the program stops calculating, again select the
Calculate Normals button and repeat step 3 selecting the
first slice of the second order kernel.

5 Repeat step 3 twice more, selecting the second slice of the
second order kernel and the first slice of the third order kernel
(the same slices we used for Artifact Removal).

6 Now Save your file, making sure that it exists in the Normal
Files folder (Alternatively, you could save the reference data
with another name using the Save As… command.)

When you create a reference file all the necessary data is stored
with that file, unlike Combination documents, The original files
need no longer be available.
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7 Open one of the files from which we created the reference,
and from the Select:Reference pull-down menu, select our
newly created reference.

8 From one of the views, select Edit Parameters. Notice that
the Kernel Slice selection is limited to those kernels slices we
selected when we created the Reference file.

Reversing Polarity
Combination files can be used to demonstrate how to correct a
common recording problem, reversed polarity.

1 Create a New Combination using the "Reversed" file,
found in the Sample Data Files folder

2 Select the Default Analysis settings and look at the Traces
view.

In setting up this recording, signal wires were reversed. In the usual
flicker response for the first order kernel you would be looking for a
trace whose slope runs negative, positive, negative, with, sometimes,
a slow component afterward. As you see in the Traces View the
traces run positive, negative and then positive.  

2 Select Edit Weight and use a value of –100% to effectively
reverse the traces. You can now save this Combination file
with the data oriented correctly.

There is a much simpler way to reverse polarity.

From the Subject view of a data file, use the Parameters pull-
down menu to select Override Setup Info. Ignore the warning
and click Proceed.

Then check the Invert Data box in the dialog and click Override
to correct your file. Use the Save or Save As... command to
create a new file with the correct orientation.
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Latency Measurement
Latency Measurement - The Problem

The simple and straightforward approach to estimating peak latencies of
neural mechanisms by selecting peaks in response amplitude is generally
inaccurate and can lead to misinterpretation of the data. There are two
reasons for this. 1. High frequency noise contamination tends to affect the
exact location of the response peak. 2. The amplitude maximum may shift
between two neighboring features such as the b-wave double peaks.

This is illustrated in Fig. 1 with a set of first order traces. Fig. 1a shows the
waveforms on a ring around the fovea. Response averages over concentric
rings are shown in Fig. 1b. Near the center the earlier peak dominates while
the later one forms a shoulder on its slope. At larger eccentricities, the roles
are reversed. It is reasonable to assume that the two features have a
different physiological origin. In this case, the latency topography of the
absolute peak in the waveforms clearly appears to confuse latency
distributions of two underlying physiological sources and is, therefore, of
little interest.

Latencies
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Latency Measurement - The VERIS Solution

The above problems can be avoided when the approximate shape of the
basic underlying response waveform is known. This waveform can then be
used as a template and latencies can be determined much more reliably by
shifting the template along each response waveform to the position where it
matches best. A suitable template waveform can be obtained in two different
ways. If normative reference data are used, the local average trace derived
from the reference data sets can be used to measure the latency of the
patient trace in the same location. If reference data are not available,
averages of groups of traces with similar waveforms can be used as
templates.
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Since waveforms vary mainly with eccentricity, averages of traces on
concentric rings around the fovea are often most appropriate for such
latency estimation. This approach is illustrated in Fig. 2. It shows how the
template waveforms are selected on the group averages by means of
markers. The feature whose latency is estimated, is marked on the template.
The range of correlational shifts explored in the fitting procedure is
determined by EPOCH START and EPOCH END of the group averages.
On the right the traces of Fig. 1a are re-plotted together with the template
in the best fitting position. The arrows mark the latency of the selected
feature.
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With VERIS™ 5.1, you can compare the latency values with
those of a reference file. The computation of Standard Deviations
from normal mean values will be implemented in the next major
release.

During data analysis you can measure and map latencies of any
feature such as a peak or valley in the response waveform.
Selection is done within the 3D Plot Parameters dialog box.

In this next tutorial we will measure peak latency using a
template for the feature and sliding this template across each of the
local response waveforms to find the position of best match, i.e.,
performing a cross-correlation.

Peak Latency (Groups)

1 From within the Sample Data Files/ Normals/103 areas
subfolder, open the "B49-BP" file and, using the Default
Analysis settings, select the 3D Plot tab.
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2 From the Edit: Edit Filters dialog, use the Artifact
Removal filter to do 2  iterations on the first and second
order (first and second slice) kernels.

3 Select Edit Parameters and choose Peak Latency
(groups) from the Plot Value pull-down menu.

When selecting Peak Latency, Small Feature Latency, or
Scalar Product Fitted the dialog box adds additional graphics
for the selection of the grouping and the marks similar to
those in the Averages view.

In order to view all the waveforms and associated latency values
it may be necessary to drag on the bottom right corner of the 3D
Plot Parameters window to expand its size.

We first want to choose a template waveform by grouping the
waveforms from an area within which the feature (peak) appears to
have constant latency. In principle a single waveform can be
selected as the template, but an average of a few traces is less
noisy and leads to more reliable latency estimates. (In second and
third order kernels, you should avoid the center waveform and those
at the blind spot.)

The default groupings, ring average waveforms, appear to have a
constant latency. (To prove this is so, you can take a ring of traces,
each trace as its own group, and examine the variance of the peak
latency in each group.)

You can select one template (grouping) if the waveforms vary little
with eccentricity. If you choose several groups, then each template
will only be used to measure the feature latency within its own
group. (Any ungrouped traces would be included with the template
of the highest numbered group.)

In our example the peak of the ring averages are all within 2
msec. (30.0 - 31.7). In addition, the central three groups and
the peripheral three groups have similar values. We can
therefore reduce the groupings to two templates.



5 - 12 Chapter 5   Working with the Data

VERIS™ Science 5.1 Reference Guide

4 Using Edit Groups, "Clear All Groups" and then create a
New Group 1, consisting of the central 19 traces.

5 Create a New Group 2 and then use "Add Rest" to group all
the peripheral traces. Click OK.

Looking at the groups from which our templates are derived,
find the approximate feature window within which the
feature (peak) appears. In our example, we will use 20 to 40
msec.

The marks for the selected feature and those for the template
boundaries (feature epoch), can be set individually with mouse
clicks or simultaneously on all traces when holding down the option
key.

6 Hold down the option key, click on one of the starting
boundaries (marked with a vertical bar) and slide it to the
right until the latency value switches to 20 msec. Upon
release the other grouping's starting boundary moves to the
same position.

7 Do the same with the ending boundaries, using the value of
40 msec.

We now need to define the maximum window range (Epoch) within
which the template will slide. If too large, the tool may find another
maximum which fits better. If too small, you use too little of the
wave form. The object is to reduce high frequency noise. Epoch
length also depends on template size. You need enough room on
each side for it to slide back and forth.

8 Under the Kernel Slice and Epoch control define the
maximum window range. For this example, enter a Start
value of 10 and an End value of 65. The waveforms contract
to reflect the epoch length.
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You must define the maximum window range (Epoch)
prior to selecting a Normals reference file. Once a Normals
file has been selected, the Kernel Slice and Epoch are grayed out.

When comparing results with another data reference file,
however, these parameters are accessible.

9 Check the Numeric view box and click OK.

Note that all the latencies in our example fall between 27 and
34 ms. We can use these values to fine tune the color range
for the latency graphic.

10 Return to Edit Parameters and change the White for value
to 34, and the Black for value to 27.

11 Verify that the Color Space is  Red Green Blue and
uncheck the Numeric view box.

NOTE:  The Spatial scaling for latency plots will be
significantly different than that for Scalar Product. It is
necessary to adjust the V Scale / H Scale value to provide a
meaningful latency plot.

12 Reduce the V Scale / Scale value to 1.5 and click OK.

In the latency plot, the largest delay appears near the blind
spot  (due to scattered light). On the color scale it is
approximately 33 msec.

Earlier versions of VERIS™ displayed latency values relative to
the template. The program now calculates absolute latency
values. The colors in the scale represent absolute latency in
milliseconds.
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Comparing Latency with Reference Files

With VERIS™ 5.1 we can look at the numeric differences between
the latency values of our data file and reference files.

1 Use the Select Reference Normals command to load "ref 103
(n=48)" as the Normals File.

2 Option-double click on "B49-CJ" in the File Navigator to load
it as the Reference File.

3 Open the 3D Plot Parameters dialog. Notice that you can
now switch between the Patient, Normals or File Reference
Trace Array.

You can also view the 3D Plots of any two of the three files.
You assign which two files to compare with the overlay
feature in the Display section.

Normally the Patient Data is presented as overlay 1,
although you have other options. Overlay 2 is either the
Normal Reference or File Reference.

4 Select the Normal Reference for Overlay 2 and enter a
Display 2 Offset value of 12.

5 Select the Numeric View and click OK.

The peak latency values for the Data file are shown offset
above the Normals values. You can also look at the
difference in values between the files.

6 Return to the Display area of the 3D Plot Parameters and
select the "-" (subtraction) option between Display 1 & 2.
Click OK.

Use the Show & Hide buttons above the plots to view the
latency values of each overlay without subtraction.

7 Now, for Display 2, switch the File Reference for the
Normals Reference to see the peak latency differences
between the data file and the other reference data file.

8 Finally, switch out of Numeric view and toggle between the
3D peak latency plots of the files.

Goodness of Fit

This function measures how well the waveforms fit the template
you've selected. When you check the Goodness of Fit display box,
you shouldn't see any change in the 3D latency plot if you have
set up the latency template properly.
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If the waveforms don't fit at all - if the goodness of fit is very poor -
then everything below the threshold (GoF tolerance) will be gray in
the 3D Plot instead of color scaled according to latency.

In these gray areas where the waveforms do not fit the
template the latency measure is therefore unreliable.

The Goodness of Fit tolerance ranges from 0 to 1. Using a value
closer to 1 the waveform has to match the template very closely in
order for you to consider the latency measure reliable.  At 0.5 the fit
can be very poor.

Scalar Product (Fitted)

The technique for looking at the Scalar Product Fitted is the same
as with Peak Latency.

In Chapter 4 we looked at the scalar product estimate of the
amplitude. The scalar product is a measure of abnormality rather
than just amplitude, because it is sensitive to reduction in
amplitude as well as misfit of the template (latency shift). This shift
can also cause a very severe reduction of the scalar product. If you
want to condense everything to one measure of abnormality the
scalar product is a good one.

But if you really want to have separate information on what is due
to change in the waveform and what is due to simply reduction in
amplitude we have another way of doing it - the fitted scalar
product.

We do this by taking the template and shifting it until it reaches the
best fit and we then take the shift that is needed to make it fit as
the latency. And we take the scalar product in the position of best
fit as the amplitude.

The Scalar Product Fitted is an important tool for separating a
"pure" change in latency from a "pure" change in amplitude
between focal responses and templates.

Small Feature Latency

Small Feature Latency utilizes the same shift correlation method
used in the previous two examples. Suppose you have on the b
wave some OP feature whose latency you want to know.

With our shift correlation we choose a feature epoch and we
baseline it. We cross correlate a template across it until we get the
best match. That determines the latency.



5 - 16 Chapter 5   Working with the Data

VERIS™ Science 5.1 Reference Guide

Combine Kernel Slices
You can add or subtract kernel slices of different order to improve
signal to noise.

You combine kernel slices by opening an Edit Parameters dialog
box and selecting the “Combine Kernel Slices” checkbox, found in
the Kernel Slice and Epoch section.

You select the tick marks indicating the slices you want to combine.
The first order automatically appears in the window. For each slice
you can modify the epoch length, and the weight given. Use the
Include button to add slices to the list.

Including the first slice of the second order, and using 100% means
that you are simply adding the slices together. Subtracting the first
slice of the second order instead of adding it (using a negative
weight, –100%) would be equivalent to considering only those
responses in the kernel calculation (in the average) that don’t have
a response in the interval right afterwards. So whenever there was
a flash in the subsequent interval it would not consider it.

As you “include” a slice, it becomes highlighted in the window. When
a listed slice is highlighted the Include button turns into a Delete
button in case you want to remove it. If you change the epoch
length or weight, a Modify button is added. You must select it in
order to register your modification.

1 Open any data file and combine the kernel slices as shown
above.

2 Use the Edit Undo command to look at the “before” and
“after” effects of the combination on your plots.

Combining kernel slices can be useful in the mfVEP, since we are
always fighting signal to noise. Adding the 4th order kernel to the
2nd order, since they are in phase, can add a little bit of signal.
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Dichoptic mfVEP Stimulation
One recording stimulation option, dichoptic mfVEP, was not covered
in Chapter 2, “Setting Up a Recording.”

1 Open a new “untitled” Setup document and select the
Subject Parameters.

2 In the Eye Tested pull-down menu select Dichoptic.

In recording mode, when you switch to Dichoptic mfVEP
the display will be duplicated - the stimulus will consist of two
arrays side by side. Unlike a binocular recording, this protocol
assumes that each eye can only view one array.

In analysis mode, after recording a subject with dichoptic
stimulation, you can view the responses for the left and right
eyes separately. In each of the analysis parameters dialogs
you can select left or right eye

Using the Display section, you can select the patient's left or
right eye, or a reference right or left eye for each of the two
overlays.

In the trace array, for example, you could have each eye as
an overlay. Using the Show and Hide buttons you could
switch to the left or right eye and get the responses.

You could also show both, overlapping them.

Or, using two plots side by side, you can compare the left and
right eyes, or one eye against a file reference.
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The Optic Nerve Head Component (ONHC)

Stimulus
The recording protocol used to isolate the optic nerve head
component has a significantly different stimulus pattern.

1 From the Select Recording Settings dialog box, double-
click on the "ONHC Protocol."

2 In the Colors section notice that there are 5 frames in each
m-step. The top sets of boxes represent the stimulus.

Frame 1 is a standard m-sequence step, followed by a global
flash (2), then a dark frame (3), a global flash (4) and finally a
dark frame (5). Then it starts over again with the next step
in the m-sequence.

The bottom sets of boxes represent the background, and are
synchronized with the stimulation of the hexagons. The
background is dark in frame 1 (the m-sequence step) and
frames 3 and 5 in which the stimulus is also dark. Frames 2
and 4 are bright matching the global flash.

Data Analysis
To properly evaluate the focal contribution of the ONHC to the
response it is critical that you know what you are looking for and
have experience that must be acquired by inspection of normal and
patient records. Similar to the x-ray specialist, you will look at
normal and patient files and know what doesn't look normal.

After accepting recording the ONHC Analysis settings should load
automatically.

As noted above, the ONHC protocol is multifocal with global flashes
thrown in. What we are looking at here is the effect the local flash
has on the global flash and that's where we get this optic never head
component that changes latency. (There is also a direct component
of the local flash, but since our protocol uses an epoch of between
60 - 90 ms the direct effect of the local flash is coming much earlier
in time.) The 60 - 90 ms range is when the global flashes are
appearing.
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This protocol also does a fairly high amount of spatial averaging (1
iteration of 29%). If the data is relatively noisy you may want to do
even more spatial averaging.

The ONHC is a contribution to the ERG that originates from optic
nerve fibers (ganglion cell axons) at the location of the optic nerve
head. It is recognized by its implicit time that increases with the
distance of the stimulated area from the optic disc. This increase is
due to the relatively slow propagation of action potential along the
unmyelinated nerve fibers. The contribution from the ONHC
cannot be reliably detected and estimated in individual focal traces.

However, in good quality records derived from normal eyes it is
easily recognized when traces are considered in the context of other
traces. Sets of traces on concentric rings around the fovea are good
choices for the evaluation. On such rings both the retinal
component and ONHC are reasonably constant in waveform and
mainly vary in their relative latency.

In the ONHC Analysis Settings the waveforms of such rings are
presented aligned in vertical columns from the innermost ring on
the left to the most peripheral ring on the right.
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The sequence of traces of each ring from top to bottom, always
start from the temporal field (nasal retina), i.e., the side of the nerve
head, proceeding through the superior field to the nasal side and
returning through the inferior field. In each ring we are then looking
for features in the waveform that first increase in implicit time and
then decrease again on the return to the proximity of the disc.
Examples of such records from normal subjects are shown below.
(The #1 trace corresponds to the red grouping and goes
counterclockwise.)

There is considerable variability in the data from normal eyes. It is
therefore important for the person inspecting the data to acquire an
appreciation of the size and nature (variability in waveforms) of
inter-subject differences in normals and differences between
normals and patients. We recommend that each institution
participating in the evaluation of the ONHC protocol record its own
normal data sets.



Chapter 5   Working with the Data          5 - 21

VERIS™ Science 5.1 Reference Guide

The pathological changes in the response waveforms differ
considerably not only between different diseases but also within
patient groups with the same diagnosis such as glaucoma patients.
These differences are not well understood at this time.

Inspecting the data sets as a whole rather than performing data
reduction to a single parameter may help us to gain a better
understanding of disease processes in the future. Careful inspection
and experience in the evaluation will help us achieve this goal.

The example below shows abnormal data from a glaucoma patient.
The red traces and corresponding red areas in the reference plot
below are considered greatly deficient in the ONHC. Traces with
residual ONHC are black even though they also they may be
slightly deficient.

VERIS can quantify the abnormal areas. When evaluating the
data, click on the numbers identifying traces you feel are strongly
deficient in the ONHC. Click once if the trace is moderately
abnormal and. the trace and the accompanying graphic below will
be pink. If the trace is very abnormal click on the number twice.
The trace and the graphic will be colored red.

The graphic will keep track of the number of abnormal traces (pink)
and the very abnormal traces (red). This gives you a quantitative
measure of the abnormal areas.

The reference plot can then be compared with visual fields of the
same patient.
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Creating Your Own Tabbed Views
There are two ways to create new tabbed views. You can add a tab
or copy one.

If you are creating a tabbed view with one plot you can use the
Edit: Add Tab pull-down menu to select a Traces Plot, Averages
Plot, or 3D Plot. You can also select an "Empty" plot in which you
can add plots or pictures.

If you want to create a tabbed view with multiple plots, an easier
way is to copy an existing similar tabbed view.

1 From within the Sample Data Files/ Normals/103 areas
subfolder, open the "B49-AT" file and select the Default
Analysis settings.

2 Double click the Multiplot tab to open the Edit Tab box.

3 In the Tab field, check the Copy Tab box

Doing this adds a new tab to the Analysis set with the same
layout as Multiplot. (The Remove Tab check box deletes
the current tab.)

4 Enter a new Name for the new Tab window.

To change Tab Color simply double-click the Tab Color box
and pick a new one. You can also select Black or White text
depending on what shows up better on your selected color. A
preview of your new tab will appear in the dialog box.

5 In the Plot Area field, make sure that the Freeze box is
unchecked.
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If you ever have problems editing plots in a tabbed view, make
sure that the Freeze box is unchecked. If checked the tabbed
view is locked. No layout changes can be made.

In the Plot Area you can also change the background Color
of the tabbed window. Show Plot Numbers is useful for
identifying each plot.

6 Check the Show Plot Numbers and click OK.

The new view is created with the same parameters as the
copied view. You can now change any features of this view
independently. The original tabbed view remains unchanged.

This feature is useful for creating a series of similar views
with different parameters. You can then quickly switch
between them for comparison.

7 Use the Edit: Select Plot pull-down menu or simply click on
Plot #1 to select it. Drag the mouse over the 3D plot with the
Apple key () held down.

Notice that the mouse arrow cursor turns into a hand
symbol. With this cursor you can move the plot around the
tabbed window.

8 Drag the hand cursor to the bottom right corner of the
selected plot.
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The hand cursor now becomes a re-size arrow cursor. With
this cursor you can change the size of the plot’s boundary box
by dragging on the lower right corner.

Adding a Plot

9 Make room for a new plot by selecting Plot #1 and deleting it
using the Edit: Clear Plot command.

You can add a new plot to your tabbed view in several ways.
Using the Edit: Copy Plot command you can copy a plot
from any view, along with all of its unique parameters. Then
return to your new view and use Edit:Paste Plot to paste
that plot into your view.

You can also use the Edit: Add Plot to Tab menu to add
either a Traces, Averages, or 3D Plot to your view. These
plots will have default parameters.

10 Add a new Traces plot to this window by selecting the Add
Plot to Tab: Traces command in the Edit Menu.

The newly added plot covers the other plots so you will need
to resize and move it so that all plots are easily seen.

Notice that the newly pasted plot receives Plot1 since it is
on the top or #1 layer. The other plots are renumbered with
the highest numbered plot on the bottom. The plot
numbers are always located in the center of the
individual plot’s boundary box.

11 Edit the Parameters of this Trace Array so that Display 1
shows Patient Data, and Display 2 is Normal Reference
data.

12 Select the "-" (subtract) function so that the trace array
shows the difference between the two file's traces.

Select the Show Patient Data and Show Normal Reference
buttons to see the difference.

If you select the Hide Patient Data button, you will see the
Normal Reference traces. If you select the Hide Normal
Reference , you will see the Patient traces.
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Adjusting Plot Visibility

When a plot is added to the tabbed view it is “pasted” on top of the
other plots. You can re-orient a plot’s layer relative to the other
plots using the Edit menu.

1 Make sure the new Traces plot is selected.

As long as any portion of a plot’s boundary box is visible you
can click on the plot to select it. If a plot is covered by other
plots, use the Edit: Select Plot command to select it.

Since the Traces is the “top” plot you can only Move Plot
Back or Move Plot To Back. Moving a plot To Back puts it
on the bottom.

 2 Using the Edit menu, move the Traces plot To Back and
notice how the numbering of the plots change.

 3 With the Traces plot still selected pull-down the Edit menu
and notice that now you can Move Plot Forward or Move
Plot to Front.

There are several additional controls that control visibility. To
access them you must double-click on your selected plot while the
Apple () key is held down. (The hand graphic should be visible.)

4 Select the Normal Reference 3D Plot (which should now be
on top as Plot #1) and move it up to cover part of the Traces
plot.

5 Double click on the Plot with the Apple () key held down to
open the Edit Plot Holder dialog box.

The Drawing options control the background transparency
of the plot and visibility of the legends and plot controls.

6 Select all three checkboxes under Drawing controls and
click OK.

The 3D Plot, without legends or controls, now appears on a
transparent background. Any plot lying beneath it's
background is now visible.
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Adding Text

You can enhance any plot by adding text, which becomes part of
this view.  

1 Re-select the Traces plot and, from the Edit pull-down
menu, select Add Text...

2 In the Edit Text dialog box, type in "Trace Array" as the
text you want added to the currently selected plot. Then
select the size, style, font and font color you want to use.

3 When you click OK the text appears in the selected plot.

To locate the text where you want it, use the Apple ()
command as you click and drag the text to a new position,
even one outside the bounding box of the plot.
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You can also use the “Bind Text” checkboxes to locate the
text at the bottom or right edge.

Editing Text

To change existing text, double click on the selected text using the
Apple () key. The Edit Text dialog will open for that text. Edit the
text or use the delete key to remove it.

4 Double-click on the "Normal - Patient Difference" text using
the Apple () key and revise the text to "Trace Difference"
from the Edit Text dialog box.

5 Use the Apple ( ) command as you click and drag the
"Normal Reference" text to a new position.

To remove the "boundary box" on a selected plot, simply use the
Apple () key and click outside any of the plot boundaries (or use
the Edit:Unselect Plot option.

Adding Pictures

You can now add pictures to your tabbed views. The pictures can
either be the same for every data file or they can change with each
data file. This will depend on whether the picture is saved as part of
the Analysis protocol or as a part of the data set in one of the
Subject tab “placeholders.”

Pictures added directly into an analysis tabbed window and
saved with the analysis settings, will be part of the analysis
settings and not part of the data file. These pictures will always
be the same regardless of the data file to which they are
applied. Any kind of graphic that you want to show there would be
the same for each data set.

Pictures added directly into one of the “placeholders” in the
Subject tab will remain with the data file. These pictures
will be different for each data file. When a data set containing
them is used with an analysis protocol that displays them, the
pictures unique to this file will automatically show up in the
analysis tabbed windows.
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Compare Anatomy with Function

One of the primary benefits of creating multiple layers of images
and plots allows you to compare anatomy with function by placing
fundus images, angiograms and visual fields under a trace array,
latency or amplitude plot.  You set this up through the following
steps:

1 Open the “Add.Pictures Demo” file.

If your data file contains “placeholder” pictures, when you
open it the Subject tabbed view will have a series of three
picture “pads” at the bottom.

These pads will not be present if no “placeholder”
pictures are part of the data file. However, as soon as you
add one, the three picture pads will appear.

In our example, we have inserted a picture of our fictitious
patient into the Picture 1 “pad.”

2 Add a picture by using the Edit: Add Picture command.

Since the Picture 1 “pad” is taken, you can only add a picture
to “pads” 2 & 3.

3 From the Sample Data Files / Pictures subfolder, select
“fundus.jpg” when prompted to “Choose a picture file.”
(Only picture files will be visible within the dialog box.)

A fluorescein picture should now be inserted as Picture #2 in
our Subject tabbed view. We will insert this picture below a
set of traces.

4 Switch to the Traces tabbed window.

5 Double-click on the Traces Tab and remove the check from
the “Freeze” box in the Edit Tab dialog.



Chapter 5   Working with the Data          5 - 29

VERIS™ Science 5.1 Reference Guide

If you want to import a picture into a tabbed window, you
first have to “unfreeze” the tab. The Freeze function
helps to avoid accidentally changing the relative
positions between overlapping plots and images.

6 Use the Edit: Add Plot to Tab command to add the
Picture - use Subject Picture 2.

In addition to the three Subject Picture choices you could
select "Picture File" which would allow you to select a picture
file located elsewhere on your hard drive or network directly.

7 Use the Edit: Move Plot to Back to put the fundus photo
behind the trace array.

The trace array is currently plotted unscaled in order to avoid
crowding at the center. It does not reflect the eccentricity
scaling of the stimulus array.
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8 Click on the Trace Array plot to select it and then select the
Edit Parameters button that appears.

9 In the Traces Parameters dialog under Misc., click on the
Exact Positioning checkbox.

VERIS now uses the exact stimulus picture to position the
traces according to where the stimulus was.

10 With the Apple (Command) key held down, double click on
the Traces Plot and select the Transparent checkbox from
the Edit Plot Holder dialog that appears.

By choosing the Transparent checkbox this plot is made
transparent, so that you can see the picture underneath.

Now we have to scale the images relative to each other
correctly. Scaling is done by first selecting an image. Each
image or plot is on its own layer. You click on an image to
select it.

When you select an image its boundary box becomes visible
and any corresponding parameters will appear in the left
panel. (If you have multiple plots, only the selected one will
be displayed). Note that you can deselect everything by
clicking on the background.

As we mentioned earlier, a background image may not
protrude sufficiently beyond the front image for you to click
on it. An easier way to select the image layer is with the Edit
– Select Plot command. The image layers are numbered from
front to the back, so selecting Plot Number 2 will select the
image behind Plot Number 1.

11 With the Traces Plot image selected, use the Apple
(Command) key and move the “hand” cursor to the lower
right corner of the boundary box.

It will change to a double-headed diagonal arrow. You can now
proportionately increase or decrease the size of the selected
image by dragging into or away from the center of the image.
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Then, using the Command “hand” you can move the image
around and achieve alignment between  images – for
instance between the trace array and fundus picture.

The size of the fundus image will change depending on the camera
settings. Future versions of VERIS™ will permit scaling of the
“pad” on which we import pictures so that when we import pictures
they will have a particular size.

If you know what the optics of the fundus camera was you will
know what the size should be. So with a fundus camera of a certain
focal length you can set your analysis settings for importing at the
right size.

You will still need to move the image around until the disc is in the
right place.

12 Use the Parameters: Change Subject Color command to
change the Trace to white, or to another color.

In order to get the traces to show up better against an image
we can alter the color or contrast.  In the dark areas of the
fundus image the traces are hard to see.
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13 Now select the fundus image, and make it Transparent in
the same way we’ve already done with the Traces Plot.

Unlike plots, when you make images transparent a
transparency control appears that allows you to modify
contrast.

14 Try changing the Xfer Value and see the effect each change
has on the image quality.

15 When you are happy with the relative  positioning of the
images  “freeze” the tab again.

In a similar way you can overlay the numeric 3D responses or
latencies on the fundus image, once you have selected Exact
Positioning in the 3D Plot Parameters.

When you add pictures and save the data file the imported pictures
are attached as a resource and will always show up in the Subject
tabbed window. However, as you place images and re-size plots you
are creating a new analysis protocol. If you use the Default
Analysis settings you will not see any of your work when you open
the various tabbed windows.

You must also save the newly created Analysis settings file, which
contains the instructions for where to place these pictures. Use the
Save As – Save Analysis Settings As… command.

When you drag in a new fundus photo, if you use this newly created
Analysis setting, it will automatically be underlayed. If the new
fundus photos were taken from the same camera the scaling will be
the same size.

It will not, however, be automatically aligned. Where the disc is
depends on where the patient is looking and that may depend on
what he was instructed to do.

Re-ordering Tabbed Views

We have discussed how to create, remove and edit the analysis
tabbed windows. As you create the layout of tabbed windows you
will have your own preferences as to the order in which they appear
across the top of the document window.

Tabbed views can be re-ordered simply by selecting a tab with the
mouse key and dragging it to a new location. An outline of the tab
will follow the cursor to indicate it is being moved.
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6 - Ganzfeld Recordings

While we believe that multifocal electrophysiology will replace the
conventional techniques in most areas of clinical testing, standard
tests utilizing Ganzfeld stimulators and single area pattern
reversals presented on a CRT monitor are still very much in
demand. This is understandable, as these techniques have been
honed during many decades of experience.

EDI now offers hardware for conventional as well as multifocal
stimulation and protocols for both types of stimulation are
accessible from the same software package.

VERIS™ Ganzfeld Software
Ganzfeld responses are commonly recorded in a single session using
a battery of tests involving scotopic, photopic, and single flash
stimulation at different flash intensities, flash intervals and filter
settings. The new VERIS™ Ganzfeld software makes recording
such sessions easy.

The user simply chooses a Ganzfeld session protocol and proceeds
according to the steps described below. The data from the individual
tests are automatically stored in a folder with the patient’s name.
Opening any of the test files in this folder opens the entire session
with the data of all the tests displayed in different tabs. Tests that
were not performed leave empty plots that can easily be filled in at
a later date. To do so, the user selects an empty plot by clicking on
it and performs the missing test as described below.

Using VERIS Science™ software, you can design new Ganzfeld
recording sessions with tests at different flash intensities,
chromaticities, background illumination and flicker rates. VERIS
Clinic™ only runs the protocols provided by the manufacturer.
These include protocols following ISCEV standards. EDI may add
new protocols as the demand arises. All feedback from the user is
greatly appreciated.

Starting a Ganzfeld Session

1. Under the Select pull-down menu choose Recording
Settings.

2. In the Select Recording Settings File dialog, choose
Conventional Protocols.

3. Under Ganzfeld Settings, select a session.
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Recording a Ganzfeld Session
1. Select a test Tab containing the plots for the data you want

to record first.

2. Click on the plot you want to record. A red record button
appears at the top of the window.

3. Click on the Record button.

Binocular Ganzfeld Recording

To start binocular recording using two recording
channels, hold down the Option key while clicking the
Record button.

A message will appear reminding you to make sure that the
right eye electrode is connected to Channel 1 and the left eye
electrode to channel 2.
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4. Depending on the test selected, one of two recording windows
will appear.

5. After accepting the recording, the responses are
automatically entered into the plot(s) of the chosen test.

Changing Ganzfeld Recording Parameters
1. Under the Select pull-down menu select Recording Settings.

2. Select the Ganzfeld Settings folder.

3. Switch the Filter files menu at the bottom of the dialog box
to Show Ganzfeld Parameter Settings. The recording
settings names change to the individual Ganzfeld tests.
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4. Select a Ganzfeld test parameter setting and click OK.

5. Using the Color and Temporal settings buttons you can
now edit the stimulation and recording parameters.

Generating new Ganzfeld Recording Test Parameters
You can either edit an existing Parameter Setting and save it with a
new Test Number and Name or generate one starting from the
Default Recording Settings. In either case proceed as follows:

1. In Temporal Settings go to the Stimulation Type pull-
down menu and select the Ganzfeld Settings type you want
to use (Ganzfeld Single Flash, Ganzfeld Periodic or Ganzfeld
EOG). The controls for the temporal parameters will appear
immediately in the box.  In addition you will see a field called
Test Num(ber).

2. Enter the desired Temporal parameters and a unique Test
Number.
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3. Click OK to close the Temporal control box and now open the
Colors controls.

4. Enter the background luminances and flash intensities
required for your protocol.

5. Use the File pull-down menu and the Save Recording
Settings As command to save the new protocol.

We recommend that you include the Test Number (in
parenthesis) as part of the name of the new Ganzfeld Parameter
Settings file when you save it.

Generating a new Ganzfeld Session
To generate a new Ganzfeld Session you can either edit an existing
one and save it with a new name or you can generate it starting
from the Default Recording Settings.

Starting from the Default Recording Settings:

1. If your default recording protocol is not set up for Ganzfeld
stimulations you must first do so.

2. In Temporal Settings go to the Stimulation Type pull-
down menu and select the Ganzfeld Settings type you want
to use (Ganzfeld Single Flash, Ganzfeld Periodic or Ganzfeld
EOG). The controls for the temporal parameters will appear
immediately in the box.

3. In the Parameters for this plot enter the Test Number of the
recording you want to display in the tabbed window.

4. In the Edit pull-down menu select Add Tab with Ganzfeld
Plot(s).

5. If you get an error message that "Recording is not available
because no Test Num was specified", simply ignore it and
click OK.
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6. Select one of the plots in the new tabbed window to set the
parameters and to scale the display as needed.

Refer to the section in Chapter 5, "Creating Your Own Tabbed
Views" for a complete description of how to position and format
the plots in this tabbed window.

7. You may place the results of other tests in the same tabbed
view by choosing Add Plot to Tab from the Edit menu.
From the submenu, select the desired type Ganzfeld plot.

Position the different plots holding down the Command key
on the keyboard and dragging them to the desired location.

8. Add plot labels and other text to the tab in the usual way.

When you are satisfied with the layout of the tab, you may
freeze the tab as described in Chapter 5.

9. In the same way you may add more tabs corresponding to
other Ganzfeld Parameter Settings to the Session Window.

Starting from an existing Ganzfeld Session.

You may change the test displayed in any plot of a Ganzfeld
Session as follows:

1. Select the test tab containing the plot you want to change.

2. Select the plot by clicking on it.

3. Click on the Edit Parameters button to display the
parameter box for this plot.

4. Change the Test Number to the one for the Ganzfeld
Parameter Settings you want to display in this plot. (You will
need to load a data file in order to adjust the scaling
parameters.)
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5. To delete a plot from a tab. select the plot by clicking on it
and use the "Clear Plot" command from the Edit menu.

6. To add plots to tabs and tabs to sessions windows
proceed as described in the previous section, "Starting from
the Default Recording Settings."

Looking at Ganzfeld data
As noted earlier, data from the individual tests are automatically
stored in a folder with the patient’s name. Opening any of the test
files in this folder opens the entire session with the data of all the
tests displayed in different tabs. Tests that were not performed
leave empty plots, which can easily be recorded later.

1. Using the File: Open command, select one of the data files
stored in a Ganzfeld folder.

2. If an analysis protocol is not already associated with the
folder, select an Analysis Settings protocol for one of the
Ganzfeld sessions using the Select pull-down menu.
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Tabs for all the tests appear at the top of the window.

3. Select one of the tabs to view the responses for that test.

4. Select the Summary tab to see the results of all tests in one
window.

A plot without data indicates a test not performed.
Simply click on the plot to activate the record button and
record the test.

5 Click on any plot and use the Edit Parameters button to
modify the parameters for that plot.
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EOG Recording Procedure
1. Attach the EOG electrodes to the patient’s head as follows:

Channel 1 electrode pair nasal and temporal to the right eye
Channel 2 electrode pair temporal and nasal to the left eye
(+) electrode always to the patient’s right
(–) electrode to the left of each eye
Ground electrode on forehead

2. Power up the Ganzfeld unit and start the VERIS™ software.

3. From the Select: Recording Settings pull-down menu,
choose one of the EOG S1 or EOG S2 recording sessions
from the Conventional Protocols Ganzfeld Settings.

4. If you have the new LT15 Grass amplifier with remote
control, the gain and filter settings are done automatically by
the VERIS™ EOG software protocol.

Otherwise, manually set the Amplifier gain to 10,000, High
Cutoff filter to 30 Hz and, Low Cutoff filter to .01 Hz.

5.Instruct the patient in his task and explain the general test
procedure.

6. Click on the EOG Plot Tab and select a plot for the eye you
want to record.

7. Press the red Record button.  

If you record both eyes at the same time, you must
hold down the Option key while pressing the Record
button.
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8. Position patient’s head in the opening of the Ganzfeld bowl.

9. Reset the amplifier trace with button on the amplifier(s) or
with computer control.

10. When the patient is ready, click on the Start button at the
bottom of the recording window.

11. Pre-adaptation Phase:

The Ganzfeld is set to the pre-adaptation light level.
Saccades are recorded during pre-adaptation according to the
same schedule as during the following dark and bright
phases. While these data points are generally not used, they
serve for patient practice in preparation for the following
dark and bright phases.

Make sure that the patient moves the eyes only and does not
follow the switching of the LED target with head movements.

Recording schedule:

A computer alert signal prompts the patient to start
tracking the lighted LED target in the Ganzfeld bowl. One
second later the lit target begins to switch right-left, left-right
at 1.5 second intervals for 8 cycles. The response traces to
each saccade cycle are recorded and displayed in the
recording window.

At the bottom of the window, a running average of the
response waveform is shown. In the interval between the end
of a record and the beginning of the next, the operator may
eliminate bad response traces from the record.

This can be done by first clicking on the number of the bad
trace. This marks the trace red. Pressing the delete key on
the keyboard then eliminates the red traces.  The running
average trace below is immediately updated.

12. Dark Phase:

After acquisition of 15 response averages of 6 saccade cycles
each, the Ganzfeld is set to DARK for recording of the next 15
response averages.
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13. Bright Phase:

After acquisition of 15 response averages in darkness, the
Ganzfeld is set to Bright for recording of the last 15 response
averages.

Data Processing

After completion of the recording, the data are automatically
processed and available for inspection in a tabbed window.

1. On the left in the EOG Plot tab, the averaged traces
recorded at one minute intervals are plotted. Beginning and
end of each trace are aligned by subtraction of a straight line
through these points from the entire trace. This eliminates
effects of signal drift during recording and improves the
accuracy of the amplitude measurement.

2. In the Summary plots on the right the saccade amplitudes
are plotted as a function of time measured in minutes from
the start of the dark period. Saccade amplitudes are
automatically estimated as follows: All data points on the
EOG traces between 750 ms and 1500 ms are averaged to
estimate the EOG for the left gaze position and those
between 2250 ms and 3000ms are averaged for the right
gaze position. In the EOG Summary plot the absolute value
of the difference between the two averages is plotted against
time for each trace of the EOG plot.
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3. Elimination of outliers: The critical parameter derived from
the data is the Arden Ratio, i.e., the ratio between the highest
amplitude during the bright phase and the lowest amplitude
during the dark phase.  For its accurate estimation, bad data
points must be eliminated from the record.  Such points are
easily recognized, as they lie far from a smoothed
interpolation line fitted to the data.  The operator may either
delete such points manually or rely on the automatic outlier
deletion procedure provided in VERIS.  

Data points located more than 2 SD from the fitted curve are
considered outliers. They are removed from the fitting
procedure and the fitted curve is recomputed without them.
This procedure is iterated three times. The points and traces
deleted from the line fitting are marked red.

The user may further edit the data. Clicking on a data point
or the corresponding trace number turns both of them red
and eliminates them from the line fitting procedure.  Clicking
on the same data point again restores it and turns point and
trace black again.

4. Below the EOG Summary Plot, the Arden Ratio and the time
to peak measured from the beginning of the bright phase are
given. A normal Arden Ratio is around 1.8 or higher. A
normal time to peak is around 10 minutes.

Changing EOG Parameters
1. From the Select: Recording Settings pull-down menu,

choose the Ganzfeld Settings folder.

2. Switch the Filter files to "Show Ganzfeld Parameter Settings.

3. Select an EOG P1 or EOG P2 test protocol and click OK.



Chapter 6   Ganzfeld Recordings 6 - 13

VERIS™ Science 5.1 Reference Guide

4. Select the Temporal settings button.

In this window you can change:

a.  Sampling rate of the A/D converter
b.  Saccade interval
c.  Number of saccades per record
d.  Interval between records
e.  Number of records during pre-adaptation
f.  Number of records during dark phase
g.  Number of records during bright phase

5. Select the Colors settings button.

In this window you can change:
a. Light levels (RGB values) used for pre-adaptation
b. Light levels (RGB values) used for dark phase
c. Light levels (RGB values) used for bright phase
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6. Click on the EOG Summary Plot

7. With the Summary Plot selected, use the Edit Parameters
button to change:

a. The trace intervals used for estimation of the saccade
amplitudes

b. Criterion in units of (SD) used for outlier detection

c. Number of iterations used in outlier detection

8. After programming new settings, the operator may save
them as a new protocol for future, automated use.
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7 - Menu Reference

In this chapter we review all of the commands available from the
VERIS™ menu bar, which spans the top of the desktop. Each pull-
down menu is presented in a separate section.

When you select a menu title, a list of related menu commands is
displayed for your selection. Depending on the currently active
document window, some menu commands will not be available and
will appear temporarily dimmed.

Some of the VERIS™ Science menu commands are not active in
the VERIS™ Clinic software. These commands will remain
dimmed when using the Clinic program.

The menu bar consists of the VERIS™ program menus and the
operating system menus. Consult your computer manual if you are
not familiar with the Mac OS menus.

Veris™ Menu

The Veris™ (Application) menu provides commands that affect
the VERIS™ application. Commands are used to:

• View the version number of  Veris™ being run.

• Control the visibility of all open applications.

• Quit the Veris™ application..

Veris:  About Veris™ Science

This command displays the program's "splash screen" and version
number. When contacting EDI technical support it is important
that you tell us the version you are using.

Veris:  Hide Veris         (Command Key Shortcut:  ⌘ H)

This command temporarily hides all Veris™ view windows while
keeping the Veris™ application running. All other programs that
are running remain visible.
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(To make Veris™ again visible, select the Show All command
from another application's similar menu, or select the Veris™
icon from the Mac's desktop dock.)

Veris:  Hide Others         (option) ⌘ Q)

This command temporarily hides all other running programs so that
only Veris™ windows are visible. The other programs continue to
run in the background.

Veris:  Show All

This command returns the visibility of all running programs. Select
one of the Veris™ windows to make Veris™ the active application
with its menus visible on the top menu bar.

Veris:  Quit Veris          (Command Key Shortcut:  ⌘ Q)

Use this command to shut down the Veris™ application. If
open documents have not been saved since they were last modified,
(other than Analysis setting changes) the program will ask you
whether you want to save any changes to each one before quitting.

The "Don't Save" option quits the program and reverts the
document to its last saved version.

File Menu

The File menu provides access to commands that affect the
management of VERIS™ documents. File menu commands are
used to:

• Create, Open, Close and Save VERIS™ documents.

• Export numerical data to other applications for additional
processing.

• Export pictorial data for analysis, presentation or publication.

• Set up the printer.

• Preview and Print all document window views.
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File:  New Combination

When you select New Combination, an "untitled" Combination
document is opened. Since this is a new document, no data
documents are yet listed. The Add Doc button is used to enter
data documents to the list.

Combination documents only store the file names and
instructions on how to combine the files. The recorded data
remains stored in the individual data documents, unaltered by
actions taken in the Combination document.

Combination files are useful in studying the results of multiple
recording sessions from a single subject or group of subjects.
Combination files are used to create reference normals data files.

File:  Open...                (Command Key Shortcut:  ⌘ O)

When you select the OPEN command, the Open File dialog box
appears. After selecting a folder from the pull-down menu, you
can filter which files types can be opened from by choosing one of
the radio buttons at the bottom.
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All data documents contained within the folder shown on the
pull-down menu are visible for selection. Selecting one opens the
appropriate data document.

With the radio button and check box selected, all data
documents are again visible for selection. However, selecting one
opens a new untitled setup document.

The new untitled setup document contains all the Subject and
Recording Settings as in the original data document.

You can save a recording protocol for a particular subject prior to
recording using File: Save Data As... All such Setup data files
within the folder will be visible for selection.

All recording settings files contained within the folder are
visible for selection. However, selecting one opens a new untitled
setup document.

The new untitled setup document contains all the Recording
Settings from the file (but no Subject data).

All combination documents contained within the folder are
visible for selection. When selected, the appropriate combination
document is opened.

Only combination documents for which Normals have been
calculated are visible for selection. When selected, the appropriate
Normals document is opened.

All analysis settings files within the folder are visible for
selection. Selecting one opens a new untitled window containing
the selected Analysis protocol. Data files opened into this window
will have the selected protocol applied.
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File:  Apply

Use Apply Settings from Window to take Analysis Settings
from another open data file window and apply them to the
currently active document window.

Use Apply Subject Settings to use Subject data from another
data file in the currently open setup file.

To Apply Recording and Analysis Settings (saved as files) to an
open document window, use the Recording Settings and Analysis
Settings pull-down menus described later.

File:  Close                                           (Shortcut:  ⌘ W)

Selecting the Close  command closes the currently active
document window but the Veris™ program continues to run.

For a data document, any changes made in an Analysis view,
(changes in analysis settings) will be lost unless you specifically
use the File: Save As: command.

Previous versions of the program would put up a warning
if you tried to close the document window when any
changes were made to the Analysis Settings. This warning
has been eliminated since in most cases users didn't want to
change the protocol and found this prompt annoying.

For setup, combination, or data documents, if changes other
than analysis settings have been made, a dialog box will ask if you
want to save those changes before closing.
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File:  Save                                            (Shortcut:  ⌘  S)

When working with a data document select the Save command
to save changes made to the Subject settings.

With a setup or combination document, select the Save
command to preserve any changes made to the file.

The Save command will appear dimmed unless the active
document has never been saved, or you have made changes since
the document was last saved.

File:  Save As

Select the Save As commands to create new documents or
settings files without changing the original documents or
settings files.

Use the Save Data As... command to save a copy of the
document with a new file name.

NOTE: When working with a setup document, this command
becomes "Save Subject Setup As..." to save a copy of the
subject information.

Use the Save Recording Settings As... command to create a
template for creating new setup documents.

Use the Save Analysis Settings As... command to preserve an
analysis protocol which can be applied to data and combination
documents.
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Recording Settings and Analysis Settings files must be
saved inside the "Recording Settings" and "Analysis
Settings" folders respectively, in order to be accessible
from the pull-down menus. These folders are located with
the other program files.

File:  Revert

Select the Revert command to revert your document to the last
saved version. This is useful if you've made some changes and
decide they are not necessary or desired.

When you select the Revert command, a dialog box asks if it is
OK to discard changes made to the current version. If you click
OK your document reappears in its previous form.

File:  Import:  Import Stimulus...

Use Import Stimulus to load pattern stimulus pictures provided
by EDI and custom stimulus pictures into the Setup document.
Selecting the Import Stimulus command brings up the "Choose a
picture file" dialog box from which you navigate to the
appropriate folder and files.
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Ongoing use of a particular pattern or custom stimulus picture
can be expedited by saving the custom picture in a Recording
Settings file. Future setup documents based on this Recording
Settings file will include the picture.

File:  Import:  Import Raw Data...
This command imports a binary file containing the entire raw
data string directly read from the subject. Usually this raw data
set has first been exported for additional processing by a special
program written by the user who then wants to use the display
facilities of VERIS to look at it.

Choosing this command opens a dialog for selecting a file
containing time sequential raw data.  Data in this format can
not be read by programs such as EXCEL.

File:  Export:  Export Stimulus...

The Export Stimulus command allows you to export the
stimulus picture of the currently active Setup or Data document
for use or editing with other applications.

Selecting the Export Stimulus command opens the Save dialog
box. After providing a file name, the stimulus is saved as a
SimpleText picture. It can be opened as a PICT file by many
applications.
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The Export Stimulus command is not active when working with
data documents recorded in earlier versions of VERIS. Older
documents do not include the necessary information.

File:  Export:  Export Processed Data...

The Export Processed Data command exports the numerical
data from the Traces, Averages, or 3D Plot. For analysis views
with multiple plots, this command will export all data in
that view.

Processed data is exported in ASCII format as a matrix, with
columns separated by tabs and rows separated by carriage
returns. This format can read by other applications such as The
MathWorks, Inc.'s MATLAB® and Microsoft® Excel.

All exported files have descriptive headers. The first character of
each line is a "%". Data is exported in the order it appears in
the VERIS™ analysis view, from top left to bottom right.

The top left element is the first element exported. The second
element in the top row is the next exported element. The bottom
right element is the last exported element.

Exporting Traces

With the Traces view active, choosing Export Processed Data
will export the individual traces. The Save dialog box appears, and
after providing a file name, the traces are exported as an ASCII
file.
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The descriptive header will note the program version, file name,
and unit of measurement. Each trace is exported as a row of data
in the matrix. (If the stimulus picture has 103 elements, there will
be 103 rows of exported data.)

The first column in each row contains the element number itself
(starting with #1).

Each of the following columns in a row contains the actual trace
information for one sample. (With a Frame Rate of 75 Hz or 13.3
msec / frame, over an epoch length of 80 msec., 16 samples per
frame, there will be 97 samples from 0 to 80 msec.)

Exporting Averages

With the Averages view active, choosing Export Processed
Data will export the group averages. The Save dialog box appears,
and after providing a file name, the averages are exported as an
ASCII file.

The descriptive header will show the type of Averages
(Normalized, Response Density Squared or Sum of Groups).

Each group average is exported as a row of data in the matrix. (If
there are 6 group averages, then the exported data matrix will
have 6 rows.)

The first column in each row contains the number of the group
itself (starting with #1). The following columns in a row each
contain the average value for one sample, starting with the first
sample.

Exporting Plot Densities

With a 3D Plot view selected and either the “Patient Data
Only” or “Reference Data Only” chosen as Source in the 3D
Plot Parameters dialog, choosing Export Processed Data
exports the density values. After providing a file name in the
Save dialog box the densities are exported.

The density values are exported in a 2 by N matrix where N is the
number of elements.

The first column contains the element number itself (starting
with #1). The second column contains the corresponding
amplitude (density).

You can verify these numbers by selecting “Numeric View” in the
3D Plot Parameters dialog.
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Exporting Patient and Reference Differences

With the “Patient and Reference Difference” 3D Plot
selected, and depending on the Analysis protocol applied,
choosing Export Processed Data exports one of two sets of
values.

It either exports the amplitude difference measured in
Standard Deviations from the reference file, or the
numeric difference between the patient and reference file
(absolute difference). You can verify which values are exported
by checking the unit of measure listed.

The difference values are exported in a 2 by N matrix where N is
the number of elements.

The first column contains the element number. The second
column contains the corresponding difference either in standard
deviations or as an absolute number.

File:  Export: Export PICT...

The Export PICT command allows you to export the plot area of
the currently active analysis view for publication or use in other
graphical applications.

Selecting the Export PICT command opens the Export Image
As... dialog box. From the pull-down menu you can choose one of
many graphics file formats. Depending on the format chosen, the
Options button may allow you to select different levels of
compression and color depth for your image.

After providing a file name, the plot is saved and can be opened as
a graphics file by many applications, depending on the file format
selected.
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File:  Export: Export Stimulus Info...

This command exports a table showing the associated solid angle
and scan delay for each element in the stimulus picture.

File:  Export: Export Marks...

With the Averages view active and the Mark Extrema button
selected, choosing Export Marks will export each group average’s
latency values in ASCII format.

Each group’s latency values are exported as a row of data in the
matrix. The columns in a row alternatively contain the latency
timing of the mark in msec, and the amplitude for that mark in
nV/deg^2 for each mark from left to right.

File:  Export: Export Raw Data...

This command exports a binary file which contains the entire
raw data string directly read from the subject. This raw data set
is usually exported for additional processing by a special program
written by the user who then wants to use the display facilities of
VERIS to look at it.

Choosing this command opens the SAVE dialog box. After
providing a file name, the data are saved in a binary file which
requires a special program to open. Data in this format cannot
be read by programs such as EXCEL.
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File:  Switch to Clinic

VERIS Science contains, as a sub-module program, VERIS
Clinic. By selecting this command, all further files opened will
contain the more simple "Clinic" interface. Many options
available under VERIS Science are locked or are not viewable
with the Clinic program.

The File Menu in VERIS Clinic will have a command to “Switch
to Science”. To return to VERIS Science, simply select this
command. All further files opened will use the Science interface.

File:  Page Setup...

The Page Setup command gives you access to your printer's
options for paper size, page orientation, scaling, and more
(depending on your particular printer's features).
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VERIS 5.1 now automatically adjusts the scale of the
printed view to fit the page. Scale should therefore always
be left at 100%.  

In the Page Setup dialog box, choose the printer you will print the
document on from the "Format for" pull-down menu. Then choose
from the options available. (Your Page Setup may differ from that
shown, depending on printer and driver software.)

The Page Setup dialog box shows the operations for the currently
selected printer and driver. Pull down menus provide access to
additional printer options, and permit you to select from the
supported paper sizes for that printer.

Clicking an Orientation button selects portrait or landscape mode.
In portrait mode, the current date and program version are
printed on top of each page and Subject and Experiment
information are printed at the bottom of each page.

In landscape mode, only the current date and program version are
printed on the top of each page.

Select Summary from the "Settings" pull-down menu to see all
the Page Attributes (paper size, margins, orientation, etc.). You'll
see additional options for controlling the appearance of your
document in the Print dialog when you print.

For more information about print operations select the Question
mark icon in the Page Setup and Print dialog boxes

File:  Print Preview

The Print Preview command accurately shows how the selected
tabbed view will appear when printed, using the existing settings.
You can then use Page Setup to alter paper size, orientation, etc.

If you save the analysis setting, the Page Setup for this tabbed
window will be saved and the view will print correctly for your
printer until you change it. This does not affect any other tabbed
views. You can do a similar setup for each tabbed view, which will
also be saved as part of the analysis settings.
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File:  Print...                                         (Shortcut:  ⌘ P)

The Print command is used to print the currently active tabbed
view.

The Print dialog box exhibits printing options available for the
selected Printer. The pull-down menu provides access to other
printing options available for the selected printer.

To see a list of selected options, choose Summary from the pull-
down menu.

The PDF option creates a copy of the tabbed view in the
computer-independent Adobe® PDF file format and can be viewed
with Adobe's free software, Adobe® Reader®.

Edit Menu
The edit menu provides commands that can correct data entry,
change digital filter settings, and modify or create new analysis
and recording protocols. Edit menu commands are used for:

• Normal text editing commands, (Cut, Copy, Paste, Clear and
Select All.)

• Context-sensitive Undo-Redo, allowing immediate switching
back and forth to observe "before" and "after" effects of
many VERIS™ operations.

• Adding new tabbed views and modifying existing ones.

• Changing the digital filter settings
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Edit:  Undo (Action)                             (Shortcut:  ⌘ Z)

Most of the actions you do in VERIS™ can be undone. Changes
made in the various dialog boxes can be undone with the Cancel
button prior to leaving the dialog box. They can also be undone
using the Undo command immediately after exiting the dialog
box.

Actions such as parameter editing or changing data filters
settings can be canceled by selecting the Undo command
immediately after choosing the action. The Edit menu Undo
command changes to reflect the action you can undo.

Edit:  Redo (Action)                             (Shortcut:  ⌘ Z)

The Redo command allows you to immediately undo your Undo
command! This is very helpful for switching back and forth
between two different parameter settings.

Each time you select the Undo command but before you take any
other action the Redo command will be available in the Edit menu.

Edit:  Cut                                              (Shortcut:  ⌘ X)

Your computer has a temporary "clipboard", designed to hold one
item at a time. It enables you to Cut or Copy elements from one
view or document, and Paste those elements into another
location or document.

The Cut  command removes the selection that has been
highlighted. Although the item disappears from the screen, a copy
remains on the Clipboard until replaced.
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Edit:  Copy (Plot)                               (Shortcut:  ⌘ C)

The Copy command copies the selected item onto the computer's
Clipboard but doesn't delete it.

When you are working with an analysis view, the Copy command
changes to Copy Plot so that you can copy the plot (and its
controls) to another tabbed view.

Edit:  Paste (Plot)                               (Shortcut:  ⌘ V)

The Paste command inserts the contents of the Clipboard onto
your window view. If pasting text, the text will appear at the
location of your text cursor.

It changes to Paste Plot in a tabbed view so that you can paste
the plot (and its controls) into that view. To adjust location of the
pasted plot, hold down the Command (⌘) key, select and drag the
plot

Edit:  Clear (Plot)

The Clear and Clear Plot (if you have a plot selected) commands
erase the selection from your document similar to the Delete key.

Clear Plot cannot be undone.

Edit:  Select Plot

The Select Plot command is only activated when you have
more than one plot in an analysis window. A submenu lists
the plots by layer number so that they can be selected for further
editing.

When a plot is added to an analysis window it is inserted on
the top layer as Plot 1. As new plots are added the first plot is
moved lower and its plot number gets higher.
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Edit:  Select All  (Unselect Plot)      (Shortcut:  ⌘ A)

The Select All command highlights all text in a parameter field or
in the comments box. Just place the cursor and choose Select All
to highlight all text.

With a Plot selected, this command changes to Unselect Plot.

Edit:  Edit Filters...

Selecting the Edit Filters… command opens the Edit Filters
dialog containing a series of digital filters. These global filters
affect each of the analysis views.

Each of these filters is activated by clicking the checkbox
associated with it and then adjusting the values.

A description of the Artifact Removal filter can be found in
Chapter 4, under “Improving Signal to Noise.” This filter replaces
noisy individual responses by substituting reliable alternative
data.

Descriptions of the other digital filters, Power Line, Band
Reject, Low and High Pass, can be found in Chapter 2, under
“Digital Filtering.”
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Edit:  Add Text...

Edit Text
        dialog box

The Add Text command inserts text into a tabbed analysis view.
Selecting this command opens the Edit Text dialog. It works like a
mini word processor, allowing you to add titles to the analysis
tabbed views and do limited formatting.

When you have entered the text and selected the size, style, color
and font name, click OK. The text will be inserted into the tabbed
view. To re-locate text, hold down the Command key (⌘), mouse-
click to select and drag the text.

To modify text already inserted,, hold down the Command key and
double click on the text to open the Edit Text dialog. Change or
delete the text and then click o.k.

The Add Text command is only active if the Freeze
checkbox in the Edit Tab dialog is not checked.

To access the Edit Tab dialog, double-click on the tab you
want to edit.
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Edit:  Add Tab

The Add Tab command creates a new tabbed analysis window.
The type of plot included in the new window depends on your
submenu selection.

You can also create an Empty Plot window into which you can
paste plots to create your own custom view.

Edit:  Add Plot to Tab

The Add Plot to Tab command pastes a new plot into the
currently active tabbed analysis window. The type of plot depends
on your submenu selection.

This plot is inserted onto the top layer as Plot 1 .  As
additional plots are added the first plot is moved further down. Its
plot number gets higher.

The Add Plot to Tab command can also paste a Picture into
the currently active analysis window. If you have attached
pictures to the “pads” in the Subject tab you may select one of
the three pictures in the Picture submenu.

     

Selecting Picture File opens the “Choose a picture file” dialog
box from which you can select the picture you want pasted.
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One of the primary benefits of layering pictures with plots is to
compare anatomy with function. The details for adding pictures to
tabbed views can be found in Chapter 4, “Looking at Your Data”
under “Creating Your Own Tabbed Views.”

Edit:  Add Picture to Tab

The Add Picture to Tab command pastes pictures into the
Subject tabbed view. There are three Subject Picture “pads”
available for pictures.

After the first picture is pasted into the Subject tab, all three
picture “placeholder” tabs become visible in a new “Pictures”
section below the Stimulus Preview.

The Add Picture to Tab command is only active when the
Subject tab is active.
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Pictures pasted into the Subject tab remain with the data file.

When used with an Analysis protocol that utilizes them, these
pictures will automatically show up in the analysis tabbed
windows for this data set.

Edit:  Delete Picture

The Delete Picture command removes pictures that have been
pasted into the Subject tabbed view. This command is only
available if the Subject tab is active.

Edit:  Move Plot Back

Edit:  Move Plot to Back   

Edit:  Move Plot Forward   

Edit:  Move Plot to Front   

These four commands are only active when the active
tabbed analysis window has multiple plots. They are used to
control the “layer” of each plot and its relationship and visibility
with respect to the other plots

You must first select one of the plots, either using the Select
Plot command or by mouse clicking on the plot.

The Move Plot Back command moves the selected plot back one
layer, exchanging position with that behind it. (Plot 1 becomes
Plot 2 - and Plot 2 becomes Plot 1.)

The Move Plot To Back command moves the selected plot to
the very back or bottom layer with the highest layer number. All
other plots move up one layer.

The Move Plot Forward command moves the selected plot
forward one layer. (Plot 2 now becomes Plot 1 - and Plot 1
becomes Plot 2.)

The Move Plot To Front command makes the selected plot Plot
1. All other plots move back one layer.
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Select Menu
The Select menu is new to Version 5.1 and combines functions of
three menus in previous versions.

Select Menu commands are used to:

• Apply or change Analysis protocols for a set of data.

• Introduce a second data file or normals Reference file for
comparison to the active data file.

• Select a Recording protocol whose settings can be used or
modified for recording a new set of data.

• Create a new setup document using the settings of a just
recorded session, or the settings of an open data file.

Analysis Settings...
VERIS™ comes installed with a set of protocols in the Analysis
Settings folder that can be used as-is or modified to suit your
requirements.

Selecting the Analysis Settings... command opens the Select
Analysis Settings dialog.

The included protocols are grouped in sub-folders based on the
type of recording, number of areas stimulated, etc. Many of the
protocols, when highlighted, will show additional information in the
Comments and Info areas of the dialog box.

For easier selection you can sort the protocols using the Arrange
files option. Files can be sorted in Finder order (inside their
subfolders), in Filename order (alphabetically), or by date created
(oldest or latest first).
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Selecting a file applies its analysis protocol to the active data
document window. All views in that window will be changed to
incorporate the new parameters

Remove Analysis Settings
Use this command to strip a data file of its currently associated
analysis protocol.

Selecting a new Analysis Settings protocol will also remove the
current analysis protocol. However, there may be times when you
simply want to remove an analysis settings protocol so that it no
longer is associated with a data file when that data file is opened.

Reference

VERIS™ comes installed with sample normal reference files for
several different stimulus picture resolutions in the Normal Files
folder.

Use the Reference command to select a Normals file or
another data file, recorded under similar conditions, to compare
with the active data document.

Veris filters out files with dissimilar recording parameters from
the active data file. Only files with similar recording parameters
will be available for selection in the dialog boxes.

Reference: Normals...

We strongly advise you to create your own reference
Normals for use with your recordings as described in
Chapter 5, under "Creating Reference Data.

Selecting this option opens the Select Normal Reference File
dialog.
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Reference: Choose data file...

Selecting this option opens the Choose a Veris data file dialog
from which you can choose another data file.

Reference: Remove Normal Reference
Reference: Remove File Reference

Use these options for removing an applied reference file.

When a Normals or data file has been applied as reference to the
current data file a check mark will appear in the Reference
submenu to remind you.
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Recording Settings...

VERIS™ comes installed with a series of recording protocols in
the Recording Settings folder.

Selecting the Recording Settings... command opens the Select
Recording Settings File dialog. From this dialog you can select one
of the recording protocols according to your needs.

Recording Protocols are grouped in sub-folders under
Conventional, Multifocal and Color Microdisplay.

Conventional Protocols include PERG (Pattern ERG) and
PVEP (Pattern VEP) for both Color and Monochrome Monitors.
Also included are the Ganzfeld protocols for use with EDI's
Ganzfeld stimulator.

Unlike other recording protocols, Ganzfeld Settings include both
the recording settings and the individual test parameters. To
change individual Ganzfeld test parameters, first select the "Show
Ganzfeld Parameter filter and then select the test to edit.
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Multifocal Protocols include both mfERG (multifocal ERG) and
mfVEP (multifocal VEP). Separate protocls are provided for color
and monochrome monitors.

The mfERG protocols are further grouped under mfERG B-A for
contact lens electrodes (30 second recording segments) and
mfERG DTL for fiber electrodes where blinking needs to be
suppressed (15 second recording segments).

Additionally, the mfERG recording protocols are grouped for use
with dilated pupil or natural pupil (which provides the
appropriate luminance settings.

The individual protocol names include the number of patches in
the stimulus picture, recording length, and luminance level in
cd/m^2,

Color Microdisplay Protocols for both Conventional and
Multifocal Recordings are provided under a separate grouping
since the Color setup is very different.

Selecting one of the provided protocols opens a new "untitled"
Setup document with the appropriate Recording settings inserted.
You can add subject information and then click Record to start a
recording.

Longer recording times give better signal-to-noise ratio but
require more patience from the subject. Fewer hexagons give
better signal-to-noise ratio but sacrifice spatial resolution.

The optimal spatial resolution depends on the suspected size of a
patient's abnormality. If a small scotoma is suspected, 241
hexagons is a good choice, etc.

The dilated pupil option is preferred as the luminance on the
retina is more constant and reproducible. It is also much easier to
get a fundus image with a dilated pupil.

To access Recording Settings, Analysis Settings, and Normal
Files from the Veris program, these files must be located inside
their appropriate folder and located within the Veris program
folder.

Reuse Recording Settings

This shortcut command can save you a lot of time.

Selecting “Reuse Recording Settings” opens a new “untitled”
setup document for recording with the same parameters and
subject information as the currently active document or just
completed recording session.
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Parameters Menu
The Parameters menu provides access to dialog boxes and
controls that affect the entire document.

Parameters Menu commands are used to:

• Customize the titles for Subject Parameters and override
certain Setup Information.

• Select unique display colors for Subject, Normals and File
Reference data.

• Switch between retinal and field view for all analysis tabbed
views in the open document window.

 • With Combination files, this menu provides alternative ways
of combining and viewing the data.

The Change Subject Titles and Override Setup Info
commands are only active when the Subject view is active in the
document window.

Parameters:  Change Subject Titles…

The Change Subject Titles command is used to change the field
names, and add or delete fields used in the Subject Parameters
dialog box. Selecting the command first brings up a warning about
changing titles.

If you select the Proceed button, the Change Subject Titles
dialog box appears containing 16 pull-down Title menus.
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If you are working with an existing data set some of the data
fields may not be empty. Titles for those fields cannot be
accessed or changed unless the data is first removed.

To change an existing title, pull down its title menu to reveal the
possible choices. The current title will appear at the bottom
designated with a black dot.

Each title choice in the pull-down menu has an appropriate data
format already selected. If you select "Custom Title", you must
select a data format using the dialog box that appears.

If a Subject title has "No Title" in its pull-down menu, that field
will not appear in the Subject section of the document. If these
non-appearing fields are at the bottom of the dialog box, the
Subject section will be appropriately re-sized.

If you would like your title changes included in other recording
protocols, use the "Other" button on the bottom of the Change
Subject Titles dialog box to select and alter additional Recording
Settings files.

Parameters:  Override Setup Info…

The Override Setup Info is used to correct mistakes made in
the setup information originally. You can change subject to screen
distance, the active scanned area of the stimulus monitor,
external amplifier settings, and type of external camera or
monitoring devices that is attached.

Selecting the Override Setup Info command first brings up a
warning about changing the values.

If you select the Proceed button, the Override Setup Information
dialog box appears.
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The Screen section's values are the distance from the subject's
eye to the stimulus monitor, and the height and width of the
active scanned area (not the total glass area) of the display, all
measured in centimeters.

The values for Subject distance, Screen Height and Width are
used in the density plots (2D), to draw rings designating
eccentricity in 5 degree intervals.

The External Amplifier section contains settings related to
electrode amplification. If your Veris system is connected to the
serial port Grass Amplifier these settings will automatically
control your amplifier. If not, you will need to manually set your
amplifier controls.

The Gain setting is used to construct the amplitude scales and
convert to amplitude densities. If not specified correctly, the
scaling of responses will be wrong.

If you manually set your amplifier controls, the Low Cutoff,
High Cutoff and Notch Filter settings are for informational
purposes only and do not affect processing of the data.

If the Eye or Fundus Camera was used during the
recording make sure that it is selected (designated with a
black dot) in the Pull-Down menu.

EDI’s Camera/Refractor unit optically rotates the image of the
stimulus array by 180 degrees. This selection rotates the
response array by 180 degrees so that the processed data set is
correctly oriented.
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If the electrode polarity was reversed when the active data set
was recorded, check the Invert Data box. This control will correct
the data and all plots will be oriented correctly.

The "default" for exiting the Override Setup Information dialog is
"Cancel" since these settings should only be changed if you are
certain of the correct values.

Parameters:  Change Subject Color…
Parameters:  Change Normals Color…
Parameters:  Change File Reference Color…

Change Normals Color and Change File Reference Color...
are only active when a Normals reference or File Reference has
been selected.

With Veris 5.1 you can now compare subject data to both a
Normals reference file and another data file used for reference.

Use the three commands, "Change Subject Color…," "Change
Normal Color…" and "Change File Reference Color..." to
select the colors that the analysis plots will use to distinguish
reference data from your current subject data.  

A Colors dialog opens. There are color pickers available on the
top of the dialog box. You can choose from a color wheel, color
sliders, color palettes, image palettes, and crayons.
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Parameters:  Change to Retinal / Field View

Use the "Change to Retinal (Field) View" command to change
all tabbed analysis views in the active data document window to
the alternative orientation.

The field view is as if your eye were projecting onto the screen.
It is the same view as a perimetry field. The retinal view is as if
you were standing looking through the subject’s pupil at the
retinal surface.

Each tabbed view will also display "Field View" or "Retinal View"
to designate the type of orientation selected.

Parameters:  Reflect Eye as Needed

When comparing subject responses to a reference set where both
are displayed in the same window, the orientation of the displayed
eyes is important.

With an ERG recording, in order to compare left and right eyes
you want to compare the two eyes reflected in the same nasal
temporal direction. For the VEP you want to compare them
unreflected.

With this command checked the program automatically
compensates for eye orientation, reflecting the reference eye as
needed.

Parameters:  Combine Left Eyes Only
Parameters:  Combine Right Eyes Only
Parameters:  Combine Both Eyes
Parameters:  Combine Both Eyes As Left Eyes

These four commands become active when working with
Combination files. As discussed in Chapter 5, “Working with the
Data” under Combining Data Documents, you can selectively
choose which file combinations you want to view.

Select “Combine Left Eyes Only” and only files recorded from
left eyes will be included in the tabbed analysis views. Similarly
you can view only the right eyes using the “Combine Right
Eyes Only command.

“Combine Both Eyes” is useful for VEP recordings where you
don’t reflect. It simply combines all eyes.

When combining a “mixed” set of files, VERIS™ uses “Combine
Both Eyes as Left Eyes” as default, flipping the right eyes to
look like left eyes and then combining them all.
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Calibration Menu
The Calibration menu contains commands for calibrating the
Stimulus luminance for each type VERIS™ stimulator. These
commands are used in conjunction with the VERIS™ Luminance
calibrator. Details for calibrating each stimulator are found
in Appendix A, under “System Calibration."

Calibration: CRT AutoCalibration

Holding down the option key when selecting this command opens
the Dark Current Calibration. This procedure is used when first
installing the calibrator and each time your software is upgraded.

Selecting CRT AutoCalibration opens a dialog box for Stimulus
monitor calibration. For monochrome monitors a single curve is
generated, - for color monitors, three curves.
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Calibration: Microdisplay AutoCalibration

Functionally similar to the CRT calibration, selecting
Microdisplay Autocalibration opens a similar dialog box.

As with the CRT, you must first do a Dark Current Calibration
when installing the calibrator and each time the software is
upgraded.

  

Calibration: Ganzfeld Calibration

The VERIS™ Auto-calibration photodiode is built into the
Ganzfeld device. Selecting Ganzfeld Calibration opens a dialog
box for calibrating the device. There are six curves (RGB for both
the flash and background luminance).

No Dark Current Calibration is necessary with the built-in device.

Window Menu
With VERIS™ you can have many data document windows open
at the same time, each with their own set of tabbed analysis
views. The only limit on the number of open windows is the
amount of computer memory available.

Use the Window pull-down menu to select and switch to any
open VERIS™ document window. A check mark designates the
"active" document window.
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8 - Advanced Topics

Response Synthesis (only available in VERIS™ PRO)

Introduction
One of the many important advantages of VERIS™ over other,
simpler systems for multifocal electrophysiology is that VERIS™
can separate and extract all the significant self-kernel slices
generated by the highly nonlinear ERG and VEP responses. Such
clear separation requires the use of binary m-sequences.

In addition, the sequence used for a particular test has to be long
enough and chosen correctly. Clearly, longer m-sequences provide a
more intricate encoding of the response properties and are,
therefore, needed when dealing with highly nonlinear systems. The
required length depends on many factors, such as rate of
stimulation, adaptation level, stimulus brightness and contrast.
Out of all possible m-sequences of a given length, VERIS™ will
choose the one that provides the cleanest separation of the
significant response components.

In addition to the above advantages of kernel separation, the
possibility to extract all the binary kernel slices from the
same record offers important opportunities.  In principle, it is
possible to derive from the kernel series the response to any
stimulation sequence that occurred during the test. The transition
from the kernel series to actual response sequences can be
extremely helpful in understanding the nonlinear response
properties.

We have found that most VERIS™ users don’t have an intuitive
understanding of the description of nonlinear behavior by means of
kernels. However, almost everyone will immediately grasp the
nature of such effects when illustrated by the response waveform in
the presence and absence of preceding responses.

When dealing with a single input experiment, the extraction of
responses to specific stimulation sequences from a record obtained
with random or pseudorandom stimulation is easily accomplished.
One might simply find all occurrences of the desired stimulus
sequences and average the corresponding responses. Of course, one
would have to make sure that the responses of interest are not
affected by the tails of preceding responses.

However, when we are testing systems with more than one input,
such as in multifocal electrophysiology, this approach no longer
works. The focal responses to specific stimulus sequences now
always occur superimposed on responses generated by other
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stimulus patches.  In this case, the separation of focal responses
contribution is only possible by way of the kernel series. We must
first isolate the response contribution from a single input by means
of the kernels and then synthesize the desired response sequences
from them.

How this is accomplished by means of simple addition and
subtraction of the dominant kernel slices has been described
elsewhere. (Sutter, E. E. (2000) "The interpretation of multifocal
binary kernels," Documenta Ophthalmologica 100:49-75, and
Sutter, E. E. (2001) "Imaging visual function with the multifocal
m-sequence technique," Vision Research 41:1241-1255.)

In VERIS™ Pro, the response synthesis has been implemented for
easy derivation of responses to arbitrary stimulation sequences.
Below is a description of this research tool and its uses. Some
familiarity with the above mentioned publications would be helpful.

Response Synthesis is a powerful tool for predicting the
response to flash sequences that occurred during
stimulation. It is the transformation of the kernel series into
sequences of responses (a series of single and multi-flash
experiments.) Response Synthesis can give a much more intuitive
appreciation for what the kernels mean and a better understanding
of what nonlinearities mean in physiological terms, allowing you to
draw conclusions about mechanisms such as feedback in the retina,
etc.

In a nonlinear system a response depends on its context. So we
are really dealing with a context-dependent response. In a linear
system the contribution of a stimulus is always the same
regardless of the context in which the stimulus is presented.

When you have a context-dependent response you can’t really
predict what the response is going to be unless you have tested that
system in all possible contexts. Now you can’t really do this, but
you can test the system in a lot of different contexts. With a
binary stimulus, the way we are using it, we are testing the
system with all possible configurations.

So the way to study such a system is to look at responses in all
different contexts, which has a very intuitive appeal. If you have a
double flash or if you have a preceding flash then the flash response
will be different. This is not the way we normally get data with the
multifocal scheme. We cannot extract local response sequences.
What we get instead is a representation of this context-dependency
in the form of a series of kernels.

We cannot separate the focal responses directly. We have to do it
by the detour of kernels. But from these kernels we can then
“synthesize” or predict what the response to a certain sequence of
flashes would be. We can only precisely predict the response to
flash sequences that actually occurred during stimulation.
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For example, if you record at a frame rate of 75 Hz., every 13.3
msec. you get (or you don’t get) a flash. You only have flash
sequences where the flashes can occur on a grid with a grid spacing
of 13.3 msec.

You could do this in principal by going through the whole flash
sequence and selecting those that you are interested in. Let’s say
you want to know how the system responds to 3 flashes in a row.
You can average all the 3 flash occurrences together, but the
flashes that happened before and those that happened afterward
are going to affect what you see. So what you really would like to
synthesize is 3 flashes with nothing happening before and nothing
happening afterwards.

And nothing is a very strange word here. If you go far enough back,
it doesn’t really matter whether something occurred there or not.
But how far back do you have to go? You can determine this by
looking at the kernels. So the detour by the kernels allows you to
evaluate how far back you have to go.

Step By Step Instructions
A. Form Groups whose responses you want to predict.

We can do synthesis on groups of traces, but not on many groups
because the amount of memory needed would be prohibitive. We will
form a mid-periphery group and a periphery group, ignoring the
central area of 7 traces which are often too noisy.

1 Open the “Synthesis” data file from the Sample Data Files
folder (or another appropriate data file).

2 Select the Custom Averages tab from the Default Analysis
Settings.

Make sure that no normal reference file is selected, as this
would limit the kernel slices that can be selected to those included
in the reference data.

Make sure that no filtering has been activated by the
Analysis protocol. Doing filtering is dangerous as you can lose
kernel slices. It is best not to use any filtering.

Turn Artifact Removal OFF. Artifact Removal could be
used only if all the kernel slices that will be used for the
synthesis are included. Since we don't yet know what these
are, it is better not to use Artifact Removal.

3 Choose the “Edit Groups” button or click on the Grouping
graphic, and first select “Clear All Groups”.

4 Select "New Group" and, ignoring the central 7 traces,
option-click on one of the next hexagons to “speed-select” the
entire ring to which this hexagon belongs as part of Group 1.



8 - 4 Chapter 8  Advanced Topics

VERIS™ Science 5.1 Reference Guide

5 Moving away from center, option-click on an adjacent non-
selected hexagon to add the next grouping to Group 1.

6 Finally, again select "New Group" and option-click on each
of the outer two adjacent hexagons to add these periphery
rings as Group 2 and click OK.

B. Activate Synthesize Responses and select the appropriate
kernels.

1 Click on the Grouped Average traces and select the “Edit
Parameters button.”

2 Check the “Synthesize Responses” box in the Averages
Parameters dialog to activate the Synthesis function.

Selecting the “Synthesize Responses” checkbox opens a new
Synthesis window below with tools for selecting the self-
kernel slices that you want to include in the synthesis.

You then scan through all the kernels by looking at the
traces until you find them disappearing in the noise. You
should include only as much epoch length as is needed.
Including too much will add noise to the data.

3 By default, the first order kernel has already been included
and you see the waveforms of the two groups displayed.

Using the Epoch controls in the Synthesis window, increase
the Epoch End for the first order kernel so that it
encompasses all the induced components visible on the
traces. You may use the Scaling controls to scale the traces
horizontally or vertically to permit easier inspection.

In examining these traces there appears to be mainly noise
beyond about 100 ms.

4 Change the Epoch End to 100 and click the Modify button
to select the first order kernel with an Epoch length of 0 to
100 ms.
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5 Using the Kernel Slice control in the Synthesis window,
select the 1st slice of the second order kernel.

As you pick each response sequence you want from the
Kernel Slice menu, the corresponding trace appears in the
lower right. Adjust the Epoch Length as necessary to
encompass all induced components and click the Include
button. The new Kernel Slice is added to the list on the lower
left.

In determining how much epoch length to include, as you move
consecutively adding tick marks to the left, you should subtract
the time interval between the first tick mark at 0 and the last
tick mark.

In our example the frame rate is 75 Hz, and the base
interval is 13.3 msec. So with each move to the left we need
to subtract 13.3 msec (14 msec).

Subtract 14 msec. from 100 to get the new Epoch End for
the 1st slice of the second order kernel of 86.

6 Change the Epoch End to 86. Verify that the epoch
encompasses all the features that appear to be above noise
level and click the Include button to select the 1st slice of
the second order kernel.

7 Select the 2nd slice of the second order kernel. Since the tick
mark again moves to the left, subtract another 14 msec and
change the Epoch End to 72. Click Include.

8 Now select the third order kernel (1st slice). The Epoch End
remains at 72 since there is no movement of the end tick
mark. Click Include.
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9 Now select the 3rd slice of the second order kernel. This
moves the tick mark again to the left so subtract another
14 msec. Change the Epoch End to 58 and click the Include
button.

10 Finally, select the 2nd & 3rd slices of the third order kernel.
The Epoch End remains at 58 for each. Click the Include
button to finish the selection.

In each case do not select the corresponding epochs larger
than necessary, as the inclusion of noise without signal will
degrade the result.

C. Select the M-Sequence which provides the best scale
for the synthesis display

When satisfied with the selection of kernel slices, you must choose
an m-sequence for the transformation of the selected data into
response sequences. The power of the m-sequence will determine
how long the traces of the synthesized waveforms can be before
they run into other responses. If you select the m-sequence too
small these responses will be too close to each other so you can’t
really see them.

Choosing a very long m-sequence may require a large amount of
memory for VERIS, especially if you have more than just two trace
groups. In selecting the m-sequence you are actually defining how
long (the length and number of tick marks) the domain is on which
you can fabricate these flash sequences.

11 Select “Use Mseq 15” from the pull-down menu and click the
OK button to open the Synthesis window.
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D. Select the responses you want to synthesize.

The program immediately generates all possible flash responses to
all possible flash configurations. After clicking on the OK button you
will see an Averages plot with traces for the selected groups and the
initial responses of the groups. The traces are completely flat since
no flashes have yet been selected.

Below them you see a time axis with tick marks spaced by the base
interval of stimulation used in the recording.  They mark the
positions where you can place your stimuli. In the case of multifocal
flicker stimulation, they represent the possible placement of focal
flash stimuli.

Clicking on such a tick mark will generate a focal stimulus. It turns
the marker from black to white and displays the corresponding
synthesized response. Selecting two consecutive marks will give
you a double flash response, i.e. the synthesized response to flashes
on two consecutive base periods.

The number of tick marks is based on the m-sequence you choose.
If you want to synthesize a long sequence you must have enough
tick marks available to see it graphically.

The transformation gives you a cycle on which you find all possible
configurations of these flashes. But there are no spaces in between.
They are lined up one after the other. So if you want to have a single
flash response, you have to make sure that it is an isolated flash with
nothing before or afterwards.

You can control what is afterwards with the tick marks that follow
the flash. The plotting routine guarantees that there is nothing before
– but for how many tick marks – how long? That depends on the
msequence you choose. If you choose a small sequence then you don’t
have as many configurations. An m-sequence of 13 will never have 15
flashes in a row. If your system has a memory that is longer than that
you are no longer testing it properly.

If you have recorded with an m-sequence long enough, it doesn’t
hurt to make it even longer when you transform back. Making it
shorter would make the responses run into each other.

Why choose an mseq. different from that from which you recorded?
In multi-focal it makes a lot of sense. For multi-focal recording your
m-sequence has to be selected much too long for a single input case
because this cross-correlation loop now has to have all the kernels
for each of the stimulated elements (103, 241, etc.) distributed on it.
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In principal you could go to a shorter m-sequence when you now
select the kernels of a single element since you don’t populate the
loop with all the others. You also reduce the amount of computer
memory needed for each element’s allocated array.

You can now inspect the response to any flash sequence at
intervals of multiples of the base interval.

1 Click on the second tick mark to put a flash there.

What you see is the response to this flash. These are no
longer kernels, these are responses to flashes. The single
isolated flash response appears, calculated from the kernels.
The flash occurred at the tick mark and the corresponding
response follows. It looks very much like a conventional
ERG.

2 Click on the 6th tick mark, 4 intervals to the right.

Selecting two flashes, far apart, shows little effect from the
first on the second.

3 Click the mark you just added to de-select it and instead
select the 4th tick mark, 2 intervals to the right.

Putting the two flashes closer together shows a greater
effect.



Chapter 8  Advanced Topics 8 - 9

VERIS™ Science 5.1 Reference Guide

What was the first waveform’s effect on the second?
Compare the second waveform above with the situation
where it is the first flash.

4 De-select the initial tick mark to remove the first flash.

You can quickly select or de-select multiple tick marks by clicking
the mouse and dragging a box around the marks you want to
change.

5 Now select 4 flashes in a row to look at the effect of multiple
flashes on their responses.

Notice how the first two flash responses merge together, and
the large “off” response in the fourth wave.

To get a better appreciation of the effect a response has on
subsequent responses we can look at a double flash response and
determine the contribution of the second flash to this double
flash response by subtracting the first flash response.

Simply removing the first flash tick mark would not be the same
thing. It merely shows the response to a single flash.

6 Start by selecting two consecutive tick marks.

7 Now select the “Add Ruler” button.
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A second line of markers will appear. A sign at the beginning
of each ruler indicates whether the responses selected on this
ruler are added or subtracted in the resulting traces shown
above. Clicking on the ruler changes its sign. Select a minus
sign for the second ruler.What you will see is the effect of the
second in the pair of responses.

8 On the “subtraction” ruler, click on the tick mark under the
first flash mark on the bar above.

Note the big “A” wave (big negativity) and how it greatly
differs from an isolated flash response. What is happening?
What contributes here is the effect of the second flash on the
first flash response.

This seems to violate basic law of physics, causality. What
happens is that the second flash abolishes the B wave peak of the
first flash response. Therefore, if you subtract the first flash
response you have an inverted B wave peak. (Why? Because at the
time the second flash occurs the B wave has not yet developed, so
the second flash can still interfere with the generation of the B wave
due to retinal feedback mechanisms.)

Caution: Please note that what you see in this case may not
always represent only the response to the second flash. If the
second stimulus occurs before the response to the first stimulus
has played out, its response may still interfere with the generation
of the response to the first stimulus and thus modify it. What you
will see then is the response to the second flash in the pair plus the
effect the second flash may have on the response to the first flash.

Synthesis can also be used to simulate stimulus sequences to
predict which stimulation protocol will generate large responses.

Synthesis is the transformation of the kernel series into sequences
of responses. This tool allows us to synthesize one sequence of
response and subtract or add some other sequences.

For example, in a linear system the double flash response shown
above would be identical to the response of each single flash shown
below. The two contributions would simply add. But they are
different.
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And we can look at the difference by subtracting the two single
flash responses from the double flash response. (In a linear system,
these would be flat lines.)

By experimenting with different flash sequences, subtractions and
additions you may gain an intuitive understanding of the nature of
the response nonlinearities.

NOTE: If you didn’t use a long enough m-sequence during
recording then you may end up in kernel overlap. This will prevent
you from cleanly extracting the kernels.

E. Some Practical Limitations

1. Note that the synthesis of response sequences amounts to
selecting a subset of the entire data set used for the derivation of
the kernel slices. The response traces are therefore always noisier
than the kernel traces. It is therefore advisable to use group
averages for the response synthesis or long recordings with
excellent signal-to-noise ratios.

2. If there are interactions between different input channels such as
neighboring stimulus patches, these will also have to be considered
to obtain a more complete description of the nonlinear response
properties. In the mfERG these interactions are generally relatively
small when the standard fast photopic stimulation is used and can
usualy be neglected. To include these so-called mutual kernels in the
synthesis would only be possible when a small number of stimulus
patches are used. Otherwise, the m-sequence required to resolve all
the self and mutual kernels would be prohibitively long.
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The study of lateral interactions between specific stimulus
elements is covered in the next section, "Deriving Mutual Kernels."

Deriving Mutual Kernels (only available in VERIS™ PRO)
Interactions between different visual inputs are of great interest in
basic research. Typical examples of applications are:

1. Interactions in the VEP between grating patches of different
orientations or spatial frequencies.

2. Interactions between concentric spot and annulus stimuli.
3. Interactions in the VEP between stimuli presented to the two

eyes using dichoptic stimulation.
4. Interactions in the ERG and VEP between stimuli of different

colors.
5. Interactions in multifocal stimulus arrays with a relatively small

number of stimulus patches.
6. In animal studies: Interactions within the receptive field of single

neurons along the visual pathway.

You can create stimulus arrangements of the desired geometry with
any suitable drawing program and import them as PICT files into
VERIS for multifocal m-sequence stimulation. (See Chapter 2.)

1 From the Sample Data Files folder, open one of the “37 Area”
data files.

2 Select the Custom Averages tab from the Default Analysis
Settings.

3 Click on the Grouped Average traces and select the “Edit
Parameters button.”

4 Select the “Mutual Kernel” checkbox to open the Mutual
Kernel window within the Parameters dialog box.
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5 Click on the top left element to select it.

A Kernel Slice selection graphic appears for this element.

6 Now select the element immediately to its right.

For both elements the first order kernel is the default.

7 Click OK.

What we are calculating in this particular case is how simultaneous
flashes on these two interact in their generation of a response. In
this case it is the diagonal of the second order mutual kernel
between the selected inputs. It is of first order in each of the inputs.

The program shows a single trace since you are only plotting one
mutual kernel and all groups' traces would be the same.

Shifting the mark on one of the rulers to the left we may select off-
diagonal slices of the second order kernel describing the interaction
between stimuli occurring at different times at the two inputs.
Unlike the second order self kernels, second order mutual kernels
need not be symmetric. A slice with input 1 leading need not be
identical to the slice with the same relative timing with input 2
leading.

8 Return to Edit Parameters. In the Mutual Kernel window
move the kernel slice marker for Element #1 from “0” to “1”
and click OK.

Now, you are calculating how a flash in a previous frame for
Element #1 affects the flash response of Element #2 in the
following frame.

Or you can do the opposite.
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9 Move the marker for Element #1 back to “0” and move the
marker for Element #2 to “1”.

Now you are calculating that if the flash for Element #2
leads Element #1, how do they interact? Of course, if they
are far enough apart in time they won’t interact any more.

The interaction is always shown as a waveform. If you had
selected three or more stimulus elements you’d still have a
single waveform.

Similarly higher order mutual kernels can be derived simply by
selecting multiple tick marks on the two rulers, e.g., by selecting
two tick marks on each ruler we obtain a fourth order mutual kernel
that is of second order in each input. Selecting tick marks on three
or more rulers we obtain interactions involving more than two
inputs. The interpretation of these kernel slices requires some
understanding of their derivation.

Note that the derivation of such interactions from multifocal
data sets with a large number of patches is generally not
feasible simply because the number of kernel slices describing
these interactions is too large and a test that can separate them all
would be prohibitively long. In shorter tests the mutual kernels will,
therefore, often overlap with the self kernels.

In our example you are not really looking at mutual
kernels but at “kernel overlap” which is meaningless.

Mutual kernels can only be resolved when you have a
small number of stimulus elements. There are so many
possibilities, even with a 37 trace array, that you can’t really
resolve them.

As individual mutual kernel slices are very small and below the
noise level in standard multifocal tests, such kernel overlap is
usually not a problem when mapping multifocal ERG topographies.

So if you are really going to look at the effects of mutual
kernels you would use a small number of stimulus elements.

This is mainly useful in situations where you generate your own
stimulus - with a drawing you make two patches or an annulus and
spot and you want to see how the annulus affects the response in
the spot and the other way around.
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Appendix A - Hardware

System Calibration
The procedure below applies to calibrating the CRT and Microdisplay
stimulus monitors. A separate section describing Ganzfeld calibration follows
that discussion.

CRT & Microdisplay Stimulus Monitor Calibration

In moving to new compact high, intensity stimulator units with
integrated eye and fundus cameras, measuring the screen
luminance has become more difficult. Accurate measurements
through the optics of the refractor/camera require careful use of an
expensive spot meter. While cumbersome, it has not been a major
problem when only one standard setting was used.

However, where different scientific and clinical applications require
frequent changes of the luminance and contrast settings, manually
adjusting stimulus luminances each time is clearly not practical
and can lead to errors.

This problem has been solved with the new VERIS™ Auto-
calibration software/hardware system. A photometric sensor is
mounted in an anodized aluminum shell that slides over the lens of
the eye camera or fundus camera unit.

If you are using a 7" or 21" monitor without the eye camera, the
sensor is mounted on the suspension bar in place of the lens holder.

The spectral sensitivity of the sensor approximates that of human
photopic vision. Therefore, it can be used to calibrate display
devices with different emission spectra such as monochrome
stimulus monitors with different phosphors. With the software, it
also permits calibration of all three colors when an RGB color
monitor is used.

Over time the brightness of the CRT display used for stimulation
may change slightly. (Also, if someone changes the monitor
controls the monitor should be re-calibrated.)

The screen should therefore be periodically calibrated,
first after installation of the equipment and from there at
intervals of approximately one month.

Since monitor brightness can change considerably during warm-
up, it should be switched on approximately 15 minutes before any
recording or calibration procedure.
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Using the VERIS™ Auto-Calibration System

The sensor of the calibrator is easily connected to the Switchbox.
Amplifier and filter electronics are miniaturized and built into the
connector. The sensor's aluminum shell slides over the lens of the
eye camera or fundus camera unit

DARK CURRENT CALIBRATION:

Each photometric sensor, when in the dark, has a different
"dark" current. When you first install the new calibration
device, and each time you install a software upgrade you
must measure this dark current.

1 Connect the cable from the calibrator to the 25-pin
connector labeled "Auto Calibrator" on the Switchbox.

2 Cover the sensor so that it is in complete darkness.

3 While holding down the option key on the keyboard, and
depending on the stimulus monitor you are calibrating, select
either the CRT, Microdisplay or Ganzfeld Calibration from
the Calibration pull-down menu.

4 In the Power Auto Calibration window that opens, push
"Read", then cover the unit with your hand to put it in the
dark.

Power Auto
Calibration

Window

Setting Dark
Current

5 When the black number stops changing, select the Stop
button and click OK.

This "dark current" number is stored in the program.
You only need to repeat this procedure when installing an
upgrade.

Do not ever manually insert or change the values for
"Dark" and "Bright" placed there by the Auto Calibration
operation.
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LUMINANCE CALIBRATION - STIMULUS MONITOR

1 Clip the black shell of the calibrator over the eye lens of the
VERIS™ Refractor/Camera unit on the stimulator.

2 From the Calibration menu, again select the appropriate
monitor for calibration but without pressing the option key.

3 If you are using a color monitor, select the Color Monitor
check box in the Auto Calibration window that opens.

4 Select a monitor size from the Size pull-down menu.

If you have multiple stimulus monitors you can store three
calibration curves (Small, Standard, Large) for each monitor
type you have connected.

     
5 Press "Start".

The progress bar grows as the calibration is run. The
program goes through all the luminance levels and stores a
look-up table. It starts off dark and gets brighter so the curve
should go up from the left.

6 When the progress bar disappears, click OK. Ideally you
want a curve that is quasi-linear.
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If the contrast of the monitor is not high enough you may get
an error message. (Note that in our example the first third of
the curve is relatively flat.)

To increase the luminance range you may need to adjust the
brightness or contrast of the monitor. However you don't
want to have the minimum brightness too high.

Or, you can choose to ignore this warning. It doesn't keep you
from calibrating.

7 After calibrating, click on the Colors box to open the Color
Settings dialog box. Click on each of the stimulus colors to
check on the minimum and maximum luminance values.

In our example we are going from 0 to 1649. This is a good
range.

Chromatic stimulation for the multifocal ERG has not proved very
useful. Color monitors cannot go to very high luminance levels - only
approx. 150 cd max. For the ERG we want to go much higher. Our
new monitors go close to 1,500 cd/m2 - giving you more options.
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But for VEP there is a wide area of research you can tackle with a
color monitor. If you have a color monitor you have three guns to
calibrate – the RED, GREEN, and BLUE.

For monochrome monitors only the Green channel is used. Many
monitors use a synch signal on the green channel. As long as synch
on green is off VERIS™ outputs the same RGB values through all
three channels. If synch on green is on, then the green signal will be
brighter than the red or blue.

The video board allows you to choose 256 levels of brightness. If
your monitor is adjusted to 800 cd at the highest level, calibration
will make a look-up table from 0 to 800 cd. The program won't enter
a higher number. If you want to go higher, you have to re-adjust the
monitor brighter and re-calibrate.

The look-up tables generated during Auto-Calibration are
subsequently used by VERIS™ to accurately set the desired
stimulus luminance levels. Once the system has been calibrated,
the stimulus intensities prescribed by the recording settings are
automatically set.

When designing new recording settings or modifying old ones, you
can now enter luminance levels in cd/m2. Assuming you work with a
calibrated monitor, the luminance will be defined by these protocols
with sufficient accuracy to give you reproducible results.

Maintenance of your VERIS™ Calibrator
If you choose to do so, you can check the values the VERIS™ system gives
you with a standard photometric spotmeter.  This should be done through
the lens system of the VERIS™ refractor/camera unit. It is important that
this is done correctly as follows:

1. From the distance of about 30 cm from the lens of the refractor, focus
the spot meter on a bright stimulus patch. If you are too close, the
light cone emanating from the refractor may not cover the objective
lens of the spot meter and your measurement will be incorrect.

2. Take measurement.

If you feel that there is too much of a discrepancy between this measurement
and the luminance value selected in VERIS™, EDI will check the calibrator
for you.  Factory calibration is guaranteed for 1 year and, calibrators are
adjusted for free within the warranty period.  Annual factory calibration is
available. Contact EDI Technical Support for further information.

Defining your Stimulus Parameters
Please note that the multifocal stimulation generated by means of a CRT
display of the standard VERIS™ system consists of brief flashes of
approximately 2 ms duration.  The flash duration is determined by the time
it takes the electron beam to scan a stimulus patch and the decay time of
the phosphor material of the screen. While, for practical reasons, the screen
calibration is measured in cd/m2, the stimulus should be defined by the
intensity of the individual flashes. The flash intensity is obtained by dividing
the luminance by the frame rate of the screen, which, in most cases, is
75/sec. It is thus measured in units of flash intensity (cd•sec/m2).
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Using Auto-Calibration System on the 7”
Stimulus Monitor without the Refractor/Camera

1. Make sure that the dark current of the calibrator has been
recorded in the program as detailed in the previous section.

2. Mount the Calibrator to the suspension bar for the refractive
lenses on top of the 7” monitor. Center the device in front of
the screen. The distance from the screen and the rear end of
the calibrator cylinder shell should be 13 cm.  

13 cm

Calibrator Glass of monitor screen

3. Darken the room or use means to keep light from falling on
the stimulator screen.

4. Select and start Auto-Calibration for monochrome monitors.

VERIFYING LUMINANCE CALIBRATION

There is a simple way to examine the luminance values of the
stimulus and for verifying that the stimulus monitor and the
luminance calibration are functioning correctly.

1 After performing a luminance calibration, from the Select
menu choose a monochrome Recording protocol set up for
dilated pupil.

2 In the Colors area of the Subject tab, place the tip of the
mouse on the white rectangle.

In the lower left-hand corner of the Subject window should
appear "RGB (cd) = (0,200,0)." These are the RGB
luminance values of the stimulus. The middle number
should be close to 200 (195-205).

3 Now put the tip of the mouse on the black rectangle.



Appendix A   Hardware A - 7

VERIS™ Science 5.1 Reference Guide

The middle number should be close to 0 (0-2). Since these
protocols involve monochrome monitors only the Green
channel values are important. (The Red and Blue values
should be 0.)

Calibration of the VERIS™ Ganzfeld Stimulator
Unlike the xenon flash tubes used in most other Ganzfeld
stimulators, the flash intensities and background luminance levels
provided by the LED technology of the VERIS™ Ganzfeld are
extremely stable. However, to assure accuracy of the device, we
recommend calibration of the Ganzfeld at periodic intervals of about
6 months. The process is simple and is fully automated.

The photo-diode sensor for calibration is built into the
Ganzfeld unit. The sensor electronics have been factory calibrated
using precision instruments.

The Auto-Calibration Procedure:
1 To avoid false readings due to the intrusion of ambient light,

make sure that the opening of the VERIS™ Ganzfeld
stimulator is covered with a completely opaque material.

The color of the material should be neither black or white.
Use something like brown cardboard to simulate the color of
someone's face.

2 On the Calibration pull-down menu select Ganzfeld
Calibration. This will bring up a Calibration window.

3 Press the Start button. The stimulator will step through all
possible RGB values and the computer will store the
corresponding luminance values of the Ganzfeld. These
values are stored in the VERIS™ preferences.

In about 10 minutes the progress bar disappears and the
calibration is complete. Note that six curves have been
generated, one at a time. There are green, red and blue
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curves, and then another set of green, red and blue curves
below it.

The top three curves refer to the flash luminance, the bottom
three curves refer to the background luminance.

All curves should start as a single flat line at the left side of
the window that take off at the "knee". This "knee" is a non-
linearity built into the system on purpose.

If no "knee" appears and the curves start up from the left
end of the window, there is something wrong.

By clicking on this window you can check the values at any
point along the curves.

    
Auto-calibration must be done every time your software is
upgraded to a new version and after any adjustments or repairs of
the Ganzfeld hardware.

Setting Up the Eye Monitoring Camera

The VERIS™ Eye and Fundus cameras allow you to monitor eye
movement during the recording process. While the stimulus picture
is displayed on the Stimulus monitor, the Recording window appears
on the Control Monitor. The Recording window is discussed in
Chapter 3, “Recording a Subject”.

If the VERIS™ Eye or Fundus Camera is attached and has been
selected in the Acquisition Settings dialog box, a rectangular area on
the top right side of the Recording window will show the video image
from the camera. You can monitor eye movement by the
superimposed ring (Eye camera) or the superimposed stimulus
pattern overlay (Fundus camera).

1 From the Select menu, choose a Recording Settings protocol.

2 From the document window click on the Acquisition button to
open the Acquisition Settings dialog box and select the
appropriate camera.
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Acquisition
Settings

3 Push the Record button. The Recording window will show a
rectangular area in the top right corner that contains the
video image from the camera.

Recording
Window

4 If there is no video image, make sure that the lens cap is
removed and test whether there is an image by placing a
printed page approximately 4 cm from the camera lens.

5 If the rectangular area remains black, make sure that all
cables are correctly connected.

6 If you still have no video image please contact your local
VERIS distributor or EDI customer support.
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Calibrating the Fundus Camera's Stimulus Grid
When “Fundus Camera” is selected in the Acquisition Dialogue Box,
an outline of the stimulus pattern is superimposed on the video
image of the fundus seen during recording. This grid must be
calibrated to match the actual stimulus on the retina. Once done,
the grid will match all stimulus patterns on the retina that can be
selected, regardless of the subject’s precise eye position and
direction of gaze.

This calibration only has to be done once, but it should be checked
every few months or when an adjustment has been made to the
internal optics of the camera or to the horizontal or vertical size of
the stimulus display.

1 For calibration slide the supplied Grid Calibrator over the
eye lens at the front of the fundus camera/stimulator. This
calibrator is essentially an artificial eye with a highly
reflective fundus.

2. From the Select menu choose a Recording protocol that
provides a high contrast, high luminance stimulus pattern
with a small hexagonal array of 37 elements. Increase the
stimulus luminance to the maximum. Also increase
background luminance.

For fine adjustments later you can select a 103 hexagonal
array and repeat the process.

3 Click on the “Record” button to open the Recording window.

4 Make sure that the camera is in Fundus Camera mode by
clicking the up and down arrows until the stimulus pattern
appears superimposed on the grid in the video window.

5 Adjust the black focusing knob as necessary on the refractor
to bring the stimulus into focus.

6 Click anywhere in the video window to bring up the Calibrate
Camera controls (or use the Calibrate Camera button).

7 Use the Levels tab to adjust the brightness and contrast as
needed.
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In Chapter 3, under "Getting a Good Fundus Image" we
discussed the fundus camera's aperture adjustment lever.
When used to improve fundus imaging, we recommend a
setting in the middle of the range. For grid calibration it may
be necessary to adjust the aperture lever setting to see the
stimulus.

8 You should now see the actual stimulus appear in the video
display. The stimulus grid is overlaid and must be adjusted
to match this stimulus.

9 Use the Stimulus and Optic Disk tabs to adjust the
controls for the position and the scaling of the stimulus grid
and optic disk.

10 Use the Left, Right, Up and Down keys to move the Image
and Disk directionally. Use the Zoom In (Grow) and Out
(Shrink) keys to reduce or enlarge Image and Disk relative to
the actual stimulus.

Hold down the “Shift” key while using the controls to
make adjustments in larger steps.

You can start and stop the recording so that the stimulus display
shows different patterns of bright hexagons. This can help fine-
tune the adjustment of the grid to the stimulus.
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Color and brightness of the grid pattern can also be changed
in the same control box. A high contrast white grid has the
tendency to obscure a low contrast fundus image. A red or
green grid at a brightness similar to that of the fundus image
is clearly discernible but has only a very minor effect on the
visibility of the fundus.

11 Click on the Mask Color on the Stimulus tab, to open the
Choose Color dialog box.

12 Use the Brightness control to adjust the grid luminance
level. You can also change the color using by selecting the
Use System Color Picker button.

You can always use the Cancel button to return to the default
position if you need to start over. Eventually you will be able to
line the grid and disk up roughly with the stimulus.

Make sure that the optic disk is correctly positioned. You
should look at the fundus of several normals who fixate well and
adjust the optic disc circle to the mean position of several
normals, noticing the variation in optic disc location

This needs to be done for both eyes. (Change the eye in the
Subject tab.)
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Software License Agreement and Limited Warranty

GRANT OF LICENSE.

EDI grants to you a nonexclusive, personal license to use the
Software as provided in this License. Except as otherwise expressly
provided in this License, you may use the Software only on a single
computer owned, leased or otherwise controlled by you. This means
that you may not use the Software, and the Software may not
reside, on more than one computer at any one time.

COPYRIGHT.

The Software is owned by EDI and is protected by United States
copyright laws and international treaty provisions. You may either
(a) make two copies of the Software solely for backup or archival
purposes, provided that you reproduce all copyright and other
proprietary notices that are on the original copy of the Software
provided to you, or (b) transfer the Software to a single hard disk,
provided you keep the original solely for backup or archival
purposes. You may not copy the written materials accompanying
the Software (called the “Documentation”).

OTHER RESTRICTIONS.

You may not rent or lease the Software, but you may permanently
transfer the Software and Documentation provided you retain no
copies and the recipient agrees to the terms of this Agreement. You
may not modify, reverse engineer, decompile, disassemble, or create
derivative works from the Software or Documentation.

TERM.

This License is effective until terminated.  You may terminate the
license at any time by returning the Software and all
Documentation to EDI and by removing the Software from the
memory of the computer into which the Software has been
transferred.  This License may be terminated by EDI immediately
and without notice in the event that you fail to comply with any
term or condition hereof.  Upon any termination, you will return to
EDI, at your expense, the Software and Documentation and any
copies whether or not the copying was authorized.
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SEVERABILITY.

If for any reason, any provision or partial provision of this License
is held invalid, such invalidity shall not affect the remainder of such
provision or this License, and this License shall, to the full extent
consistent with law, continue in full force and effect.

THIRD PARTY BENEFICIARIES.

If any portion of the Software has been licensed to EDI by a third
party for redistribution, Licensee is hereby notified that such third
party is an intended third party beneficiary of this License with full
rights of enforcement.

GENERAL.

The validity and performance of this License shall be governed by
California law, except for that body of law dealing with conflict of
laws and except as to copyrights, which are governed by United
States laws and international treaties. This License constitutes the
entire agreement between the parties concerning the subject
matter hereof. Any waiver or amendment of any provision of this
License shall be effective only if in writing and signed by you and an
officer of EDI. No distributor, dealer, or employee (other than an
officer) of EDI is authorized to change or amend any terms of this
License. In the event of any conflict between the terms of this
License and the terms of any license bound into any manual
packaged with the Software, this License shall govern.

Limited Warranty

EDI warrants that for ninety (90) days following delivery of the
Software to you, as shown by a copy of your receipt:  (1) the
Software, unless modified by you, will perform substantially the
functions described in the Documentation provided by EDI; and (2)
the media on which the Software is furnished will be free from
defects in materials and workmanship under normal use.  EDI does
not warrant that the Software will meet your requirements or that
operation of the Software will be uninterrupted or error-free. EDI is
not responsible for any problem, including any problem which would
otherwise be a breach of warranty, caused by (i) changes in the
operating characteristics of computer hardware or computer
operating systems which are made after the release of the
Software, (ii) interaction of the Software with non-EDI software or
(iii) accident, abuse, or misapplication.
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THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO
OTHER WARRANTIES ARE MADE BY EDI OR ITS
LICENSORS, WHETHER EXPRESSED OR IMPLIED,
INCLUDING THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, OR NONINFRINGEMENT.   SOME LOCALITIES DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES,
SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. IN
THAT EVENT, ANY IMPLIED WARRANTIES ARE LIMITED IN
DURATION TO NINETY (90) DAYS FROM THE DATE OF
DELIVERY OF THE SOFTWARE. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER
RIGHTS, WHICH VARY FROM LOCALITY TO LOCALITY.

Limitation of Remedies

EDI’s entire liability and your sole remedy under the warranty
during the ninety (90) day warranty period is that EDI shall, at its
sole and exclusive option, either replace the Software with a
functionally equivalent program at no charge to you or refund the
license fee of the Software. Any replacement Software will be
warranted for the remainder of the original warranty period or
thirty (30) days, whichever is longer.  These are your sole and
exclusive remedies for any breach of warranty during this ninety
(90) day period.  In order to make a claim under this warranty you
must return the defective item with your receipt within ten (10)
days following the end of the warranty period.  EDI will have no
responsibility to replace or refund the license fee of Software
damaged by accident, abuse, or misapplication.

REGARDLESS OF WHETHER ANY REMEDY SET FORTH
HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT
WILL EDI OR ITS LICENSORS, OR THE DIRECTORS,
OFFICERS, EMPLOYEES, OR AGENTS OF ANY OF THEM BE
LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL,
INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST
PROFITS OR LOST DATA ARISING OUT OF THE USE OR
INABILITY TO USE THE SOFTWARE OR ANY DATA
SUPPLIED WITH IT EVEN IF EDI OR ANYONE ELSE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES,
OR FOR ANY CLAIM BY ANY OTHER PARTY.  SOME
LOCALITIES DO NOT ALLOW THE LIMITATION OR
EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION
OR EXCLUSION MAY NOT APPLY TO YOU.  IN NO CASE
SHALL EDI OR ITS LICENSORS’ LIABILITY UNDER THIS
LICENSE EXCEED THE LICENSE FEE PAID FOR THE
SOFTWARE.
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Disclaimer

ELECTRO DIAGNOSTIC IMAGING (EDI) AND ITS
LICENSOR(S) MAKE NO WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, REGARDING THE ENCLOSED
COMPUTER SOFTWARE OR HARDWARE PRODUCT (THE
“PRODUCT”). EXCEPT AS OTHERWISE EXPRESSLY
PROVIDED IN ANY WRITTEN WARRANTY DELIVERED
WITH THE PRODUCT, EDI AND ITS LICENSOR(S) DO NOT
W A R R A N T ,  G U A R A N T E E  O R  M A K E  ANY
REPRESENTATIONS REGARDING THE USE OR THE
RESULTS OF USE OF THE PRODUCT IN TERMS OF ITS
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS
OR OTHERWISE.  YOU ASSUME THE ENTIRE RISK AS TO
THE RESULTS AND PERFORMANCE OF THE PRODUCT.
SOME STATES OR JURISDICTIONS DO NOT PERMIT THE
EXCLUSION OF IMPLIED WARRANTIES. THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU.  THERE MAY BE
OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM
STATE TO STATE.  IN NO EVENT WILL EDI, ITS
LICENSOR(S) AND THE DIRECTORS, OFFICERS,
EMPLOYEES OR AGENTS OF ANY OF THEM BE LIABLE TO
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR
INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF
BUSINESS INFORMATION, AND THE LIKE) ARISING OUT
OF THE USE OR INABILITY TO USE THE PRODUCT EVEN IF
EDI OR ITS LICENSOR(S) HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES
OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY
NOT APPLY TO YOU. EDI AND ITS LICENSOR(S) LIABILITY
TO YOU FOR ACTUAL DAMAGES FROM ANY CAUSE
WHATSOEVER, AND REGARDLESS OF THE FORM OF THE
ACTION (WHETHER IN CONTRACT, TORT [INCLUDING
NEGLIGENCE], PRODUCT LIABILITY OR OTHERWISE),
WILL BE LIMITED TO $50.

If you have any questions concerning this license, please
write or call:

Electro Diagnostic Imaging, Inc.
200-F Twin Dolphins Drive
Redwood City, California 94065-1402
USA
Voice: (650) 631-0120 Fax: (650) 631-0122
E-mail: edi@electro-diagnostic.com
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Installing VERIS™ Application and Upgrades
All files necessary to successfully run your VERIS™ Science
program have been pre-installed on your computer. They can be
found in the VERIS™ Science folder on your hard drive. Included is
the VERIS™ application icon in that folder.

Although you will not need to do an installation now, familiarity with
the procedure will be helpful if you need to re-install the application
or install updates in the future.

If unfamiliar with your computer’s file handling capabilities, we
suggest that you gain some knowledge before proceeding with the
installation of VERIS™.

There are three occasions when you may need to re-install or
update your current Application or supporting files.

1. Minor upgrades of the program and supporting files in which
bug fixes or enhancements have been made. Only the last
number in the Version will change, i.e. 5.1.9 to 5.1.10. (Your
current Key File will work with these new files.)

2. Major Upgrade of the software with significant enhancements.
This would include changes to either the initial or second number
in the Version, i.e. 4.9 to 5.0 or 5.0 to 5.1. (This option requires a
new Key File.)

3. Re-installation of the entire application would only be
necessary in the rare instance of a hard drive failure. (This option
may require a new Key File.)

The quickest way to secure the necessary files is from EDI's FTP
website. Alternatively, if a fast Internet connection is not available,
a CD of the required files can be mailed to you.

Minor upgrades are available without charge. Depending on your
Support Agreement, Major Upgrades and new Installation
CDs may also be provided without charge.
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Downloading Files from the FTP Site:

1 From your web browser, type in the address for EDI's FTP
site, ftp://ftp.electro-diagnostic.com/pub/.

How you download the files will depend on which
browser you use.

2a If using a browser like Microsoft's Internet Explorer you
will see a directory of files and folders available to download in
the browser window,

Double-click on the file you want to download (or click
on a folder to locate the file(s) you want to download).
Alternatively, you can drag the file or folder to your desktop.

2b If using a browser like Apple's Safari an icon of the FTP
site will mount on your desktop. If the "pub" icon appears on
your desktop a folder of files available to download should also
appear. (If not, simply double-click on the "pub" icon.)

DRAG the file or folder you want to download directly
onto your desktop. Do not double-click on the folder or files.
A plus sign will appear as you drag the icon to your desktop,
indicating that you are copying to your desktop.



Appendix B   Software  B - 7

VERIS™ Science 5.1 Reference Guide

3 The file(s) in either .dmg (Disk Image) or .hqx (Bin Hex)
format will download to your desktop.

4a If a Disk Image (.dmg) file, double-click to mount the image
on your desktop. The new icon will look like a disk drive.

Double-click on this icon to show the file(s) inside and
drag the file(s) to your VERIS™ folder.

Like an external disk drive, this icon (and its contents) will
disappear when you shut down the computer or Eject the
icon. This is unlike the .dmg file which will remain on your
desktop until moved to Trash.

4b If a Binary Hex (.hqx) file, double-click to expand it on your
desktop.

Drag the file to your VERIS™ folder.

5 When you are satisfied that the files have been correctly
installed in your VERIS™ folder, you may move all the .dmg
and .hqx files to the Trash and Eject the FTP and disk image
icons.
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Installing Files from a CD:
1 Insert the VERIS™ Install CD into the SuperDrive in your

computer and double-click on the CD icon when it appears.  

The Install folder window will appear on your desktop.

2 First, double-click on any Read Me  files for the latest
information about the installatoin process.

3 Drag the appropriate files to your VERIS™ folder.

Be sure that specific files are put in their proper sub-folders,
i.e. Analysis files in the Analysis Settings folder, Recording
files in the Recording Settings folder, etc .

4 Follow any special instructions for installing drivers that are
included on the CD.

The Key File
Each license for VERIS™ entitles the user to record and
analyze data from one computer. In addition, major upgrades of
the software require the user to either subscribe to a maintenance
agreement or purchase the new software.

These restrictions are enforced by the use of a Key File. In
order for the program to run, this Key File must be in the
VERIS™ folder. The Key File is unique to the computer and
software version being used.

The Key File is created and sent to each licensee by EDI. In
order to create the Key File for a major upgrade EDI must have in
its records the unique number from each licensee's computer.

That is the purpose of the Veris Inspector program.

VERIS™ Inspector Program
The string of numbers unique to each computer can be found by
running the Veris™ Inspector program.

1 Double-click on the Veris Inspector program icon found in
your VERIS Utilities sub-folder.

A window will open providing the Veris Inspector String.
Provide this number to EDI when requested.
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VERIS™ Swap Monitors Program
If the menu bar appears on the wrong monitor, this program makes
it easy to correct the problem. It puts a small dialog box on all
monitors except the one with the menu bar. Click on the push
button on that dialog box, and it moves the menu bar to that
monitor.

It is intended that Veris Swap Monitors be included in the Login
Items panel on the Accounts pane of System Preferences. Each
time you start the computer you'll have the option, if necessary, of
moving the menu bar. Use File: Display Preferences to Main to
open the Display Preferences pane on the main display.

Files Supplied with VERIS™
Included below are the types of additional files which may be
provided with your installation of the VERIS™ program.

Release Notes
Documentation

VERIS™ Utilities
Veris Inspector
VerisSwapMonitors

Custom Stimulus Pictures
Recordings Settings folder

Default Recording Settings
Multi-focal Protocols

mfERG

Multiple versions of these files are supplied, depending on the type
of electrode, whether the eye is recorded with a natural or dilated
pupil, the type of eye camera used, and monochrome or color
stimulus monitor.

The file name of each type of protocol gives the key features of its
settings. The format is picture, length, electrode, camera,
luminance.

Therefore a "103, 7m, B-A, eye cam, 200" protocol uses a 103
hexagon picture, with a 7 minute recording, using a Burien-
Allen or contact lens type electrode, and uses a value of 200
candelas / m2 as the maximum luminance.
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To calculate the actual flash intensity, divide the value of the
luminance by the flashes per second or frame rate. For a value
of 200 candelas / m2 with a frame rate of 75 flashes/second the
flash intensity is 2.6 candelas x seconds / m2.

mfVEP

The file name of each type of protocol gives the key features of its
settings. The format is: frames / m-step, length.

Therefore a "1m 7mi" protocol uses 1 frame per m-step, with a
7 minute recording.

Conventional Protocols
PERG  &  PVEP

Multiple Versions are supplied for Steady State and Transient
stimulations. The format is: Picture resolution, Reversals /
second.

A "1.5 deg check, 13 rev/s," is a steady state stimulation with
13 reversals per second, and a 1.5 deg (32 x 32 pixel)
checkerboard).

GANZFELD EOG, ERG & VEP

Microdisplay Protocols
Conventional Protocols

Multi-focal Protocols

Analysis Settings folder
Multi-focal ERG
Multi-focal VEP
Conventional ERG
Conventional VEP
Conventional EOG

Normal Files folder
A Normal Files folder is provided with the installation; however, the
sample reference files are for multifocal ERG use only.

The sample reference data is limited and for illustrative
purposes only. You should generate your own Reference
Files, using the methods explained in Chapter 5 , under
"Creating Reference Data."

Sample Data Files folder
Normals
Sample Patients
Tutorial Documents
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